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1.Introducción 
Tópicos de esta sección: 
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Quantum GIS 
QGIS (Quantum GIS) es un programa de código abierto y gratuito que sirve para visualizar y procesar 

datos geográficos.  

 

QGIS funciona en diferentes sistemas operativos, tales como Windows, Linux y Mac.   

 
Este programa les proveerá herramientas básicas para poder hacer las labores de visualización, 

recopilación de información geográfica, y análisis de geodatos (información geográfica), además de 

impresión de mapas.  El tutorial incluye el uso del plugin del SIG open source de más larga trayectoria: 

GRASS. 
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Instalación 
Windows: Utilizarán los ejecutables para Windows.  Deberá ir a la página de downloads de QuantumGIS 

para Windows: http://qgis.org/en/site/forusers/download.html  

 

 

La lista de enlaces tiene una variedad de 

versiones, según el tipo de sistema 

operativo 32 o 64 bit, la versión “Latest 

release", la cual se actualiza en pocos 

meses 

La versión “Long term release" es 

preferida por organizaciones. 

 

 

La instalación incluye, el programa GRASS.  Este tiene cientos de funciones de geoprocesamiento y 

manejo de geodatos.  Este es otro software de GIS, el cual lleva muchos años desarrollándose, pero su 

aprendizaje toma más tiempo que QGIS.  Incluiremos su uso en la sección de geoprocesos y 

procesamiento de rásters. 

  
 

No daremos más detalles sobre la instalación.  Esto puede variar según la versión de Windows que esté 

utilizando, así como los privilegios de instalación que le haya asignado su administración de sistemas de 

información. 

 

Aquellos que deseen usar Linux, pueden ir la la sección de descargas para Linux en sus diferentes 

“distros”.  También hemos instalado QGIS/GRASS en Ubuntu 18.04 para experimentar.   

 

Además, es buena idea ir al depósito de plugins de QGIS para tener una idea de todas las contribuciones 

de usuarios/programadores para resolver distintas situaciones. 

 

http://qgis.org/en/site/forusers/download.html
http://grass.osgeo.org/
http://plugins.qgis.org/plugins/
http://grass.osgeo.org/
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Interfaz gráfica (GUI) 
QGIS es un programa intuitivo.  Por tal razón, ha sido uno de los SIG de código libre favoritos para 

aprender sobre los programas de procesamiento de datos geográficos (GIS).   

 
 

Las diferentes barras de herramientas y paneles (TOC/Browser) pueden ser activadas o desactivadas de la 

interfaz desde el menú principal: View > Toolbars y View > Panels. 

          
Por el momento, desactive el panel Browser, haciendo uncheck en la caja de opción.  
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Importar y visualizar geodatos en QGIS 
Antes de traer geodatos a cualquiera de estos programas de procesamiento (GIS), es importante mencionar 

cómo abstraemos la realidad percibida para modelar el ambiente dentro de estos programas. 

 

Entre las maneras de codificar o representar la geografía (reducir la realidad percibida de los elementos 

geográficos a cierto nivel de abstracción) están:  

Método vectorial:  

Reducir todo a tres niveles geométricos: 

• punto 

• línea o multilínea (polyline) 

• área (llamado también polígono o multipolígono) 

 

La geometría puntual puede usarse para definir elementos separados y de relativa pocas dimensiones para 

los propósitos del mapa. Un aeropuerto, pozo, escuela, etc pueden ser representados por un punto o 

multipunto. 

 

Las líneas (polylines) se usan para representar objetos generalmente alargados tales como ríos y 

carreteras. 

 

Los polígonos (áreas) son usados para representar áreas o superficies, por ejemplo, parcelas, huellas de 

edificios, la reglamentación de uso de un territorio, el área de un municipio, barrio, sector censal, etc. 

 

 
Tres niveles geométricos.  Tomado de http://en.wikipedia.org/wiki/Shapefile (marzo 8, 2013). 

 

  

http://en.wikipedia.org/wiki/Shapefile
http://en.wikipedia.org/wiki/File:Simple_vector_map.svg
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Método ráster (uso de imágenes): 

El ejemplo más común del uso de ráster para representar geografía es la fotografía aérea.   

Una vez digitalizada, la imagen está compuesta de celdas que tienen un valor, en el caso de rásters 

simples de una sola banda o múltiples valores por celda, en rásters multibandas como lo son las fotos 

aéreas. 

 
Ejemplo de fotografía aérea (ortofotografía) de 2009-10 provista por la Escuela de Planificación de la 

Universidad de Puerto Rico.  Tomado del servicio web mapping: 

http://gis.otg.pr.gov/ArcGIS/rest/services/Ortofotos/Orthophoto2009_10/MapServer?f=jsapi.  

 

Los rásters pueden servir también para hacer mapas tanto de puntos, líneas o áreas.  La diferencia es el 

uso de las matrices.  En el caso de puntos, las celdas están desconectadas.  En el caso de líneas, las celdas 

se encadenan haciendo líneas y para las áreas, las celdas se agrupan formando “manchas” regulares o 

irregulares. 

SpatiaLite layers 
Quantum GIS ofrece varias maneras de allegar geodatos al programa.  Entre la variedad que hay 

estaremos dando preferencia a los siguientes formatos o protocolos:   

Formato SpatiaLite. 

Protocolo abierto Web Feature Service  

 

SpatiaLite es una extensión espacial de SQLite, (permite guardar datos geográficos).  Es un programa de 

gestión de bases de datos relacionales escrito en lenguaje C y de dominio público.  En su versión 3, 

SQLite permite bancos de datos hasta de 2 Terabytes, además de permitir incluir campos binarios BLOB 

(para guardar geometrías e imágenes).   

 

Estaremos dando preferencia a este formato para datos vectoriales, porque los shapefiles tienen ciertas 

limitaciones tales como la longitud del nombre de campos (hasta 10 caracteres), así como funciones para 

gestionar los datos usando lenguaje SQL.  Además, el formato SpatiaLite puede leerse en QGIS y 

ArcGIS, además de usarse en diferentes sistemas operativos: Windows o Linux en sus diferentes 

variedades.   

 

  

 
Logo 
Spatialite 

http://es.wikipedia.org/wiki/Ortofotograf%C3%ADa
http://gis.otg.pr.gov/ArcGIS/rest/services/Ortofotos/Orthophoto2009_10/MapServer?f=jsapi
https://en.wikipedia.org/wiki/SpatiaLite
http://en.wikipedia.org/wiki/Web_Feature_Service
https://es.wikipedia.org/wiki/SQLite
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1A: Abrir un proyecto QGIS existente para probar 

algunas funciones geoespaciales básicas 
--------------------------------------------------------------------------------------------------------- 

 Para comenzar, descargue el siguiente archivo: 

Ejercicio_1.   

--------------------------------------------------------------------------------------------------------- 

 Guárdelo en el directorio/folder C:\Tutorial_QGIS.   

--------------------------------------------------------------------------------------------------------- 

  
 

 Descomprima el archivo, haciendo right click encima y escoja la opción Extract All… 

 
 

 Extraiga/descomprima en el directorio que aparecerá C:\Tutorial_QGIS\Ejercicio_1 

 
 

 Abra una sesión de QGIS, si está usando Windows 10, a través de Start > All Programs > 

QGIS 3.4.x > QGIS Desktop 3.4.x with GRASS 7.x.x 

 
 Espere que le aparezca el programa QGIS. 

  
 

 Presione OK en la forma QGIS Tips. 

 

http://gis.otg.pr.gov/Downloads/Tutorials/Qgis/Ejercicio_1.zip
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 Vaya al menú principal y escoja Project > Open 

 
 

 Entre en el directorio C:\Tutorial_QGIS\Ejercicio_1 y escoja el archivo Ejercicio_1.qgs 

 

 Haga click en el botón Open.  

 

 Espere que carguen los datos al proyecto. 

 
 

Un archivo “qgs” contiene referencias a las localizaciones de los datos en el disco, además de otras 

preferencias, simbología, etcétera.  Los archivos qgs y qgz (comprimido) son archivos de texto bajo el 

estándar XML. 
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Así deberá aparecer el QGIS Project File Ejercicio_1.qgs en pantalla: 

 
 

Note la lista de layers y tablas que aparecen a la izquierda y el canvas a la derecha, el cual muestra los 

geodatos. 

El proyecto está compuesto por diferentes layers: tanto vectoriales (puntos, líneas, polígonos)… 

 
Como rásters… 

 
 

Además de tablas de atributos: 

 
 

Los puntos que se ven encima del mapa de 

municipios representan las localizaciones 

de algunos de los establecimientos para el 

consumo de carne de cerdo y comida 

criolla (lechoneras).  Algunos les pueden 

llamar chinchorros.  
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1B: Navegar en el canvas usando Spatial Bookmarks 
Por el momento haremos una navegación dirigida mediante el uso de marcadores espaciales (bookmarks) 

que nos servirán para mostrar algunos lugares de interés.   

 

Estos tres botones: 

 
Se usan para crear y manejar Geospatial Bookmarks (marcadores).  Estos guardan la extensión territorial 

del canvas para usos posteriores 

 

Si no le aparecen estos botones, es posible que estén escondidos bajo el siguiente botón >>: 

 a la extrema derecha de las barras de botones. 

 

 Haga click en el botón Show Bookmarks 

 
 

Aparecerá la forma Spatial Bookmarks.   

 
 

 Escoja el bookmark llamado Cuadrángulo Caguas y presione el botón Zoom to bookmark. 

 
 

El mapa cambiará su extensión territorial acomodándose a los límites del cuadrángulo topográfico de 

Caguas, PR.  
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Note que ahora aparecen algunos layers (geodatos, capas de información, niveles) de la lista que no se 

veían antes.  Estos son el sombreado topográfico y el mapa del cuadrángulo topográfico de Caguas.  

 

 Vuelva a la forma Spatial Bookmarks Panel y proceda ahora a escoger el bookmark PR-184 

Beatriz-Guavate y haga click en el botón Zoom to bookmark. 

 

 

Notará que ahora aparecerán otros layers diferentes con más detalles.  También aparecerán etiquetas con 

los nombres de las lechoneras en la carretera PR-184 en el Municipio de Cayey.: 

    
 Vuelva a la forma Spatial Bookmarks Panel y proceda ahora a escoger el bookmark PR-184 & 

PR-763 y haga click en el botón Zoom to bookmark. 

 

El despliegue de los datos tardará un poco para traer la foto aérea 2009-10 que mencionamos 

anteriormente.  Esto dependerá de la conexión al Internet y del tiempo de respuesta del servidor: 
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Dependencia de escala: 
Los layers de la lista están dispuestos de tal manera que aparecerán en el canvas según el nivel de 

acercamiento o alejamiento (zoom, escala).  De esta manera podemos establecer que algunos de los layers 

más detallados y pesados puedan ser vistos de cerca y apagarse cuando nos alejemos.   

 

La dependencia de escala se establece accediendo a las propiedades de cada layer y hacer que el 

despliegue dependa de los niveles de acercamiento.  Por ejemplo, ver las propiedades del layer Ortofoto 

2009-10: Right click > Layer Properties > Rendering 

 >  

Esto quiere decir que el ortofotomosaico solo aparecerá entre las escalas 1:1 hasta 1:10,000.   

 

La dirección URL de este servicio es:  
http://gis.otg.pr.gov/arcgis/services/Ortofotos/Orthophoto2009_10_Web_Mercator/MapServer/WMSServer  

Esta url solo funciona usando un cliente GIS que entienda el protocolo WMS. 

 Cierre la forma Spatial Bookmarks.  Luego volveremos a usarla. 

 Cierre la forma Layer Properties. 

La tabla de atributos del geodato 
Un geodato sin descripciones es solamente un dibujo con coordenadas.  Sólo podríamos decir su 

extensión, forma y posición.  Si le añadimos descripciones, datos, podemos inferir información sobre los 

mismos.  Más adelante haremos otro ejercicio en el cual podrá enlazar/relacionar esta con otras tablas de 

atributos. 

 

 Haga click primero en el layer Municipios.   

  
 

 Para ver y poder interactuar con la tabla de atributos de este geodato, use el botón Open 

Attribute Table,  localizado en el área de las barras de herramientas  

   
 

  

http://gis.otg.pr.gov/arcgis/services/Ortofotos/Orthophoto2009_10_Web_Mercator/MapServer/WMSServer
https://es.wikipedia.org/wiki/Web_Map_Service
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Esta tabla descriptiva de municipios contiene muy poca información.  Solamente tiene el nombre del 

municipio, su código censal (fips_code), perímetro (shape_length), área (shape_area) y otro campo, 

geo_id que contiene los códigos censales de cada municipio.   

 

El campo cntyidfp se usará más adelante en otro ejercicio para unir una tabla con datos censales al 

geodato de municipios.  Los códigos del campo cntyidfp están compuestos de: 

• número identificador de Puerto Rico “72” y  

• código censal municipal de tres dígitos en orden alfabético: “001” para Adjuntas hasta 

“153” para Yauco.   

  
Note que este campo cntyidfp no es numérico sino de texto, generalmente de 5 espacios.   

 

 También puede usar right-click encima del nombre del geodato en el panel de capas (layout 

panel) y escoger Open Attribute Table.: 

  
Esta tabla tiene utilidad.   

 Si quiere saber cuáles son los 10 municipios de mayor área, solo haga doble click en la cabecera 

de la columna shape_Area: (está registrada en metros cuadrados) 

 
 ¿Cuál es el municipio de mayor área? _________________ 

 ¿Cuál es el de menor área? ________________ (haga doble click otra vez para orden ascendente) 

 Cierre esta tabla para el próximo paso. 

1C. Inspeccionar atributos por elemento gráfico 
Puede ver los atributos (descripciones) de cada elemento del layer.   

 Por el momento, haga click en el botón Show Bookmarks  para abrir la forma Spatial 

Bookmarks Panel.  Proceda ahora a escoger el bookmark PR-184 Beatriz-Guavate y haga click 

http://en.wikipedia.org/wiki/FIPS_county_code
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en el botón Zoom to bookmark. 

 
 Cierre la forma Spatial Bookmarks. 

 

 En la tabla de contenido, haga click en el layer Lechoneras.  Veremos los atributos 

(descripciones) de este layer.  

  
 

 Así entonces podrá usar el botón Identify features para este layer 

 
 Usando esta herramienta, haga click en el punto llamado Lechonera Los Amigos.   

 
 Aparecerá la forma Identify Results: 

   
 

Este layers de Lechoneras tiene otras tablas relacionadas que nos dan datos sobre el menú de estos 

establecimentos.  Estas tablas (menú, correspond, etc.) no son parte del layer.  Éstas se mantienen como 

tablas separadas. 

 
En las propiedades de este proyecto QGIS se puede establecer la relación entre estas tablas y poder 

desplegar coordinadamente los records relacionados a cada establecimiento. 

  



 

Tutorial Quantum GIS 3.4 LTR 

21 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

1D: Seleccionar municipios usando SQL 
Practicará ahora a utilizar parte del lenguaje orientado a bases de datos Structured Query Language (SQL) 

para hacer consultas a la tabla de atributos usando el botón Select features using an expression.   

 

 Haga click primero en el layer Municipios.   

 
 Haga click en el triángulo del botón de selecciones interactivas para activar la lista de opciones  

Luego escoja la opción Select features using an expression. 

 
 

Escogeremos el municipio de Isabela.  Para esto usaremos la forma Select by Expression – Municipios  

 
 

 Expanda el nodo “Fields and Values” haciendo click encima de la triángulo o nodo.  

 
Este item contiene los campos y los valores de la tabla de este geodato.  

 

 Haga doble click en el campo municipio. 

 
 

En la caja de texto Expression, aparecerá entre comillas dobles la palabra “municipio”.  

 

 Haga click en el operador de igualdad =  

 En la sección Values, haga click en el botón All unique.   

Esto hará que aparezca la lista completa y así entonces podrá escoger los municipios.   

 

 Busque en la lista Field Values, el valor 'Isabela' y haga doble click encima de este valor: 

 
 

http://en.wikipedia.org/wiki/FIPS_county_code
http://en.wikipedia.org/wiki/FIPS_county_code
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La caja de texto/tab Expression deberá verse así: 

 
“municipio” = 'Isabela'  

 

 Presione el botón Select features para ejecutar la selección. 

 
 Cierre esta forma usando el botón Close. 

El área del Municipio de Isabela está seleccionada.   

 Para ver su selección, haga click el botón Zoom map to selection:  

Notará que aparecerá el Municipio de Isabela en amarillo: 
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1E: Guardar selecciones como nuevo layer SpatiaLite 
Puede seleccionar uno o más municipios y guardarlos como un layer o tabla SQLite/SpatiaLite.   

 

Teniendo seleccionado al Municipio de Isabela… 

 

 Vaya al menú principal y escoja Database > DB Manager  

 
 Aparecerá la forma DB Manager 

 

Es posible que tengamos que conectarnos al banco de datos “Guavate.sqlite”.   

Si no existe la conexión, hay que hacerla. 

 

 En las opciones bajo Providers, haga right-click en la opción de SpatiaLite 

Haga click en New Connection… 

 
 Busque el archivo Guavate.sqlite localizado en el folder C:\Tutorial_QGIS\Ejercicio_1 

 
 Haga click en este archivo y haga click en el botón Open para hacer la conexión. 

 

 En el apartado Providers, expanda el nodo SpatiaLite 
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 Expanda el nodo del archivo Guavate.sqlite 

 
 Para guardar la selección como una tabla aparte, haga click en el botón Import layer / file. 

 
 

 Aparecerá la forma Import vector layer.   

 
 

 En el apartado Input, escoja el layer Municipios el cual aparece al final de la lista de layers. 

 
 

El botón  sirve para traer geodatos o tablas externas e integrarlas a la base de datos sqlite. 

 

 Haga check en la opción Import only selected features.  Solamente convertiremos la selección 

de Isabela a una tabla/layer aparte dentro del archivo sqlite existente.   

 
 

 Haga click en el botón Update options: 

 
 

 En la sección Output table, aparece primero el nombre ‘Municipios’.   

Cambie este nombre a: Isabela. 

 
 

 Haga check en la opción Create spatial index.  

 
 

 Presione el botón OK 

Aparecerá la forma Import to database, informando que el proceso fue exitoso. 
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 Presione el botón OK para cerrar esta forma. 

Notará que ahora aparece la tabla Isabela en la lista: 

 
 Haga right click encima de esta tabla/layer Isabela y escoja la opción Add to canvas para verla 

en QGIS: 

 
 

El nuevo geodato en formato SpatiaLite (del Municipio de Isabela) aparecerá en el canvas 

 
Ya produjo su primer geodato. 

 

 Apague el layer de Isabela haciendo uncheck al lado de la caja  

 
 

 Quite la selección que hizo de Isabela en el layer de municipios usando el botón Deselect 

features from all layers: 

 
 

Pasemos a la próxima sección. 

  

Note que la simbología 

en su caso puede variar. 
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1F: Selección geográfica y por atributos 
En esta parte utilizará las funciones geográficas de búsqueda para: 

1. Seleccionar las lechoneras que estén a 30 metros a cada lado de la carretera PR-184.   

2. Hacer una subselección para determinar cuáles de estos establecimientos están certificados por el 

Departamento de Agricultura como consumidores de cerdo local. 

 

Para comenzar, debemos ubicarnos en el área de la PR-184 en Cayey.  Para esto, podemos usar uno de los 

bookmarks que usamos anteriormente.  

 

 Haga click en el botón Show Bookmarks  para abrir la forma Spatial Bookmarks.   

 Escoja el bookmark PR-184 Beatriz-Guavate.   

 Haga click en el botón Zoom to bookmark.  

 
 Cierre la forma Spatial Bookmarks Panel. 

 

Selección geográfica 
En esta parte, usaremos la herramienta de selección geográfica llamada Select by Location que nos 

permite hacer búsquedas usando aspectos geográficos tales como distancia, intersección, 

continencia, adyacencia, etc.   Estos serán explicados más adelante en el capítulo de Geoprocesamiento, 

descritos en la tabla 3.   

 

Objetivo:  Buscar establecimientos (lechoneras) que estén dentro de la zona buffer de 30 metros a 

ambos lados de la carretera PR-184 en los barrios Beatriz y Guavate del Municipio de Cayey.   

 Localice y active la herramienta Select by location en el menú principal bajo Vector > 

Research Tools| Select by location 

 

  
Aparecerá la forma Select by Location.   

Esta función se usa para las selecciones geográficas usando parámetros geográfico-geométricos 

(Geometric predicate) tales como solape, toque, continencia, entrecruzamiento entre layers. 

 
La aplicación de los distintos predicados puede variar según el propósito de búsqueda y la dimensión de 

las geometrías a comparar (si se trata de puntos, líneas o áreas/polígonos).  
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Estos predicados están definidos por el Open Geospatial Consortium,  

 
Una explicación más extensa de estos predicados se encuentra en esta página de Esri Understanding 

Spatial Relations. 

 Bajo el tab Parameters, en el apartado Select features from, escoja de la lista el layer 

Lechoneras:  

  
 En la sección Where the features (geometric predicate), escoja o mantenga la opción intersect. 

 

Pregunta:  ¿Cuál otro predicado sería 

aplicable a este caso, además de 

intersect? 

 

 En la sección By comparing to the features from, escoja el layer Buffer 30m en PR-184 Cayey. 

  
Este layer poligonal es el área que cubre una zona de proximidad de 30 metros a cada lado de esta 

carretera.  Este layer se preparó previamente para el uso de este ejercicio. 

 

 Mantenga la opción creating new selection en la sección Modify current selection by 

 
 Presione el botón Run para hacer la selección. 

 

https://en.wikipedia.org/wiki/Open_Geospatial_Consortium
http://edndoc.esri.com/arcsde/9.0/general_topics/understand_spatial_relations.htm
http://edndoc.esri.com/arcsde/9.0/general_topics/understand_spatial_relations.htm
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Notará que los puntos seleccionados aparecerán en color amarillo brillante: 

 
 

Verá también que cerca de la esquina inferior izquierda de la interfaz gráfica de QGIS aparecerá el 

número de puntos seleccionados. 

 

1G: Subselección por atributos 
En esta parte, usaremos el conjunto de establecimientos seleccionados anteriormente para escoger de 

estos, cuáles son los que están certificados por el Departamento de Agricultura como consumidores de 

cerdo local. 

Para esto, abriremos la tabla de atributos del layer Lechoneras.   

 Haga right click encima del layer y escoja la opción Open Attribute Table 

 o puede usar el botón  siempre y cuando esté activado el layer. 

 

Cuando aparezca la tabla, podrá ver los 15 récords seleccionados en color azul oscuro. 

El resto de los puntos están fuera del límite de 30 metros a los lados de la carretera PR-184. 



 

Tutorial Quantum GIS 3.4 LTR 

29 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

 

 Para hacer una subselección, deberá hacer click en el botón ε  Select features using an 

expression. 

Aparecerá la forma Select by expression  

 

 En la lista de funciones y campos, expanda el nodo Fields and Values: 

 
 Haga doble click en el campo LechDescrip_CertifAgric.  Aparecerá este en la caja de texto 

Expression: 

 

 Haga click ahora en el botón de igualdad  

 Haga click en el botón All Unique  

 Haga doble click en la opción ‘Y’  
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 En la caja de texto Expression, la expresión debe verse así: 

 
 

 En el botón Select, haga click en el triángulo para activar el combo box y escoja la opción Filter 

current selection. 

  
 Cierre la forma Select by expression. 

 

Regresará a la tabla de atributos.  Notará que hay solamente un récord.  Este es el único record que 

cumple con los criterios de proximidad a la carretera 184 y estar certificado por el Departamento de 

Agricultura como consumidor de cerdo local.  

 
 Cierre la tabla de atributos. 

Volviendo al canvas, notará el punto seleccionado en amarillo (Lechonera El Nuevo Rancho), cerca de la 

intersección de la PR-184 con la PR-763.   

 Haga click en el bookmark  PR-184 & PR-763, podrá ver el punto más de cerca. 

 
Espere que aparezca la foto aérea.  Esto puede tardar, dependiendo de la capacidad de ancho de banda 

donde ud esté radicado y la disponibilidad del servidor de mapas.  

 
 Cierre la forma Spatial Bookmarks 
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 Utilice el botón Identify  para ver la descripción de este establecimiento. 

 

 Bajo el título Identify Results, haga click en el botónView feature form  para que pueda ver 

parte del menú. 

 
 Cierre la forma Feature Attributes. 

 Cierre la forma Identify Results. 
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Opciones de navegación 
La barra de botones Navigation toolbar, tiene una decena de opciones para moverse dentro del canvas: 

 
 

 

 

 

 

 

 

 

 

 

 

Pan map: sirve para arrastrar el contenido del canvas, sin afectar la escala (acercamiento) 

Pan map to selection: mantiene fijo el nivel de acercamiento y arrastra mediante la extensión territorial 

de los elementos que estén seleccionados, sin acercar o alejar.  

Zoom in: Para acercar, haciendo una caja, arrastrando y soltando o mediante un click. 

Zoom out: Para alejar usando el mismo método 

Zoom to native pixel resolution: Aplica a datos en formato ráster (imágenes), acercando al nivel de 

resolución de la celda que compone dicho ráster. 

Zoom full: Permite visualizar la extensión de todos los geodatos que están en la lista (TOC) 

Zoom to selection: Permite visualizar todos los elementos seleccionados. 

Zoom to layer: Muestra la extensión territorial de un geodato (layer) activado en particular 

Zoom last: Nos deja volver a la extensión y nivel de acercamiento anterior. 

Zoom next: Para regresar al nivel de acercamiento después de haber usado Zoom last. 

New MapView: Aparecerá otra ventana como un nuevo canvas con múltiples opciones para navegar o 

fijar escala, etc.  

  
New bookmark: Para añadir spatial bookmarks (marcadores geoespaciales) 

Show Bookmark: Mostrar forma Spatial Bookmarks Panel 

Refresh: Redibuja el canvas. 
 

 

  

Pan map 

Pan to  

map selection 

Zoom in 

Zoom out 

Zoom to 

native pixel 

resolution 

Zoom 
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Zoom to 
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Zoom 

to layer 

Zoom  
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1H: Escala gráfica 
La escala gráfica es una relación entre la distancia real en el terreno y la distancia representada en 

el mapa, en este caso, en el canvas de QGIS.  Para ver la escala gráfica, solo necesitamos activarla de la 

siguiente forma: 

 Vaya al menú principal y escoja View > 

Decorations > Scale bar 

 
 Aparecerá la forma Scale Bar Decoration: 

 

 Haga check en la opción Enable scale bar 

 
 En Scale bar style, escoja la opción Bar: 

 
 En la sección Color of bar, mantenga color Negro para Fill y Blanco para Outline… deberían 

aparecer por defecto. 

 
 En Font of bar, haga click en el triángulo  

 

 
Escriba 8 en el tamaño de letra 

 

y escoja el color blanco para los números de la 

escala 

 En la sección Size of bar, mantenga 30 meters/km. 

 
 Mantenga la opción cotejada (check) en Automatically snap round numbers on resize. 

 
 En la sección Placement, escoja la opción Bottom right. 

 
 En Margin from edge (separación del borde del canvas), mantenga 0 en Horizontal y 0 en Vertical. 

 
 Presione OK para que aparezca la escala gráfica en el canvas. 

 

Note que ya que el fondo del mapa (la foto) es 

oscuro, la barra de escala no se percibiría si no tuviera 

un borde blanco.  Mucho menos se verán los números 

de la escala si el fondo es oscuro y los números son 

negros… 

 

 

  

Decorations? 

Contrario a lo que puede pensarse, la escala 

gráfica no siempre es necesaria.  Hay algunos 

mapas temáticos o estadísticos en los que la 

escala no aporta mucho.  Ejemplo de esto son 

algunos mapas que presentan en los periódicos 

como los resultados electorales. 
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1-i: Atributos: ¿Cómo se codifican y guardan los 

datos? 
La tabla de atributos se compone principalmente de tres tipos de dato, dos de ellos son los más comunes: 

• Texto (character, string.): letras, palabras, frases, oraciones, códigos alfanuméricos, identificadores. 

No se usan para operaciones matemáticas.  Generalmente se manipulan con funciones de texto como 

concatenaciones, extracción, etc.  Puede usarse ordenamiento (sorting). 

• Cifras, números enteros, decimales, binarios, fechas.  

En estos es común el ordenamiento y operaciones matemáticas. 

• Objetos, (datos en formato que solo puede interpretar la computadora mediante instrucciones) 

Ciertas bases de datos pueden guardar las coordenadas de un punto, línea, área, celda(s) en un campo de 

una tabla.  Usualmente se usa el tipo de dato numérico “binario” para guardarlos. 

 
Sea prudente al momento de escoger un tipo de representación numérica.   

• Evite usar números con decimales cuando sepa de antemano que todos los números del conjunto de datos 

son números enteros.   

• Use el menor espacio posible para los atributos tipo texto.  Si va a guardar un código que no pasa de tres 

espacios, no use el espacio por defecto de algunos programas (50 espacios) 

 
Al hacer esto se economiza espacio en disco y el rendimiento del programa se mantendrá óptimo. 

 

Al final, guarde su proyecto.  Debe tener el nombre ejercicio_1.qgs.   

 

 Para hacerlo, vaya al menú principal y escoja Project > Save  

 
 Cierre esta sesión de QGIS.  Vaya al menú principal en Project > Exit QGIS 

 
Esto concluye este ejercicio.  

http://es.wikipedia.org/wiki/Tipo_de_dato
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Preguntas 
Representación/codificación de los datos geográficos 

1. Mencione los tipos de representación de datos geográficos (p 10) 

______________________________________________________________________________ 

 

2. ¿Cuáles son los niveles geométricos básicos que se usan para representar la información 

geográfica en un programa SIG vectorial? (pág 10) 

______________________________________________________________________________ 

 

3. ¿Cómo se representa la información geográfica en formato ráster? (pág 11) Mencione un ejemplo. 

______________________________________________________________________________ 

 

Archivos geográficos digitales: 

4. Describa brevemente qué es un archivo Spatialite (p 11) 

______________________________________________________________________________ 

 

______________________________________________________________________________ 

 

______________________________________________________________________________ 

 

5. ¿Para qué se usa la herramienta Select by Expression de QGIS? (p 20) 

______________________________________________________________________________ 

 

6. ¿Para qué se usa la herramienta Select by Location de QGIS? (p 25) 

______________________________________________________________________________ 

 

7. ¿Qué es y para qué se usa una escala gráfica? (p 32) 

______________________________________________________________________________ 

 

8. Mencione dos tipos principales de tipo de dato para las tablas de atributos. (p 33) 

______________________________________________________________________________ 
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2.Sistemas de referencia espacial 
Tópicos de esta sección: 

 

2.Sistemas de referencia espacial ................................................................................................................ 36 

Tareas/Objetivos: .................................................................................................................................... 37 

Proyecciones cartográficas ...................................................................................................................... 38 

Algunos términos importantes ................................................................................................................ 39 

Construcción de proyecciones cartográficas ........................................................................................... 40 

2A: Aplicación local: reproyección instantánea ..................................................................................... 43 

Tareas/Objetivos ................................................................................................................................. 43 

Descarga de datos para el ejercicio ..................................................................................................... 45 

Propiedades de un geodato .................................................................................................................. 45 

2B: Reproyección permanente ................................................................................................................ 49 

Preguntas ................................................................................................................................................. 52 

Referencias .............................................................................................................................................. 53 
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Tareas/Objetivos: 
1. Conocer la importancia de los conceptos sistemas de referencia espacial, proyección 

cartográfica, datum, reproyección cartográfica instantánea y permanente, transformación 

de datums. 

2. Aplicar estos conceptos mediante un ejemplo local.  Reproyectar un geodato de manera 

instantánea y de manera permanente. 

3. Mostrar las propiedades de un geodato para conocer detalles tales como el sistema de 

referencia espacial utilizado, geometría, formato, etcétera. 

 

¿Qué importancia tienen las proyecciones cartográficas y los sistemas de referencia espacial?  Los 

sistemas de información geográfica registran posiciones, longitudes y áreas, generalmente sobre la 

superficie de la tierra.  En teoría se puede “cartografiar” cualquier espacio, ya sea por encima, encima o 

debajo de la tierra.  Este espacio es finito, pero puede ser desde tamaños subatómicos hasta tamaños 

cósmicos… 

 

¿Por qué usar proyecciones cartográficas?  La utilidad de estas es poder representar la forma de la 

tierra en una superficie plana.  Originalmente el medio para presentar mapas era el papel; ahora se usan 

computadoras y con programas de cartografía o sistemas de información geográfica.   

 

¿Cómo estas proyecciones afectan el trabajo de personas que usan SIG?  En estos días lo normal es 

usar geodatos que estén dentro de un marco de coordenadas de referencia, llamado sistema de referencia 

espacial.  Estos marcos de referencia están estandarizados, están basados en proyecciones 

cartográficas, datums, unidades de medida y se utilizan constantemente.  En algunos casos, los 

ámbitos de trabajo son a nivel planetario y en otras a nivel local: un país, un estado/provincia, municipio, 

barrio, cuenca de drenaje, etcétera…  

Una aplicación más práctica para el técnico/analista de SIG es la superposición de geodatos 

(geoprocesamiento).  Los geodatos que no estén georreferenciados correctamente pueden devolver 

resultados erróneos.  Por lo tanto, se deben tener nociones sobre estos conceptos que estaremos utilizando 

en los sistemas de información geográfica.  
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Proyecciones cartográficas 
Las proyecciones cartográficas se utilizan para modelar la superficie de la tierra (más o menos esférica) a 

un plano.  Es matemáticamente imposible modelar la superficie a un plano sin algún grado de distorsión.  

Las proyecciones se escogen según la necesidad y propósitos al hacer un mapa. 

  
Diferentes proyecciones cartográficas.   

Tomado de http://es.wikipedia.org/wiki/Proyección_cartográfica (8 marzo, 2013). 

 

Referencia espacial: 

Un programa de manejo de datos geográficos (SIG) se sirve de un sistema de referencia espacial para 

localizar las coordenadas que definen los objetos.  Estos sistemas de referencia son, por lo regular, 

estandarizados.  Esto quiere decir que las coordenadas utilizadas se refieren a un sistema de coordenadas 

que puede ser traducido a coordenadas geográficas angulares latitud y longitud en cualquier parte de 

la tierra.  Por ejemplo, un lugar cualquiera en el planeta puede representarse con una coordenada en 

unidades planas (metros, pies…) y esta localización en unidades planas, si se basa en un sistema 

estandarizado, puede ser transformada en coordenadas angulares (lat, long).  

 

Como se mencionó antes, las proyecciones cartográficas conllevan ciertas distorsiones que pueden ser en 

área, forma o ángulos y distancias.  Ninguna proyección corrige todas estas distorsiones a la vez.  Se opta 

entonces por utilizar una que sirva los propósitos para la preparación del mapa.  Para representar la 

superficie esférica del planeta se pueden usar superficies de otras figuras geométricas como el cilindro, 

cono u otras.   

  

http://en.wikipedia.org/wiki/Map_projection
http://en.wikipedia.org/wiki/Map_projection#Metric_properties_of_maps
http://es.wikipedia.org/wiki/Proyección_cartográfica
http://commons.wikimedia.org/wiki/File:Netzentwuerfe.png
http://commons.wikimedia.org/wiki/File:Netzentwuerfe.png
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Algunos términos importantes 
Sistema de referencia espacial (CRS/SRS) – Es un sistema de coordenadas, ya sea local, regional o 

global, el cual se utiliza para localizar entidades en un espacio.  La referencia espacial está compuesta de 

una proyección cartográfica, datum geodésico y unidades de medida.  Existe una multitud de sistemas de 

referencia espacial y a cada una de estas se le asigna un código identificador EPSG, por ejemplo, el 

EPSG:4326, el cual corresponde al SRS con coordenadas geográficas y datum global WGS84. 
 

Geoide – Modelo matemático de la forma de la Tierra relativamente complejo, siendo este basado en 

mediciones de la fuerza gravitacional, mediciones en el terreno y mediciones en los niveles de la marea.  

Se utiliza además para determinar altitudes mediante métodos electrónicos como los equipos de 

posicionamiento global (GPS).   
 

Geodesia – Ciencia matemática que estudia la medición de la Tierra.  Se diferencia de la agrimensura en 

cuanto a que las mediciones geodésicas toman en cuenta la curvatura del planeta.   
 

Esferoide – Modelo matemático más simple que el geoide, el cual se aproxima a la forma de una esfera 

abultada, achatada en los polos.   
 

Datum geodésico – Sistema de referencia contra el cual las posiciones están definidas tanto en el plano 

horizontal, como en el vertical.  El datum geodésico consiste al menos de una representación de la forma 

del planeta y una serie de mediciones en el terreno.  Estas mediciones se hacen de manera muy precisa, 

utilizando instrumentos geodésicos.  Para un datum geodésico vertical se toma en cuenta además las 

diferencias superficiales regionales en el campo gravitacional, diferencias de elevación en el terreno y 

mediciones en el nivel de la marea.  Estos datums son revisados periódicamente por agencias 

gubernamentales para compensar entre otras cosas, el movimiento de placas tectónicas y errores de 

medición anteriores. 
 

Proyección cartográfica – Se trata de una representación en un plano de las localizaciones, formas, 

puntos en la superficie curva del planeta.  Toda proyección cartográfica conlleva algún tipo de distorsión 

en cuanto a área, forma/ángulo y distancia.   
 

Coordenadas angulares – Coordenadas expresadas generalmente en términos de latitud y longitud.  Son 

angulares porque se miden como desviaciones con respecto un centro en el planeta que es curvo/esférico. 
 

Coordenadas planas – Coordenadas expresadas en unidades de medida/distancia, tales como el metro o 

el pie.   
 

Transformaciones de datums – Se refiere a la traslación de coordenadas de un datum de referencia a 

otro.  Puede seruna traslación entre datums locales y globales y datums recientes y otros más antiguos.    
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Construcción de proyecciones cartográficas 
Hay muchísimas proyecciones cartográficas.  Estas se pueden clasificarse por: 

1. Primero sin proyección (pero con datum), usando el datum WGS84: 

 
2. Según el tipo de distorsión (área, forma, distancia) que se quiere eliminar: 

o Equivalentes: Preservar área (superficie) 

 
o Conformes: preservar las formas o los ángulos 

                
o Equidistante: preservar distancias 

 
o Afilácticas: presentan deformaciones mínimas, pero no las eliminan. 

 
 

  

Proyección Robinson 

Proyección sinusoidal 

Proyección cónica 

conforme de Lambert 

Proyección Mollweide 

Sin proyección 
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3. Tipo de construcción o tipo de superficie que se usa para representar la esfera: 

o Cilíndricas, pseudocilíndricas,  

 
 

o Cónicas, policónicas, pseudocónicas  

 
 

o Acimutales  
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4. Por aspecto/punto de vista/eje de pivote: 

a. Normal o directo 

Usa los polos y el ecuador como puntos de referencia 

 
 

b. Transversal  

 
 

c. Oblicuo  

 
 

 
 

El PDF incluido tiene una tabla con ejemplos de proyecciones cartográficas, ejemplos y usos.  Esta fue 

tomada del manual Map Projections: A Working Manual de John P Snyder del US Geological Survey. 

 

  

Nota sobre proyecciones conformes y proyecciones equivalentes: 
Forma vs tamaño 

Mientras más se trate de representar fielmente la forma en el mapa, más se perderá la 

exactitud del tamaño.  Por lo tanto, una proyección no puede ser conforme y equivalente a la 

vez.  Si lo que se interesa es conocer el área, es mejor usar una proyección equivalente.  Si se quiere 

ser más fiel a la forma de los países, se debe usar una proyección conforme. 

http://pubs.er.usgs.gov/publication/pp1395
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2A: Aplicación local: reproyección instantánea 

Tareas/Objetivos 
1. Explicar sobre la aplicación del sistema de referencia espacial de Puerto Rico.  

2. Conocer el conceptos y usos de la reproyección instantánea y la reproyección permanente.  

3. Aplicar el conocimiento mediante un ejemplo local: reproyectar de manera instantánea y 

reproyectar de forma permanente 

 

En esta parte, demostraremos la utilidad de la capacidad de reproyección de este programa.  Estas 

reproyecciones están basadas en listados públicos con definiciones de parámetros de estos sistemas de 

referencia espacial (SRE).  Es bien importante que un geodato esté acompañado de un archivo que 

documente cuál es su SRE o CRS en inglés.  En ocasiones el geodato tiene la definición de SRS dentro 

del mismo archivo geográfico.   

1* Para la versión QGIS 3 y versiones subsiguientes, la antigua reproyección 

instantánea (OTF) no podrá ser desactivada.   

En su defecto, podemos establecer que el canvas no tendrá proyección.  

 

No use esta opción  

para este ejercicio.   

No haga check 

 

2* QGIS integra el Sistema de Referencia Espacial (SRS o CRS en inglés) del primer 

geodato añadido al canvas.   

3* Podemos cambiar el SRE del canvas en cualquier momento.   

 

La proyección cartográfica que se usa en Puerto Rico por agrimensores y técnicos de SIG es la 

proyección Cónica Conforme de Lambert, la cual usa dos paralelos y un meridiano central.  Como regla 

general, mientras más nos alejemos de estos paralelos y meridianos, mayor será la distorsión.   

 
 

La siguiente gráfica muestra los paralelos y meridianos que definen el marco de referencia para la 

proyección cartográfica que usamos en las agencias gubernamentales. 

Proyección Cónica Conforme de 

Lambert.   

Tomado de 

http://es.wikipedia.org/wiki/Proye

cción_conforme_de_Lambert  

(8 marzo, 2013) 

http://es.wikipedia.org/wiki/Proyecci%C3%B3n_conforme_de_Lambert
http://commons.wikimedia.org/wiki/File:Lambert_conformal_conic.svg
http://en.wikipedia.org/wiki/Johann_Heinrich_Lambert
http://es.wikipedia.org/wiki/Proyección_conforme_de_Lambert
http://es.wikipedia.org/wiki/Proyección_conforme_de_Lambert
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Parámetros para el uso del sistema estatal de coordenadas planas (State Plane Coordinate System).  

Tomado de Fundamentos de ArcGIS, versión ArcView 9.1, Sección VII, p. 99, nov 2005. 

 

Por virtud de la Ley 264 de 2002 y ahora sustituida por la Ley 184 de 2014, las agencias del gobierno 

estatal y municipios adoptarán el uso del sistema estatal de coordenadas planas con proyección cónica 

conforme de Lambert, usando metros como unidad de medida. El datum geodésico adoptado es el 

norteamericano de 1983 (NAD83) o su versión más reciente.   

 

La adopción de este sistema y su reglamentación no impide el uso de otros sistemas de coordenadas.  

Usamos frecuentemente latitud y longitud durante la temporada de huracanes por la simplicidad de sus 

números, que van de 0 a 180 en longitud (o X) y de cero a 90 en latitud (o Y).   

 

Los instrumentos de posicionamiento (GPS) usan el sistema geodésico de referencia global llamado 

World Geodetic Survey de 1984 (WGS84).  En Norteamérica, este datum es muy similar al NAD83 y 

para aplicaciones cartográficas pueden intercambiarse dependiendo del grado de exactitud requerida. 

 

En adelante, los datos de los ejercicios estarán utilizando el sistema estatal de coordenadas planas usando 

el datum NAD83 y su actualización más reciente NAD83(2011).  Este tiene un número identificador 

asignado: EPSG:6566,  Recuerde ese número porque lo verá frecuentemente cuando utilice geodatos de 

Puerto Rico.  Otros códigos muy usados son 4326 para WGS84 y el 3857 (Spherical Mercator usado 

por Google Maps) 

  

http://www.lexjuris.com/lexlex/Leyes2002/lexl2002264.htm
http://www.lexjuris.com/lexlex/Leyes2014/lexl2014184.htm
http://en.wikipedia.org/wiki/Geodetic_system
http://es.wikipedia.org/wiki/WGS84
http://en.wikipedia.org/wiki/SRID
https://epsg.io/6566
https://epsg.io/4326
https://epsg.io/3857
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Descarga de datos para el ejercicio 
1. Demostraremos la capacidad de reproyección/transformación instantánea dentro de QGIS usando 

geodatos de Puerto Rico.  

2. En la última parte de esta sección, usaremos un geodato de prueba derivado de un equipo GPS 

para demostrar cómo realizar una reproyección/transformación permanente de un shapefile.  

 

 

 

 

 Guarde el zip file dentro del folder Tutorial_QGIS y descomprima el archivo zip dentro de un 

nuevo directorio llamado Ejercicio_2, dentro del folder C:\Tutorial_QGIS. 

 
 

 Abra un nuevo proyecto QGIS.  En el menú principal escoja Project > New: 

 

Propiedades de un geodato 
Antes de traer un geodato al canvas de QGIS, veamos cuáles son las propiedades de este geodato.  Con 

esta opción, aparecerá una forma (Layer Properties) con tres tabs pestañas: Metadata, Preview, y 

Attributes.  Estas pestañas nos muestran datos básicos (nombre, formato, localización, sistema de 

referencia espacial, etc), la documentación (si existe), una vista previa, y la tabla de atributos 

respectivamente. 

  
 

 

Asegúrese de tener visible y activado el panel Browser (2) 

 Haga click en View > Panels > Browser (2). 

 Descargue los datos para utilizarse en este ejercicio desde este enlace. 

Datos para el ejercicio. 

http://gis.otg.pr.gov/Downloads/Tutorials/Qgis/Ejercicio_2.zip
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 Navegue el panel Browser (2) hacia el folder C:\Tutorial_QGIS\Ejercicio_2\Puerto_Rico 

 

 Haga right-click en el geodato g03_legales_municipios_edicion_octubre2015.shp. 

Escoja la opción Properties 

 
En la pestaña Metadata, podrá constatar las propiedades del geodato.   

 
El Sistema de referencia espacial (SRS) es EPSG:6566 – NAD83(2011) / Puerto Rico and Virgin Is. 

 

 Inspeccione los tabs Preview y Attributes de este geodato. 

 De esta manera podemos visualizar propiedades y contenido sin tener que cargar el geodato al 

canvas.  Cierre esta forma haciendo click en el botón Close. 

 Haga right click encima de este mismo geodato de municipios y escoja la opción Add Selected 

Layer(s) to Canvas.  

 
Aparecerá el geodato de municipios al canvas.  Además, notará que QGIS adoptará el sistema de 

coordenadas de este geodato EPSG:6566.   

 
 

El geodato de municipios deberá verse así: 
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Repetiremos el procedimiento anterior para traer el próximo geodato que representa el sistema vial, 

calles y carreteras del sur del Municipio de Guaynabo.  El archivo se llama gnbo_sur_tgr_rds2006.shp.  

Este archivo proviene de los mapas censales TIGER Files del Negociado del Censo Federal. 

Primero, acceda a las propiedades de este geodato.  

 Navegue a través del panel Browser (2), localice el geodato gnbo_sur_tgr_rds2006.shp y haga 

right click encima de este.   

 Escoja primero la opción Properties para conocer algunos detalles de este layer. 

 
Podrá inspeccionar algunas propiedades básicas como estas que aparecen en el tab Metadata. 

 
Las coordenadas que definen la geometría de este layer utilizan el CRS EPSG:6566.   

Otro dato importante es el Encoding o la codificación de caracteres.  En este y otros geodatos, se 

usa el conjunto UTF-8… Así está configurado en la base de datos PostgreSQL/PostGIS, pero… 

¿En qué manera es esto importante?  Si no escogemos el conjunto correcto, las palabras con 

caracteres especiales aparecerán de manera incorrecta.  La codificación, permite guardar, 

codificar y representar una serie de caracteres (letras, símbolos) de manera electrónica.  Escoger 

el encoding adecuado ayuda a que se pueda escribir correctamente palabras con caracteres 

especiales como las letras que tienen acentos y tildes.  Este geodato utiliza el conjunto UTF-8.   
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 Haga right click encima del nombre gnbo_sur_tgr_rds2006.shp y escoja la opción Add 

Selected Layer(s) to Canvas 

 
QGIS hará la transformación de datums automáticamente y ubicará el layer en la posición adecuada. 

 Para ver este geodato más de cerca, vaya al panel Layers, haga right click encima de este 

geodato y escoja la opción Zoom to Layer. El sistema vial local deberá verse más o menos así 

dentro del Municipio de Guaynabo: 

 
Primero, note que aparecen dos categorías en la leyenda, en la tabla de contenido (lista de 

layers).  Esto fue definido anteriormente usando las opciones de simbología de QGIS y fue 

guardado en un archivo qgis style layer file “qml”.  Este archivo de texto se guarda con el 

mismo nombre del shapefile y aparecerá asociado al mismo, cada vez que lo traigamos.  Lo 

mismo sucede con el layer de municipios y el próximo geodato que añadiremos.  

 
 Ahora utilice el mismo procedimiento para traer el próximo shapefile sample_gps_points.shp, 

usando el Browser(s).  Este geodato está localizado en el folder Puerto_Rico. 

o Primero acceda a las propiedades del geodato y preste atención al CRS del geodato. 

¿Cuál es el sistema de referencia espacial (CRS o SRS) y datum de este geodato? 

______________________________________________________________ 

o ¿Qué unidad de medida utiliza? 

______________________________________________________________ 

o Luego de inspeccionarlo, añádalo a la lista de layers mediante la opción Add selected 

layer(s) to canvas 

Aparecerá en el canvas un layer con unos puntos de muestra que se tomaron con un equipo GPS 

Garmin76 en el área sur-central del Municipio de Guaynabo.   
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¿Cómo aparecen alineados estos puntos?  Inspeccione más de cerca usando herramientas de navegación: 

 
____________________________________________________________________________________

____________________________________________________________________________________ 

2B: Reproyección permanente 
Se recomienda que los geodatos utilicen el mismo sistema de referencia espacial:  

o Al entrar/registrar datos en la computadora/base de datos (digitalización) 

o Cuando hagamos procesos de análisis de geodatos (geoprocesamiento). 

 

Para esta parte del ejercicio, cambiaremos el sistema de referencia espacial (CRS) de un layer de puntos 

tomados con un equipo GPS al sistema EPSG:6566 (NAD83(2011) PR & USVI).   

 

Para cambiar el CRS de forma permanente, es necesario derivar/crear otro geodato; shapefile en este 

caso.   

 Haga right click encima del geodato sample_gps_points y escoja Export > Save Features As... 

 
 En la forma Save vector layer as que aparecerá, mantenga el formato ESRI Shapefile 

 



 

Tutorial Quantum GIS 3.4 LTR 

50 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

 En la sección, File name, presione el botón  Browse: 

 
 En la forma Save layer as… que aparecerá, asegúrese de que esté ubicado en el folder 

Tutorial_QGIS\Ejercicio_2\Puerto_Rico 

 En la caja de texto File name: escriba sample_gps_points_6566.shp 

 
 Presione el botón Save. 

 

 De vuelta a la forma Save vector layer as… presione el botón Select CRS… al lado derecho 

del combo box Select CRS (EPSG:4326, WGS84) 

 
 En la forma Coordinate Reference System Selector que aparecerá, en la caja de texto Filter, 

escriba 6566 

 
 En la sección Coordinate reference systems of the world, escoja el sistema 

NAD83(2011)/Puerto Rico & Virgin Is. Con código EPSG:6566 

  
 Estos son los parámetros del sistema escogido para la transformación de coordenadas: 

 
 Presione el botón OK en esta forma Coordinate Reference System Selector. 

 

 De vuelta a la forma Save vector layer as…, mantenga check en la opción Add saved file to 

map. 

 
 Deje las demás opciones como están. 

 Presione OK para correr el proceso y derivar el nuevo archivo con la transformación de 

coordenadas.   

Le aparecerá este mensaje: 
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 Coteje cuál es el CRS del nuevo layer, yendo a las propiedades del nuevo layer.  

Right click encima del nuevo layer > Properties > click en el tab/pestaña Information 

 
……………………. 

  

 

El nuevo layer está referenciado geográficamente usando el sistema EPSG:6566. 

 Guarde este proyecto con el nombre re-proyecciones.qgs.  Cierre el programa QGIS. 
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Preguntas 
1. Un Sistema de Referencia Espacial (CRS o SRS): (p 38) 

a. Se compone de modelos matemáticos que representan la forma y medidas de la tierra 

b. Puede basarse en una proyección cartográfica 

c. Puede utilizar coordenadas planas (metros, pies) o angulares (lat, long) 

d. Todas las anteriores 

 

2. Las proyecciones cartográficas son: (p 38) 

a. Dibujar un mapa en un papel 

b. Representación matemática de la forma de un lugar en la superficie redondeada de la 

Tierra en un medio plano como un papel, una pantalla de computadora, o un medio para 

imprimir. 

c. Representación geométrica plana de manera simplificada y convencional de toda o parte 

de la superficie terrestre, según su nivel de acercamiento.   

d. Alternativas a y b. 

 

3. Cierto/Falso: ¿Una proyección cartográfica puede ser equivalente y conforme a la vez? (p 41) 

 

4. El modelo matemático más complejo de la forma y dimensiones de la Tierra es: (p 38) 

a. Esfera 

b. Esferoide 

c. Geoide 

 

5. Un datum geodésico se desarrolla mediante: (p 38) 

a. Mediciones en el terreno 

b. Usando instrumentos geodésicos 

c. Revisiones periódicas tomando mediciones en el campo 

d. Todas las anteriores 

 

6. Las transformaciones entre datums consisten en el traslado de coordenadas de un sistema de 

referencia espacial a otro.  Estas pueden ser: (p 38) 

a. Solo entre datums que usen el mismo elipsoide de referencia 

b. Entre cualquier datum, si se conocen los parámetros que los definen 

c. Todas las anteriores 
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Tareas/Objetivos: 
1. Importancia de la entrada de datos gráficos (digitalizar), así como la entrada de datos en 

tablas. 

2. Aplicar estos conceptos mediante un ejemplo local.  Digitalizar una sección de un mapa 

geológico simplificado para este ejercicio.   

3. Entrar datos en tablas y realizar cálculos simples del campo/field de área o cabida en 

múltiples filas simultáneamente usando la herramienta Field Calculator. 

 

Debemos tener nociones sobre cómo entrar datos usando programas de manejo de información 

geográfica, hojas de cálculo y bases de datos.  En ocasiones usted hará estudios de campo y deberá 

colectar los datos, configurar (dibujar, trazar) localizaciones, segmentos, áreas, interpretar fotos o 

imágenes satelitales y derivar datos de otras fuentes.  En otras, habrá datos, a menudo en forma digital 

pero ud necesitará extraer información, especialmente de mapas históricos escaneados, imágenes y fotos 

aéreas. 

 

Aparte de las herramientas de dibujo técnico (CAD), los programas de manejo de datos geográficos 

(GIS/SIG) están especializados en la entrada de este tipo de datos, reduciendo la realidad geográfica en el 

campo a tres dimensiones geométricas:  

• Punto: Para registrar localidades simples 

• Línea: Para registrar segmentos 

• Área: Para registrar superficies o áreas cerradas 

 

El ejercicio constará en: 

• Digitalizar los límites de las unidades geológicas del área a trabajar. Estos límites se 

digitalizarán en QGIS mediante geometría multilínea.   

• Usar el ambiente de enganche (snapping environment) para asegurar que los extremos 

(contornos) de las líneas coincidan.   

• Generar polígonos de unidades geológicas a partir de estas líneas, usando la herramienta 

Polygonize en el panel Processing de QGIS.   

• Importar el geodato temporal producto de la herramienta Polygonize al banco de datos 

SpatiaLite como una tabla geoespacial permanente. 

• Modificar la tabla de atributos del geodato de unidades geológicas para añadirle los campos 

descriptivos y área en cuerdas.  

• Usar la herramienta Field Calculator para calcular el área en cuerdas para cada polígono de 

unidad geológica. 
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En esta parte, vamos a usar QGIS para la entrada de datos, en este caso, vectorizar una sección 

simplificada de un mapa existente de unidades geológicas (del cuadrángulo geológico de Barranquitas) 

cerca del Cañón de San Cristóbal.  Este cañón está localizado en el río Usabón, entre los municipios de 

Barranquitas y Aibonito.  El río Usabón formó este cañón, erosionando la roca volcánica sedimentaria 

subyacente.   

  
Fuentes: OpenStreet Maps, US Geological Survey (contornos), Junta de Planificación (municipios, 2015) 

3A: Descargar los geodatos 
 Haga una carpeta nueva y nómbrela Ejercicio_3, dentro del directorio C:\Tutorial_QGIS\.   

---------------------------------------------------------------------------------------------------------------------- 

Los geodatos para este ejercicio están disponibles en el siguiente enlace:  

---------------------------------------------------------------------------------------------------------------------- 

 Proceda a descomprmir los archivos mencionados al principio de este ejercicio.   

 
 

 
 

  

NOTA: Todos estos geodatos están en formato SpatiaLite comprimido ZIP.  

Debe descomprimirlos para continuar las prácticas.  Use la herramienta de 

descompresión de su sistema operativo, o Winzip, 7Zip, WinRar, etc.   

Descomprímalos dentro del folder: C:\Tutorial QGIS\Ejercicio_3  

https://pubs.er.usgs.gov/publication/i336
http://gis.otg.pr.gov/downloads/tutorials/qgis/Ejercicio_3.zip
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3B: Establecer el sistema de coordenadas por 

defecto para los proyectos QGIS 
Es altamente recomendable mantener los datos en un solo sistema de referencia espacial, 

especialmente para: 

• análisis geográfico (geoprocessing)  

• entrada de datos geográficos.   

 

En esta parte usaremos el sistema de referencia espacial oficial para las agencias de gobierno de 

Puerto Rico: el EPSG:6566, NAD83(2011), además de otras opciones. 

 Comience una sesión de QGIS, si es que no la tiene activada. 

 Vaya al menú principal y escoja Project > New. 

 
 Nuevamente en el menú principal, escoja Settings > Options 

 
 En la forma Options que aparecerá, haga click en la opción CRS  

 
 

En la sección Default CRS for new projects … 

 Haga click en el botón Select CRS… 

 
 En la forma Coordinate Reference System Selector que aparecerá, en la caja de texto Filter, 

escriba 6566 

 
 En la sección Coordinate reference systems of the world, escoja el item NAD83(2011) / 

Puerto Rico & Virgin Is. con identificador EPSG:6566. 

 
 Presione OK en esta forma. 

Así debe aparecer esta sección ahora: 
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 Siguiendo, en el apartado CRS for new layers, escoja la opción Use default CRS displayed 

below.  

 
El propósito de esto es definir el CRS por defecto para cada geodato nuevo que vayamos a construir.  

Cambiaremos el sistema EPSG:4326 (WGS1984), por el CRS NAD83(2011).  Vamos a usarlo para 

construir geodatos nuevos más adelante en la otra sección. 

 Presione el botón Select CRS…  

 En la forma Coordinate Reference System Selector que aparecerá, en la caja de texto Filter, 

escriba 6566 

 
 En la sección Coordinate reference systems of the world, escoja el item NAD83(2011) / 

Puerto Rico & Virgin Is. con identificador EPSG:6566. 

 
 Presione OK en esta forma. 

 

Así debe aparecer esta sección: 

 
 Presione OK en la forma Options | CRS para aceptar los cambios.  

 

Podrá constatar al extremo inferior derecho de la interfaz gráfica de QGIS, que el sistema de referencia 

espacial del canvas debe ser EPSG: 6566 

 
 

 
  

Este símbolo  es a su vez, un botón que le traerá a la forma Project properties|CRS.  

Es otra forma de modificar el sistema de referencia espacial (CRS-SRS). 
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3C: Añadir los geodatos para el ejercicio 
Una vez tenga estos shapefiles descomprimidos y guardados en el lugar indicado, traiga primero el 

geodato que contiene los contornos de las unidades geológicas.  Este es un pequeño pedazo del 

cuadrángulo geológico de Barranquitas-PR, a escala 1:20,000.   

 
Este es un geodato ráster (imagen) en formato jpeg.  El mapa esquemático tiene menos detalle que el original.  

 Para traer este geodato al canvas, use el botón Add Raster Layer, localizado en la barra de 

botones a la izquierda de la interfaz gráfica de QGIS. 

 

Esta barra de botones se llama Manage Layers Toolbar.   

En caso de que no le aparezca, puede hacerla visible desde el  

Menú principal > View > Toolbars > Manage Layers Toolbar 

 

 

 

Aparecerá la forma Data Source Manager.  Ya estará activado el tab Raster para traer datos en formato 

raster  

 Vaya al apartado Source y haga click en el botón  Browse para buscar el geodato raster. 

 
Aparecerá la forma Open GDAL Supported Raster Data Set(s)  

 

 

¿Qué es GDAL? 

 
Fuente: https://es.wikipedia.org/wiki/GDAL (junio 5, 2019) 

https://pubs.er.usgs.gov/publication/i336
http://www.gdal.org/
https://es.wikipedia.org/wiki/GDAL
http://www.gdal.org/
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 En el combo-box o lista de formatos en la esquina inferior derecha de esta forma, escoja JPEG 

JFIF (*.jpeg *.JPG *.JPEG) 

 
Deberá aparecer en la lista de archivos, el raster exer_3_geol_sketch.jpg, el cual tiene la delimitación de 

las unidades geológicas.   

 Escójalo y haga click en el botón Open: 

 

 De vuelta a la forma Data Source Manager|Raster, haga click en el botón Add  

En la parte superior de esta forma, aparecerá la advertencia: 

 
Significa que el raster jpeg a usar ahora, no tiene información de su 

sistema de referencia espacial.  QGIS asignará a este geodato el SRS 

EPSG:6566.  Este jpg tiene un archivo suplementario jgw (world file) que 

provee a QGIS la información de las coordenadas, tamaño de celda, giro 

(rotation)… (archivo exer_3_geol_sketch.jgw). 

 Cierre la forma Data Source Manager, haciendo click en el botón Close. 

El ráster aparece así en el canvas: 

 

Cambiar la transparencia del layer 
Es conveniente hacer este layer ráster traslúcido antes de proceder a añadir otros datos y a digitalizar 

trazando las líneas sobre el mismo.  Esto nos ayudará a distinguir mejor las líneas que vamos a trazar 

por encima de los contornos rojos del layer ráster. 

 Para hacer traslúcido el geodato, haga right click encima del nombre del layer ráster 

exer_3_geol_sketch y escoja Properties.  

 
………………….. 
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Aparecerá la forma Layer Properties – exer_3_geol_sketch 

 
 Haga click en el ítem Transparency  

 
 En la sección Global Opacity, arrastre el botón del slidebar hasta 70% 

 
 Presione el botón OK en esta forma Properties para aceptar los cambios y cerrarla.  

Añadir layer de área de interés 
Procederemos a añadir el geodato del área de interés.  Este nos servirá de referencia para delimitar los 

contornos y los polígonos que vamos a generar.   

 Para esto, vaya al menú principal y escoja Database > DB Manager 

 o use el botón  

Aparecerá la forma DB Manager.   

 En esta forma, vaya a la sección Providers,  

haga right click en el ítem Spatialite y  

escoja New Connection… 

 
 Para hacer la conexión con el archivo ejercicio_3.sqlite, seleccione este archivo. Este debe estar 

localizado en C:\Tutorial_QGIS\Ejercicio_3 

 

Este banco de datos contiene varios geodatos y 

posteriormente contendrá los layers que se van 

a construir.   

 

 Haga click en el botón Open para hacer la conexión y cerrar esta forma.  

 

Aparecerá la conexión de este banco de datos en la lista Providers.   



 

Tutorial Quantum GIS 3.4 LTR 

62 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

 Expanda el nodo de esta conexión haciendo click en el triángulo (nodo): 

 
Podrá ver la lista de tablas 

 Para añadir el geodato/tabla aoi_exer_3 al canvas, haga right click en esta tabla geoespacial y 

escoja la opción Add to canvas. 

 
 Cierre la forma DB Manager.   

Así debe aparecer el geodato de área de interés con el borde amarillo.  Este borde nos ayudará a producir 

la línea exterior y los polígonos de las unidades geológicas:   
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Si el geodato aparece completamente opaco, como en este ejemplo, 

  
haga lo siguiente: 

 Para asignar una simbología predefinida al geodato, haga right click encima del nombre del 

layer ráster exer_3_geol_sketch y escoja Properties.  

 
………………….. 

      
 Haga click en el ítem Symbology.   

 
 En la parte inferior izquierda de esta forma Layer Properties|Symbology,  

haga click en el botón Style y 

escoja la opción Load Style…  

  



 

Tutorial Quantum GIS 3.4 LTR 

64 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

 En la forma Database styles manager que aparecerá, siga los pasos según la siguiente figura 

 

 

1. En la sección Load style, escoja from databse 

(spatialite) 

 

1.a Mantenga las categorías como están. 

 

 

 

 

 

 

 

2. En la sección Other Styles on the database, 

escoja bajo Name, el ítem aoi_exer_3 

 

3. Haga click en el botón Load style 

Ahora el geodato de área de interés debe tener asignada la simbología correcta. 

 

3D: Generar un nuevo geodato en SpatiaLite 
Para registrar geodatos en un sistema de información, ya sea SIG/GIS, es necesario codificar o 

reinterpretar la información que percibimos y traducirla o reducirla a una forma digital como entrada 

en la computadora.  Como vimos antes, los datos geográficos (vectoriales) se representan en sistemas de 

información geográfica y CAD mediante tres dimensiones geométricas: puntos, segmentos, áreas o 

superficies (comúnmente llamadas “polígonos”). 

 

Objetivos/Tareas 

• Generar un geodato tipo área/superficie que contenga unidades geológicas en una zona dada.   

• Definir un nuevo geodato 

• Establecer parámetro de enganche entre segmentos; reglas topológicas simples 

• Digitalización de segmentos de línea, trazando manualmente sobre mapa geológico 

• Usar herramienta para convertir los contornos (segmentos) en áreas cerradas 

• Practicar la entrada de datos tabulares 

• Calcular varias filas en una columna de cabidas usando Field Calculator 

 

En esta parte, nos concentraremos en hacer un nuevo geodato dentro de la base de datos SpatiaLite.  

Se trata de un archivo/tabla en SpatiaLite con geometría de líneas.  Esta se usará para delimitar los 
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contornos de las unidades geológicas.  Además, nos servirán posteriormente para generar otro geodato de 

polígonos, el cual contendrá las áreas (interior) de las unidades geológicas, así como heredará los campos 

del geodato de líneas.    

Definir el nuevo geodato SpatiaLite en QGIS 
QGIS nos provee la opción de generar una nueva tabla/geodato tipo SpatiaLite Layer.   

 Vaya al menú principal y escoja Layer > Create Layer > New SpatiaLite Layer… 

 
Aparecerá la forma New Spatialite Layer 

 
 En el apartado Database, debe aparecer el archivo 

C:/Tutorial_QGIS/Ejercicio_3/ejercicio_3.sqlite, el cual corresponde a la conexión que 

realizamos en tareas anteriores. 

 
 

 En Layer name, escriba el nombre del nuevo layer: geol_contornos.  Este es el geodato que 

usaremos para registrar el trazado de contornos de cada unidad geológica y será el input para derivar el 

geodato de áreas para las unidades geológicas. 

 
 

 En la sección Geometry type, escoja la opción Line 

 
Puede usar la opción Multiline también en este caso.  

 No haga check en las opciones Include Z dimension ni en Include M values 

 
¿Por qué? No necesitamos que las coordenadas que componen estos segmentos tengan elevaciones (u otra medida 

adicional tipo “Z”) así como tampoco, valores de mediciones “M”, tales como kilometrajes para localizar puntos y 

segmentos dentro de un segmento (esto es conocido como referencia lineal). 

 

 Mantenga el sistema de referencia espacial (EPSG:6566) que habíamos fijado al principio de este 

ejercicio: 
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 En los apartados New Field y Field List, deje las opciones como están porque no vamos a 

añadirle datos a los segmentos. 

 
 

 Expanda la sección Advanced Options 

 

 Verifique que tenga check en la opción Create an autoincrementing primary key.  

 
Geometry column puede quedarse como geometry.  Esto es solo una etiqueta de la nueva 

columna que contendrá las coordenadas de los vértices de segmentos. 

¿Por qué es importante mantener la opción autoincrementing primary key?  Esto hará que cada vez 

que usted vaya a producir un elemento (líneas en este caso), se produzca un identificador secuencial único.  Esto es 

fundamental para identificar y visualizar los geodatos en QGIS.   
 

 Presione OK en esta forma New SpatiaLite Layer para aceptar las definiciones del nuevo 

layer/geodato. 

El nuevo geodato aparecerá en la tabla de contenido/lista de layers: 

 

Suprimir la aparición del formulario de entrada de datos 
Para añadir las líneas de los bordes de las unidades geológicas no será necesario añadir ningún dato 

adicional al número ID que será asignado automáticamente.  Por lo tanto, es conveniente suprimir la 

aparición del formulario de entrada de datos en la tabla de atributos. 

 Vaya al menú principal y escoja Settings > Options. 

 En la forma Options que aparecerá, haga click en el ítem Digitizing 

 
 En la sección Feature creation, haga check en la opción Supress attribute form pop-up after 

creation 
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 Haga click en el botón OK para cerrar esta forma. 

3E: Establecer snapping environment (ambiente de 

enganche) 
Antes de empezar a añadir líneas al nuevo geodato, trabajaremos con la herramienta de enganches 

(snapping).  Esta se utiliza para asegurar la coincidencia de los extremos, vértices o contornos de las 

geometrías.  Por ejemplo, para generar un polígono, hará falta una línea/anillo ring cerrada, en la cual los 

extremos (contornos, principio y fin) de la línea coincidan.  

 
De lo contrario, si la línea no cierra, no se genera el área porque no está cerrada.  

Snapping toolbar 
Se trata de un conjunto de herramientas para facilitar una entrada de datos de manera más exacta.   

   Parece simple, pero contiene múltiples opciones. 

Puede verse así: 

 
Si no le aparece, vaya al menú principal > View > Toolbars > Snapping Toolbar 

 

¿Qué haremos con estas opciones? 

• Activar las opciones de enganche “snapping” 

• Establecer umbral de distancia en metros para fijar el enganche al digitalizar 

• Edición topológica para mejorar la entrada de datos 

• Producir vértices donde haya cruces de líneas para mejorar la digitalización 

Prosigamos. 

 Primero haga click en el botón  para activar el ambiente de enganche Enable snapping 

 

 En la sección Snapping tolerance in defined units, escriba 5.00 y escoja meters. 

 
 ¿Por qué 5 metros (no más ni menos)?  Por lo general el umbral recomendado está relacionado 

con la escala de compilación del mapa original.  Ningún geodato, por mejor que se haya 

digitalizado, superará la precisión original del mapa en papel.   
Escala de compilación: El mapa geológico original fue compilado a escala 1:20,000.  El estándar 

cartográfico clásico de EEUU (NMAS) establecía que para escalas mayores de 1:20,000 el umbral de 

error permitido es 1/30 de pulgada.  Esto es para mapas impresos.  El estándar depende de la escala de 

compilación.  La escala está ligada al nivel de detalle del mapa.  En otros países el umbral es 0.5 

milímetros.  Ya que estamos preparando un geodato en formato digital, podríamos usar este umbral de 

0.5 milímetros.  Si la escala es 1:20,000, el nivel de detalle sería 10 metros.  Además, podemos hacer 

acercamientos, así que podríamos fijar la tolerancia de enganche (snapping) a 5 metros… 

http://nationalmap.gov/standards/pdf/NMAS647.PDF
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Este parámetro es Snapping tolerance.  No se debe confundir con el término “cluster tolerance” de 

ArcGIS.  QGIS no utiliza un sistema de cluster tolerances como ArcGIS, por lo cual algunos resultados 

pueden ser diferentes en el procesamiento de los datos.   

 

 Haga click en el botón Enable topological editing .  Esto le avisará cuando cuando haya 

algún problema con reglas topológicas; por ejemplo, registrar dos o más vértices de un segmento 

en el mismo lugar.  

 Haga click en el triángulo del botón Snapping Options  y escoja la opción Open Snapping 

Options 

.   

Aparecerá la forma Project Snapping Settings.  En este formulario podrá hacer ajustes más refinados.   

 Haga los arreglos necesarios para que su formulario esté de acuerdo con la siguiente figura.   
Snapping ON, All Layers, Vertex and Segment, 5.00 meters, Topological Editing, Snapping on 

Intersection 

 
 Cierre esta forma cuando haya hecho los ajustes. 

Esto hará que usemos las mismas coordenadas de la caja aoi (Area of Interest) para generar el límite externo.  Las 

líneas se podrán pegar, tanto a vértices, como a segmentos (edges, o secciones de la línea que no tienen vértices).  

Además, se producirá un vértice adicional an cada punto en el cual se crucen dos o más líneas.  Esto es importante 

como mencionamos antes, además de cumplir con las reglas topológicas y facilitar los geoprocesos.  Este tema se 

discutirá más adelante en el capítulo de geoprocesamiento.  
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3F: Trazar líneas del geodato de límites de unidades 

geológicas 
En esta parte vamos a añadir los contornos/límites de cada unidad geológica que está dentro de la caja o 

área de interés delimitado previamente.  Antes, queremos presentar el grupo de herramientas básicas que 

forman parte del Digitizing toolbar de QGIS. 

Digitizing toolbar: 

 
 

Estas dos barras de herramientas, se usan para el registro de geometrías de polígonos regulares , 

irregulares y complejos.   

Advanced Digitizing toolbar, para digitalización avanzada, con más opciones, especialmente para 

registrar áreas (polígonos irregulares)… 

 
 

Shape Digitizing toolbar se utiliza para añadir arcos, círculos, elipses, cuadrados o rectángulos, además 

de polígonos regulares.   

 
 

Volviendo a nuestra tarea, vamos a trazar las líneas, siguiendo lo mejor posible, el mapa de fondo (en 

formato jpeg).  

 

  

Editar múltiples layers simultáneamente 

Editar un layer a la vez 

Guardar cambios (Save) 

Añadir líneas 

Mover vértices 

Modificar atributos de elementos seleccionados 

Borrar elementos 

Cortar (cut) elementos guardando en memoria volátil RAM  

Hacer copia de elementos (cut/paste) 

Traer (paste) copia de elementos 

Eliminar un paso de proceso (Undo) 

Rehacer un paso de proceso (Redo) 
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Antes de comenzar a registrar las líneas, sería deseable que estas nuevas resalten sobre el fondo.   

 Para lograrlo, haga right click en el layer geol_contornos y escoja Styles > Click en el cuadro 

negro, más debajo de la rueda de colores… 

 
Para hacer el registro de contornos de manera más fidedigna, podemos hacer uso de las herramientas de 

acercamiento y panning disponibles en QGIS.  Por ejemplo: 

 Use la herramienta Zoom in  y haga una caja (click &arrastar/drag) en el lugar indicado 

(Krq): 

 
 Antes de comenzar, asegúrese que el layer geol_contornos esté seleccionado: 

 

 Haga click en el botón Toggle Editing:  

 Para añadir geometrías (en este caso, líneas) haga click en el botón Add Features:  
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Antes de empezar…. 

QGIS tiene maneras de navegar, a la vez que añadimos geometrías:  

Zoom in/out: usar botón scroll del mouse 

 

Panning usar tecla spacebar 

 

Borrar vértice usar tecla backspace 

 
 Ahora, notará que el cursor cambiará a una forma así: 

 

 
 Comience a trazar líneas usando el botón izquierdo del mouse.  Empiece donde comiencen las 

líneas, fuera del borde amarillo.  

 

NOTA IMPORTANTE: 

No registre más de un vértice (node) de línea (dos o más clicks) en el mismo lugar.   

Esto le devolverá un mensaje de error como este: 

 

Use la tecla backspace para borrar vértices repetidos en la línea.   

  X VERDE = VÉRTICE REPETIDO 

Si deja vértices repetidos, los resultados del resto del ejercicio perderán validez y las funciones a usarse 

tendrán resultados inesperados. 

 



 

Tutorial Quantum GIS 3.4 LTR 

72 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

 A medida que se va acercando a la línea amarilla, aparecerá una pequeña X, color rosado 

brillante… 

  
 Continúe trazando la línea de este contorno del polígono del mapa raster… 

  
RECUERDE  

Usar la tecla BACKSPACE para borrar vértices secuencialmente 

Usar la tecla ESCAPE para borrar todo el segmento que no ha sido terminado. 

 Use la tecla Spacebar si necesita hacer panning 

 
Use el botón scrollwheel del mouse para hacer zoom in/out, según sea necesario… 

 Añada el último vértice de este contorno: 

 
 Haga click en el botón derecho del mouse para terminar de añadir vértices.   

  

Esto le muestra que esta geometría está 

disponible para enganchar y crear un vértice en 

esta intersección.  Crear el vértice será útil para 

otras operaciones de geoprocesamiento 
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Su primera línea debería verse más o menos así.   

  
 Para continuar, ubíquese cerca del extremo final de la línea que acaba de añadir.  Notará que 

aparece un cuadro en color rosa brillante: 

 

Esto le indica que se pegará al extremo (contorno de esta 

línea) 

 Comience a añadir vértices a la próxima línea, comenzando por este extremo y termine la línea 

fuera de la caja con el borde amarillo.  Use las opciones zoom/panning, según sea necesario. 

 
 Use el botón derecho del mouse para terminar de añadir vértices.   

Así debe aparecer la segunda línea del contorno de esta unidad geológica.   

 

 Haga click en el botón Save Edits  para ir registrando las líneas en la base de datos 

SpatiaLite. 

 Haga click en el botón Zoom Full  para ver la extensión completa. 
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 Haga click en el botón Zoom In  y haga una caja (click+drag) cubriendo el contorno 

siguiente: 

 

 Haga click en el botón  para continuar registrando otros contornos del mismo modo, 

asegurándose que los extremos de las líneas hayan enganchado.   

 Continúe añadiendo la próxima línea.  Note que aparecerá un cuadro rosado brillante en los 

puntos extremos de las líneas: 

 

Prosiga, añadiendo vértices a este contorno hasta 

que llegue al final. 

 

Recuerde sobrepasar la línea amarilla. Esto 

asegurará el ciere del área y poder generar áreas 

posteriormente.  

 Haga click en el botón Save Edits  para ir registrando las líneas en la base de datos 

SpatiaLite. 

 Continúe con la próxima línea.  Haga click en el botón Zoom Full  para ver la extensión 

completa. 

 Haga click en el botón Zoom In  y haga una caja (click+drag) cubriendo el contorno 

siguiente: 
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Puede hacer click en el botón Zoom In  para 

poder ver más de cerca el contorno. 

 

Haga click en el botón  Add Line Feature 

para añadir vértices al contorno. 

Use la tecla spacebar para hacer panning (desplazarse) luego de registrar vértices.   

 Continúe añadiendo vértices hasta terminar la línea sobrepasando el límite de línea amarilla: 

 

Haga right click para terminar esta línea 

 Haga click en el botón Save Edits  para ir registrando las líneas en la base de datos 

SpatiaLite. 
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 Haga click en el botón Zoom Full  para ver la extensión completa. 

 
Añada ahora las líneas que definen la caja o área de interés.   

 Haga click en el botón  Add Line Feature para añadir vértices al contorno.   

Comience por la esquina superior izquierda.  Verá el cuadro rosado, indicando que está encima 

del vértice que define estas esquinas del AOI 

 

Añada vertices solo en las esquinas, siguiendo el orden de estas 

flechas:  

Superior derecha: 

 
Inferior derecha: 

   
Inferior izquierda: 

 
Superior izquierda nuevamente para cerrar: 

  
Haga right click en el botón derecho del mouse para terminar este 

segmento: 

 
 

  



 

Tutorial Quantum GIS 3.4 LTR 

77 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

Así debe verse el resultado: 

  

Haga click en el botón Save Edits  para ir registrando las líneas en la base de datos SpatiaLite. 

 Haga click en el botón Toggle Editing  para cerrar la sesión de edición. 

3G: Generar los polígonos a partir de líneas usando 

la herramienta Polygonize 
En esta parte vamos a generar polígonos a partir de las líneas que hemos trazado en la parte anterior.  

Estas líneas (que deben estar cerradas o deben intersecar el cuadro) servirán de contornos para derivar las 

áreas cerradas (polígonos irregulares).  Usaremos la función Polygonize, la cual se puede encontrar en las 

herramientas de geoprocesamiento de QGIS. 

 

 Vamos a usar estas líneas para generar áreas cerradas. Vaya al menú principal y escoja 

Processing > Toolbox. 

 
Aparecerá la forma Processing Toolbox.   

 En la caja de texto, escriba polygonize. 

 
 

El árbol (tree) mostrará las herramientas disponibles con ese nombre.  Hay dos funciones.  La función 

GDAL Polygonize, se usa para datos tipo ráster y es para generar polígonos vectoriales desde un mapa 

raster que represente áreas (ráster temático). No es nuestra tarea ahora. 

 

La herramienta que vamos a usar es  Polygonize, la cual es 

parte de los geo-algoritmos  Vector geometry de QGIS. 
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 Haga doble click en esta función Polygonize vectorial. 

Aparecerá la forma Polygonize.   

 En Input layer, mantenga el geodato geol_contornos [EPSG:6566] 

 

Haga o mantenga check en la opción:  

✓ Open output file after running algorithm 

 No use la primera opción Keep table structure… 

 

 En el apartado Polygons from lines, mantenga la opción por defecto [Create temporary layer].  

Esto es conveniente porque el resultado se mantiene en la memoria RAM.   

 
 Haga click en el botón Run para aceptar los cambios y poner a trabajar esta función. 

 

 Cierre esta forma cuando haya terminado el trabajo.  

 

Luego que termine de hacer el trabajo, aparecerá el nuevo layer ‘Polygon from lines’, en la tabla de 

contenido…  

…y en el canvas de QGIS.  Los colores pueden variar.   

  

3H: Importar el geodato temporal dentro de la base 

de datos SpatiaLite 
Vamos a aprovechar para importar este layer temporal a la base de datos SpatiaLite como otra tabla 

geoespacial.   

 Vaya al menú principal y escoja Database > DB Manager 

 o hacer click en el botón  

 Para conectarnos a este banco de datos y guardar el layer temporal, vaya a la sección Providers y 

expanda el nodo debajo de Spatialite: ejercicio_3.sqlite 

   >>>      

 Para guardar este layer temporal en el banco de datos, haga click en el botón Import Layer/File 
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Aparecerá la forma Import vector layer.   

 En el apartado Input, escoja el layer Polygons from lines. 

 Haga click en el botón Update options. 

 
 En la sección Output table, escriba geol_units en la caja de texto Table. 

 
 Haga check en las opciones Replace destination table (if exists) y en la opción Create spatial 

index.   

 
Esta última es importante para acelerar las búsquedas en los queries geoespaciales. 

Su forma Import vector layer debe verse como esta: 

 

Note que estamos manteniendo el mismo sistema de 

referencia espacial (CRS) porque ya estaba 

predefinido.  

 

Presione el botón OK para aceptar las opciones y 

generar la nueva tabla/geodato de polígonos de 

unidades geológicas.   

 Presione OK en la forma informativa Import to database 

 
 

Aparecerá entonces la tabla geol_units en el banco de datos SpatiaLite.   
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 Haga right click en esta tabla y escoja la opción Add to canvas para que la pueda ver en QGIS. 

 

 Cierrre la forma DB Manager.  

 

 Remueva el geodato temporal Polygons from lines.  

 

 Seleccione el layer Polygons from lines y haga click en el botón Remove Layer. 

 

3i: Añadir campos a la tabla de atributos del nuevo 

geodato de polígonos 
Pasaremos a entrar los datos descriptivos de las unidades geológicas.  Se trata de los códigos y los 

nombres de estas, además del área en cuerdas.   
 

Antes de comenzar, estos son los campos que vamos a añadir al geodato geol_units: 

unit_code código de la unidad geológica 

unit_name nombre de la unidad geológica 

cuerdas área en cuerdas (1 cda = 3,930.395625 m2) 

 

 Active el layer geol_units haciendo click encima del nombre. 

 

 Haga click en el botón Open Attribute table  o F6 

Así aparecerá la tabla de atributos: 

 

 Para añadir campos a la tabla, deberá hacer click en el botón Toggle editing mode  que 

aparece en la tabla.  
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La interfaz gráfica de la tabla cambiará, añadiendo una barra para cómputos o manipulación de datos: 

 

 Presione el botón New field  para añadir los campos… 

Aparecerá la forma Add field.  

Añada los campos, según las tablas que aparecen a continuación: 

 

Name unit_code 

Comment Código de unidad geológica 

Type Text 

Click en botón OK 

Presione el botón New field  para añadir el próximo campo… 

 

Name unit_name 

Comment Nombre de la unidad geológica 

Type Text 

Presione el botón New field  para añadir el próximo campo… 

 

Name cuerdas 

Comment Cabida en cuerdas 

Type Decimal number (double) 

Así deberá aparecer la tabla, luego de añadir los campos.   

 

Cambiar la opacidad del layer de unidades geológicas 
 Cambie la opacidad de este layer para hacerlo traslúcido y poder ver los códigos que aparecen en 

el mapa ráster subyacente de unidades geológicas.  

 

 Haga click en el nombre del layer 

geol_units para activarlo.  



 

Tutorial Quantum GIS 3.4 LTR 

82 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

 Haga click en el botón  Layer 

Styling Panel  

 

 

Al lado derecho de la interfaz gráfica de 

QGIS, aparecerá la forma Layer Styling.   

 Haga click en el símbolo de caja 

Fill. 

 Ajuste en la barra de opacidad 

(Opacity), arrastrando (dragging) 

el botón a 50%. O puede escribir 

50 en la caja de texto 

 

Los cambios se harán de forma automática. 

 

Ya que tenemos disponible la tabla en modo de edición y la visibilidad traslúcida del layer de polígonos, 

comenzaremos a añadir los datos a las celdas de la tabla de atributos.  

Haremos selección interactiva en la tabla de atributos y editaremos los códigos y nombres de las 

unidades geológicas.   

 

Puede arreglar las ventanas de QGIS y la tabla, una a cada lado usando el botón  Dock 

Attribute table.  Este se encuentra al lado derecho superior de la tabla. 
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Así aparece el geodato geol_units en el canvas.  Verá que hay dos áreas con la etiqueta Kr.  Estas dos 

áreas comparten la misma formación geológica.  Lo ideal es poder asignar los mismos datos 

simultáneamente a dos o más objetos.  

 

Para asignar el mismo valor a varios objetos vamos a seleccionar las dos áreas que leen “Kr” en el canvas. 

 

 Haga click en el botón Select Features   

 

 Haga Shift-click 

encima de una de las 

áreas Kr y luego la otra.  

No importa el orden. 

 

Así aparecerán las dos 

áreas seleccionadas en el 

canvas de QGIS.  Note que 

estamos en modo “edición” 

porque los bordes de los 

polígonos tienen las cruces 

rojas, denotando los 

vértices que definen sus 

formas.    

 

 Vaya a la tabla de atributos y haga click en el botón Toggle multi edit mode.  
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Note que la interfaz de la tabla ya no parece una hoja de cálculo.  Podemos ver a la izquierda que hay 

dos cuadros amarillos.  Estos representan los dos objetos (áreas 2 y 3) que seleccionamos 

previamente.   

 
Ya que están seleccionados: 

 En la caja de texto unit_code, escriba Kr. 

 En la caja de texto unit_name, escriba Robles Formation 

 
 No escriba nada en el campo cuerdas.  Esto lo haremos en bloque en la próxima sección 

 Para registrar este cambio, haga click en el enlace apply changes. 

 
Aparecerá un aviso de los cambios aplicados 

 
Prosigamos.   

 Haga click en el área Kpr que aparece en el centro para seleccionarla. 

 
 Vaya a la tabla de atributos… 

 En la caja de texto unit_code, escriba Kr 
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 En la caja de texto unit_name, escriba Pre-Robles rocks 

 
 Para registrar este cambio, haga click en el enlace apply changes. 

 No escriba nada en el campo cuerdas.   

 

 Haga click ahora en el área que lee Krq. 

>>  

 

 Vaya a la tabla de atributos y en la caja de texto unit_code, escriba Krq. 
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 En la caja de texto unit_name, escriba Robles Formation; Quartz and Jasper 

 
 

 Haga haga click en el enlace apply changes.  

 

 Para guardar los cambios, haga click en el botón Save Edits.  

 

 Haga click en el botón Yes para aplicar estos cambios. 

 

 Cierre la sesión de edición por el momento haciendo click en el botón  Toggle Edit Mode 

 Cierre el panel Layer Styling.  

3J: Aplicar simbología predefinida al geodato de 

unidades geológicas 
Esta opción es válida si hay una tabla con simbologías entre los valores existentes en la tabla de atributos 

del geodato y la tabla que contiene los colores y símbolos asignados a cada elemento del geodato.  Esta 

tabla deberá existir dentro del banco de datos sqlite de este ejercicio.  Verificará si los códigos están bien 

colocados.   

 Haga right click en el layer geol_units y escoja la opción Properties. 

 

También puede hacer 

doble click en el nombre 

del layer 

 

Aparecerá la forma Layer Properties.   

 Haga click en el ítem Symbology. 

 

En la parte inferior izquierda de esta forma está el botón Style  
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 Haga click en el botón Style y escoja Load Style. 

 
Como mencionamos anteriormente, la simbología había sido guardada previamente dentro de la base de 

datos SpatialLite.  

 

Aparecerá la forma Database styles manager 

 
 Vaya a la sección Other styes on the database y escoja el ítem unidades_geol, Simbología 

para representar unidades geológicas.   

 
 Haga click en el botón Load Style para asignar estas representaciones al layer de unidades 

geológicas.   

 

 Regresará a la forma Layer Properties, podrá constatar los colores asignados por código de 

unidad geológica (campo unit_code). 

 
 

 Haga click en el botón OK de la forma Layer properties para aceptar los cambios y cerrarla.  

 

 

 

En la próxima sección haremos un cómputo simultáneo de cabida en cuerdas para todos los records de la 

tabla.   
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3K: Usar Field Calculator toolbar para calcular 

cuerdaje 
En esta sección usaremos la herramienta Field calculator para computar el área en cuerdas de las 

unidades geológicas dentro de esta área de interés.  (1 cuerda = 3,930.395625 metros cuadrados o 0.97 acres). 

 

 Para hacer el cómputo, mantenga activado el layer geol_units en la tabla de contenido: 

  

 Si cerró la tabla de este geodato, haga click en el botón Open Attribute Table . 

Aparecerá la tabla de atributos:  

 

En esta parte, es conveniente regresar la tabla a su aspecto original de hoja de cálculo.   

 En la tabla, haga click en el botón Switch to table view.  

 

 Abra la sesión de edición, haciendo click en el botón  Toggle Edit Mode 

Trabajaremos ahora con la barra Field Calculator. 

 
 Para registrar el cuerdaje, seleccione el campo cuerdas en el combo box: 

 
Borre la palabra id en la caja de texto del Field Calculator. 

 Escriba la fórmula $area/3930.395625 en la caja de texto: 

 
Función cómputo de área $area 

Operador aritmético: división  / 
Literal/número 3930.395625 

 Haga click en el botón Update All  para calcular todas las celdas 



 

Tutorial Quantum GIS 3.4 LTR 

89 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

Podrá ver las celdas del campo cuerdas calculadas. 

 

 Presione el botón  Save Edits para guardar los cambios.   

 Haga click en el botón Toggle Editing para cerrar la sesión de edición . 

 Cierre la tabla de atributos. 

 

 Guarde su trabajo QGIS Project file.  Vaya al menú principal > Project > Save As…  

 Guarde el archivo en C:\Tutorial_QGIS\Ejercicio_3 con el nombre ejercicio_3.qgs 

 

 
 Haga click en el botón Save para guardar el Project file.  

 

Esto finaliza este ejercicio número 3. 

 

  



 

Tutorial Quantum GIS 3.4 LTR 

90 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

Preguntas 
 

1. ¿En cuáles ocasiones se recomienda utilizar un solo sistema de referencia espacial (p.55) 

a. Análisis de datos 

b. Geoprocesamiento 

c. Entrada de datos 

d. Preparar mapas para imprimir 

2. ¿Cuál es el sistema de referencia espacial oficial del gobierno de PR? (p 55) 

a. Puerto Rico Datum 

b. EPSG:NAD83 

c. State Plane Coordinate System 

d. Todas las anteriores 

e. Ninguna 

3. ¿Para qué se usa el snapping environment? (p 64) 

___________________________________________________________________________ 

 

___________________________________________________________________________ 

4. ¿En qué características del geodato fuente nos fijamos para establecer el umbral de distancia para 

enganche (snapping tolerance)? (p 65) 

___________________________________________________________________________ 

5. ¿Cuál es la distancia en papel (fracción de pulgada) que se usaba como umbral de tolerancia en 

los mapas para el estándar de exactitud geográfica NMAS-1947?  (p 65) 

___________________________________________________________________________ 

 

___________________________________________________________________________ 

6. ¿Cuál es la diferencia (en QGIS) entre snapping tolerance y fuzzy/cluster tolerance?   

¿Es QGIS un programa Desktop GIS que utiliza el concepto de fuzzy/cluster tolerance? (p 65) 

___________________________________________________________________________ 

 

___________________________________________________________________________ 

7. ¿Qué herramienta podemos usar para convertir geodatos con geometría de líneas a geodato de 

polígonos? (p 74) ¿Por qué no usamos la opción Keep table structure? (p 74) 

___________________________________________________________________________ 

 

___________________________________________________________________________ 

8. ¿Qué herramienta utilizamos para calcular el área en cuerdas para el geodato de unidades 

geológicas? (p 85) 

___________________________________________________________________________ 
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4-I: Unir datos censales con un 

geodato y producir mapas 

estadísticos 
 

Tópicos de esta sección: 

4-I: Unir datos censales con un geodato y producir mapas estadísticos ..................................................... 91 

4A: Usar herramienta Census Data Explorer .......................................................................................... 92 

Escoger el nivel geográfico de agregación (summary level) .............................................................. 93 

Descargar la tabla para este ejercicio .................................................................................................. 94 

4B: Abrir el archivo csv en Excel y exportarlo a formato xlsx para lectura en QGIS ............................ 95 

Asignar nombres de columnas usando la primera fila ........................................................................ 97 

Escoger columnas de interés ............................................................................................................... 97 

Eliminar fila con descripciones ......................................................................................................... 100 

Dividir columna para obtener identificadores ................................................................................... 100 

Cambiar el tipo de dato en Power Query .......................................................................................... 101 

Applied steps: Enmendar algún paso ................................................................................................ 103 

Añadir columnas calculadas en Power Query ................................................................................... 103 

Celdas con null .............................................................................................................................. 104 

Añadir otra columna ..................................................................................................................... 104 

Carga de datos a Excel desde Power Query ...................................................................................... 106 
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En esta parte, traeremos una tabla de datos estadísticos del Censo y la uniremos (join tables) al geodato de 

municipios.  Muchas veces a los usuarios de programas SIG se les requiere hacer mapas que representen 

datos estadísticos.  De esto se trata este ejercicio #4.   

 

Tema: Brecha salarial, mujeres/varones:  

Pregunta: ¿Cuál la distribución de esta brecha salarial por municipios en Puerto Rico, en especial 

para el nivel educativo de bachillerato y grado profesional?  

 

Tareas generales o destrezas para aprender:  

Parte A: 

 Usar la interfaz de datos censales data. census gov para buscar datos estadísticos del Censo 

Federal de EEUU para Puerto Rico.  Producir y descargar un archivo csv (comma separated 

value) con estos datos.    

 Usar la interfaz Power Query de Excel (365) para modificar en memoria RAM, la estructura 

de la tabla y extraer datos relevantes, calcular valores de brecha y descargarlo a Excel 

Parte B: 

 Unir tabla de datos estadísticos Excel con la tabla del geodato de municipios (JOIN tables) 

 Representar los datos estadísticos que habíamos trabajado en Excel usando método de 

clasificación de datos y mediante secuencia de colores. 

 

 

4A: Usar herramienta Census Data Explorer 
Los datos necesarios para este ejercicio están contenidos en la tabla censal S1501: Educational 

Attainment.  En esta tabla se desglosan variables sobre logros educativos en varios niveles, tales como 

instrucción primaria, secundaria y universitaria.  Al final de la tabla se muestra la mediana de salario 

para los últimos 12 meses por nivel instruccional alcanzado y por género.  Usaremos esta parte final 

para hacer la extracción de datos y usarlos para preparar el mapa.   

 

 Para ir a la herramienta Census Data Explorer, use su navegador disponible (para este ejemplo 

usé Google Chrome) y copie la dirección http://data.census.gov/  

 En la caja I’m looking for … escriba S1501 

. 

 Aparecerá el item S1501 EDUCATIONAL ATTAINMENT.  Haga click en este item para 

escogerlo. 

Información: 
Los datos censales serán extraídos de la interfaz data.census.gov.  Usaremos los datos 

del American Community Survey (en nuestro caso, Encuesta de Puerto Rico).   

http://data.census.gov/cedsci
http://data.census.gov/
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 Podrá ver esta tabla a la cual vamos a hacer algunos cambios, porque: 

o Los estimados están para un año y queremos mostrar el estimado de 5 años, el cual 

contiene los valores para todos los municipios 

o La geografía que deseamos es por municipios de Puerto Rico.   

 Comenzaremos a hacer estos cambios haciendo click en el botón drop down para modificar la 

tabla 

 
 En la lista escoja 2017: ACS 5 Year Estimates Subject Tables.   

 

Escoger el nivel geográfico de agregación (summary level) 
Los datos aparecen por defecto globales para Estados Unidos. 

 Haga click en el botón Geographies.  

 
Aparecerá la forma para filtrar datos con el ítem Geography seleccionado.  

 Para mostrar datos por municipios, escoja en Summary Levels el nivel 050 – County, luego 

busque a Puerto Rico, haga click encima y escoja entonces la opción All counties in Puerto 

Rico. 

 
 Abajo en esta forma, podrá ver el filtro por nivel geográfico para todos los municipios (counties) 

de Puerto Rico. 

    
 Haga click en el botón para cerrar esta forma de filtrados: 

 
 Podrá ver la tabla, sin orden alguno.  Los datos que nos interesan aparecen al final de esta tabla 

en: MEDIAN EARNINGS IN THE PAST 12 MONTHS (IN 2017 INFLATION…  
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desglosado por nivel Graduate or Professional, Female, Male 

 

Descargar la tabla para este ejercicio 
Estos datos pueden descargarse en varios formatos.  Sin embargo, para este ejercicio nos interesa 

descargar datos que sean compatibles con el programado SIG (GIS compatible format).  La interfaz del 

Fact Finder nos da la opción Comma Separated Value (csv).  Este es un formato de texto el cual puede 

ser usado en programas de hoja de cálculo.   

 

 Para descargar esta tabla, haga click en el botón Download.  

 
 En la forma Download / Print / Share que aparecerá, 

1: haga uncheck en la caja 1 Year, 2: mantenga check el estimado 5 Year, y 3: haga click en el 

botón DOWNLOAD.  

 
 Aparecerá una forma indicando el progreso de la preparación de su archivo.  Una vez termine, 

haga click en el botón Download Now.  

Click para descargar esta tabla 
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 Descargue el archivo zip dentro de la carpeta C:>Tutorial_QGIS > Ejercicio_4. 

 
 

Si ud no especifica el destino, el archivo descargado se guardará en el folder por defecto de descargas, 

dependiendo de las opciones que usted haya seleccionado previamente en su navegador.  Generalmente se 

guardan en el folder Downloads localizado en Users\nombre_usuario\Downloads 

 Haga right click encima de este archivo zip y escoja la opción Extract all 

 
 

Aparecerá la forma Extract Compressed (Zipped) Folders.   

 Descomprima el archivo en el directorio C:\Tutorial_QGIS\Ejercicio_4 

 

 Haga click en el botón Extract.  

 

El primer archivo csv descomprimido contiene los datos a trabajar.  El segundo archivo csv contiene los 

metadatos: etiquetas de columnas y su descripción.   

El nombre del archivo cambia según la fecha y hora de descarga. 

 
  

4B: Abrir el archivo csv en Excel y exportarlo a 

formato xlsx para lectura en QGIS 
Cada vez se hace más importante tener nociones de uso de programas de extracción, transformación y 

carga de datos (Extract, Transform & Load).  Excel y Power BI proveen una interfaz muy útil para 

esta extracción, transformación y posterior carga de datos a estos programas de manejo de datos, 

principalmente numéricos.  Esta interfaz en estos programas Microsoft es llamada Power Query.   

En esta parte vamos a usar Excel 365 y su interfaz Power Query para convertir los datos del archivo csv 

a formato xslx de Excel.   
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Para los que no tengan acceso a Excel, específicamente las herramientas de Power Query (Office 2016+), 

se puede usar otro programa como LibreOffice Calc.  El procedimiento se describe en otra sección para 

usuarios de QGIS para Linux.   

 Vamos primero a abrir Excel.  (Para este tutorial, estamos usando Excel de Office 365).   

Haga click en el botón Start de Windows…  

 
 Busque el icono de Excel y haga click en su icono…  

 
Aparecerá la interfaz gráfica del programa Excel 

 

 Para abrir el archivo csv que acabamos de descargar y descomprimir, primero haga click en la 

opción Blank workbook para abrir un workbook vacío.  En este vamos a vaciar parte del 

contenido del archivo csv.  

 
 Para comenzar a importar el archivo csv con los datos, vaya al menú principal y escoja  

Data > From Text/CSV: 

 
 

 Navegue en esta forma Import Data  para que encuentre el archivo 

ACSST5Y2017.S1501_data_with_overlays...csv.  El nombre del archivo cambiará según la 

fecha y hora de creación.  Este se debe encontrar en el folder C:\Tutorial_QGIS\Ejercicio_4 

donde usted lo descomprimió en el paso anterior. 

  

 Haga click en el botón Import.  
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 Espere que aparezca la forma Query Editor Wizard  

 
 Haga click en el combo box File Origin para cambiar el conjunto de caracteres “encoding” y así 

poder parear los caracteres especiales de los idiomas símbolos especiales.    

Escoja el ítem 65001: Unicode (UTF-8) 

 
 Haga click en el botón Transform Data.   

 
Aparecerá la forma Power Query Editor. 

 

Asignar nombres de columnas usando la primera fila 
La primera fila contiene los nombres de cada columna y nos servirá para asignarle los nombres.  

 
 

 En Power Query Editor, vaya al grupo Transform y haga click en el botón Use First Row as 

Headers: 

 

Escoger columnas de interés 
Notará que la primera fila se convierte en los headers (cabeceras) de las columnas. 

 
También podrá ver que la fila #1 tiene la descripción de estas columnas.  Estas descripciones son útiles para saber de 

qué se trata cada columna.  Sin embargo, estas no pueden estar en la tabla final porque nos afectará el resultado 

al mezclar números con letras (datos alfanuméricos dentro de campos numéricos). 
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 Antes de eliminar la primera fila, haga click en el tab Home, vaya al grupo Manage Columns, 

Haga click en el botón Choose Columns y escoja de la lista la opción Go to Column 

 
 En la forma Go to Column escriba en la caja de texto S1501_C03_064E 

 
 Haga click en el nombre de esta columna y luego click en el botón OK de esta forma. 

 

Inmediatamente, ¿Qué puede ud notar del contenido de esta columna? ¿Cómo esto puede afectar nuestra 

tarea? ¿Qué consideraciones debemos tomar en cuenta?  Vaya pensando… 

 
 

… navegue hacia la derecha y localice la columna S1501_C05_064E 

 
Las mismas preguntas aplican para esta columna.   

 

Mire un momento las columnas de margen de error MOE 

 
¿Cómo ud explicaría estos márgenes de error, tan diferentes entre varones y mujeres?  

 

Estas son las columnas que vamos a conservar: 
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 Vaya al grupo Manage Columns y haga click en el botón Choose Columns  

 
 En la forma Choose Colmns, haga uncheck en la opción Select All Columns 

 
 Haga check en las opciones GEO_ID y NAME. 

 
 En la caja de texto bajo Choose the columns to keep, escriba c02_013 y escoja check la 

columna S1501_C02_013E 

 

Esta columna tiene datos de: 

S1501_C02_013E: Porcentaje de personas >= 25 años 

con estudios graduados o profesionales 

Es deseable conocer cuál es la proporción de habitantes 

con estas características comparado con la población 

total de cada municipio. 

 En la caja de texto bajo Choose the columns to keep, escriba c04 y escoja check la columna 

S1501_C04_013E 

 

Esta columna tiene datos de  

S1501_C04_013E: Porcentaje de varones >= 25 años 

con estudios graduados o profesionales 

Es deseable conocer cuál es la proporción de habitantes 

con estas características comparado con la población 

total de cada municipio. 

 En la caja de texto bajo Choose the columns to keep, escriba c06 y escoja check la columna 

S1501_C06_013E 

 

Esta columna tiene datos de  

S1501_C06_013E: Porcentaje de mujeres >= 25 años 

con estudios graduados o profesionales 

Es deseable conocer cuál es la proporción de habitantes 

con estas características comparado con la población 

total de cada municipio. 

 En la caja de texto bajo Choose the columns to keep, escriba _064E y escoja check las 

columnas S1501_C03_064E y S1501_C05_064E 

 

Estas columnas tienen datos de mediana de ingresos en 

dólares ajustados a inflación (2017) en los pasados 12 

meses, para personas >= 25 años con nivel educativo 

profesional o estudios graduados 

S1501_C03_064E: Ingresos $ varones 

S1501_C05_064E: Ingresos $ mujeres 
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 Haga click en el botón OK para aceptar los cambios  

 

De esta manera, mantendrá solo las columnas que vamos a usar antes de importar el archivo csv 

completo. 

 
 

Nos falta ahora eliminar la fila #1.   

Eliminar fila con descripciones 
Para este ejercicio, solo es necesario eliminar la primera fila.   

 

 En el tab Home, vaya al grupo Reduce Rows, haga click en el botón Remove Rows y luego en 

la opción Remove Top Rows. 

  
 En la forma Remove Top Rows que aparecerá, en la caja de texto del apartado Number of rows, 

escriba 1.  Luego haga click en el botón OK. 

  
 La fila fue eliminada. 

 

Dividir columna para obtener identificadores 
En esta tabla, los identificadores GEO_ID, están compuestos de una cadena de caracteres 

0500000US72073 por ejemplo para el municipio de Jayuya, Puerto Rico.  Mientras, en la tabla del 

geodato de municipios, el identificador correspondiente es 72073 para este municipio. 

 

Usando Power Query Editor podemos dividir esta columna para obtener el identificador basado en estos 

últimos 5 caracteres.   

 

¿Cómo vamos a obtener las últimas 5 posiciones de esta cadena de caracteres? 

Usaremos como delimitador la letra S que está contenida en el identificador completo: 
0500000US72073 

Esa letra se repite en todos los records, así que lo podemos usar como delimitador.  Otra manera es 

usando la función clásica Right(‘texto’, número de posiciones de derecha a izquierda).  En este ejemplo 

usaremos la letra S.  

 Haga click en la pestaña Transform.  
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 Haga click en la cabecera de la columna GEO_ID para activarla.  Debe aparecer en verde: 

 
 Vaya al grupo Text Column, haga click en el botón Extract y luego en la opción Last 

Characters. 

   
 En la forma Extract Last Characters que aparecerá,  

escriba 5 en la caja de texto Count.  

Luego click en el botón OK. 

  
La columna solo retendrá las últimas 5 posiciones a la derecha. 

 
 Repita el proceso para la columna NAME.   

Esta vez, use la función Transform > Text Column > Extract > Text Before Delimiter. El 

delimitador será la siguiente cadena de texto: Municipio (espacio Municipio).  Fíjese en la 

figura.  El espacio está marcado  

 >>  

Resultado:  

Cambiar el tipo de dato en Power Query 

Algo que debemos notar es que todos los campos de esta tabla son alfanuméricos:  
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Aunque los datos deberían ser numéricos, hay celdas que no tienen valor registrado y muestran una tilde 

“-”.  Por lo tanto, Excel interpreta estas columnas como alfanuméricas . 

 Para cambiar el tipo de dato haga shift+click en las cabeceras de las columnas 

S1501_C02_013E, S1501_C04_013E, S1501_C06_013E  

 

 Mantenga la tecla shift presionada y haga click en el icono  de la columna S1501_C06_013E 

y en el menú drop-down escoja la opción 1.2 Decimal Number . 

 Repita el proceso para las columnas S1501_C03_064E y S1501_C05_064E.   

Esta vez cambie el tipo de dato a enteros Whole Number.  

 
Sin embargo, aparecerá un problema.  Por cada lugar donde había una raya, Excel las remplaza por la 

palabra “Error”.   

 
Es más conveniente remplazar estos errores por valores vacíos “null” porque el Censo no provee datos 

para estos municipios.   

 Para eliminar la palabra Error en estas columnas: 

o Haga click en las columnas S1501_C03_064E, S1501_C05_064E para activarlas 

  
o Vaya al menú principal, click en el tab Transform, vaya al grupo Any Column y haga 

click en botón Replace Values, luego click en la opción Replace Errors.  

 
 Aparecerá la forma Replace Errors.  En la caja de texto Value, escriba null 
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Aparecerá entonces la representación null para celdas que no tienen números.   

  

Applied steps: Enmendar algún paso 
Power Query registra cada operación hecha en el panel Query Settings, en la caja Applied Steps.  Esta 

interfaz es útil para hacer cambios y regresar a otros pasos realizados.  

 
Si se equivocó en algún paso, esta es la herramienta para usar. 

Añadir columnas calculadas en Power Query 
En esta parte añadiremos una columna adicional.  Haremos una operación matemática simple en la cual 

registraremos el llamado “gender wage gap” o brecha salarial por género.  Se trata de establecer una razón 

entre el salario de mujeres / salario de varones.  Debemos recordar que estos son datos de sueldos con el 

nivel educativo más alto: estudios graduados y profesionales.  Además, hay celdas sin datos en ambas 

columnas.   

 

 Vaya al menú principal y haga click en el tab Add Column, seguido de click en el botón 

Custom Column 

 
 

 En la forma Custom Column que aparecerá: 

https://en.wikipedia.org/wiki/Gender_pay_gap_in_the_United_States
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o Escriba la palabra brecha en la caja de texto New column name 

o En la caja de texto Custom column formula, escriba la siguiente función 

Number.Round( 

o Haga doble click en el campo S1501_C05_064E (mujeres) 

o Teclee / seguido del nombre de este campo 

o Haga doble click en el campo S1501_C03_064E (varones) 

o En la misma caja de texto escriba ,2) para cerrar esta función y fórmula.  

o Ver figura en la próxima página… 

 
o Haga click en el botón OK para generar la nueva columna calculada y redondeada a dos 

lugares decimales. 

Le aparecerá la nueva columna brecha, con los valores calculados.   

 

Celdas con null 

Note la aparición de celdas con null.  Cualquier operación que contenga un null como entrada, nos 

devolverá un valor null (vacío).  Null no es lo mismo que cero.  Significa que no hay datos y Excel, así 

como QGIS los manejarán de manera diferente a hacer operaciones con cero.   

Añadir otra columna 

Vamos a añadir otra columna, la cual registrará la relación entre los porcentajes de mujeres con nivel 

educativo de estudios graduados o profesionales versus los varones con el mismo nivel educativo.   

 Vaya al menú principal y haga click en el tab Add Column, seguido de click en el botón 

Custom Column 

 
 

 En la forma Custom Column que aparecerá: 

o Escriba la palabra brecha en la caja de texto New column name 
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o En la caja de texto Custom column formula, escriba la siguiente función 
Number.Round( 

o Haga doble click en el campo S1501_C06_013E (mujeres) 

o Teclee / seguido del nombre de este campo 

o Haga doble click en el campo S1501_C04_013E (varones) 

o En la misma caja de texto escriba ,2) para cerrar esta función y fórmula.  

o Siga los pasos como en esta figura 

 
Solo resta mover esta nueva columna al lado derecho de la columna S1501_C06_013E.   

 Haga click en la cabecera de la columna ratio_mv_prof y arrástrela al lado derecho de la 

columna S1501_C06013E.  

 
 Verá que se añadió un paso llamado Reordered Columns en la caja Applied Steps de la Forma 

Query Settings, a la derecha de la interfaz Power Query Editor.  

 

 Finalmente, cambie el tipo de dato en las columnas brecha y ratio_mv_prof de ABC123  a 

1.2 Decimal Number . 
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Carga de datos a Excel desde Power Query 
Habiendo finalizado este proceso, el archivo ya está listo para la carga de datos a Excel.   

 Vaya al menú principal de la interfaz Query Editor y haga click en el botón Close & Load. 

 
 

El resultado de este proceso es una Excel Table.  Este es otro formato de Excel para trabajar datos, algo 

diferente a los “data ranges”.   

 
Se puede notar por el formateo de color alternado, los filtros y la aparición del menú de contexto Table 

Tools, para Excel Tables.   

 
La tabla censal original en Sheet2, la renombraremos s1501.   

 Cambie el nombre de la hoja (tab) haciendo doble click en esa pestaña Sheet2 

 
 Sustituya Sheet2 por s1501 

 
 

Guarde esta tabla en el formato nativo de Excel book (xlsx).   

 File > Save As…  

 
 

 En File name escriba s1501_2017 

 En Save as type escoja Excel Workbook 

(*.xlsx) 

 El archivo debe ser guardado en la carpeta: 

C:\Tutorial_QGIS\Ejercicio_4 

 Haga click en el botón Save. 

 

 Cierre el programa Excel. 

 

En la próxima sección, usaremos las opciones de QGIS para hacer mapas temáticos basados en datos 

numéricos de la tabla que convertimos de la interfaz data.census.gov del Censo. 
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USUARIOS LINUX: Importar y procesar el archivo csv en 

LibreOffice Calc 
Es posible importar y transformar el archivo csv usando LibreOffice Calc.  El proceso es distinto pero los 

resultados serán iguales al final.  Este ejemplo se hará en Ubuntu 18.04.   

 

 Comience abriendo una sesión de LibreOffice Calc 

 
 

 

Abra el archivo csv con los datos censales.   

 Vaya al menú principal, click en File > Open

 
 

 Localice el archivo donde lo haya descargado.  En este caso, el archivo fue guardado en la carpeta 

Tutorial_QGIS/Ejercicio_4/ACSST5Y2017.S1501_... etcétera.  El nombre de la carpeta 

puede cambiar según la fecha y hora.  

 
 

 Aparecerá la forma Text Import.  En la sección Separator Options (delimitador de columnas), 

solo debe estar check la opción Comma como delimitador. 

 

 Acepte las demás opciones y haga click en 

el botón OK. 

 

El archivo abrirá en Calc.  Puede notar que traerá 

todas las columnas y filas del archivo csv sin pre-

procesar como el caso de Power Query.   
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Lo primero a hacer para transformar esta tabla es 

borrar la segunda fila.  Debemos borrarla porque es 

incompatible con el tipo de dato que necesitamos 

para procesar los números.  

Right click en el botón 2 de la segunda fila y 

escoja la opción Delete Rows. 

Vamos a insertar una hoja nueva para vaciar las filas y columnas que necesitamos para este ejercicio.   

 Inserte una nueva hoja haciendo click en el botón Append Sheet  

 
 Cámbiele el nombre a esta hoja.  Haga doble click en el nombre Sheet2 y escriba s1501 

 >  

 Regrese a la hoja ACSST5Y2017… haciendo click en la pestaña con ese nombre 

 
 Haga click en la segunda fila de la primera columna y haga click en el botón Sort Ascending. 

 
Calc organizará por orden ascendente a partir de la columna A (GEO_ID). 

 
Vamos a copiar las primeras dos columnas a la nueva hoja 
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 Haga click en las cabeceras de las columnas A y B usando Shift y click a la vez. 

 
 Con estas dos columnas seleccionadas, vaya al menú principal y escoja Edit > Copy 

 
 Haga click en la pestaña s1501 de su nueva hoja 

 
 Haga click en la celda A1  

 
 Vaya al menú principal y escoja Edit > Paste 

 
Los datos fueron copiados a la hoja s1501.   

 
Falta aún copiar las columnas que nos interesan: S1501_C03_064E y S1501_C05_064E  

 Regrese a la hoja ACSST5Y2017… haciendo click en la pestaña con ese nombre 

 
 Haga click en la celda A1.  Vaya al menú principal > Edit > Find… 

En la parte inferior izquierda de Calc aparecerá la forma Find con una caja de texto para 
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escribir… 

 
 En la caja de texto escriba el nombre de la columna S1501_C03_064E y haga click en el 

botón Find Next. 

 
El cursor debe moverse a la celda ACI 

 

 Haga click en la cabecera de la columna ACI  

 

Esto hará activar toda la columna ACI, la cual contiene 

los datos de la variable S1501_C03_064E (estimado 

de la mediana de ingresos en los pasados 12 meses,25 

años o más, con nivel educativo superior graduado o 

nivel profesional). Incluye ajuste de dólar por inflación 

para 2017 

 

 Haga right click en la cabecera de la columna ACI y escoja la opción Copy 

 
 Vaya a la hoja s1501 haciendo click en el tab s1501 

 
 Haga right click en la cabecera de columna C y escoja la opción Paste. 

 
Copiará el contenido de la columna de la hoja anterior a la hoja s1501. 

 
Hay que repetir el proceso para copiar la columna S1501_C05_064E  

 En la caja de texto Find, escriba S1501_C05_064E y presione Enter 
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 El cursor se moverá a la columna ACM.  Haga right click en la cabecera de la columna ACM y 

escoja la opción Copy para copiar el contenido de esta columna. 

 
 Haga click en la pestaña s1501 de su nueva hoja 

 
 Haga right click en la cabecera de la columna D y escoja Paste para traer los datos copiados.  

 
Copiará el contenido de la columna de la hoja anterior a la hoja s1501.

 

Añadir columna para brecha salarial y calcular valores 

Ahora calcularemos la brecha de ingresos, diviendo el ingreso de las féminas por el ingreso de los 

varones.  Antes de hacer esta división, es mejor asegurarnos: 

 Tener en cuenta que existen celdas sin datos.  Para evitar futuros problemas, podemos usar la 

función IFERROR(), asignando -1 a las celdas que tengan algún error de entrada.   
Calc no tiene una representación null.  Solo ofrece la opción “” string vacío.  Esto a su vez, trae un problema en QGIS 

porque el espacio vacío aparecerá como una cadena de caracteres, convirtiendo esta columna en datos tipo texto, lo cual 

es algo que no deseamos.  Por lo tanto, usamos -1 para luego cambiarlo a null en QGIS. 

 Redondear el resultado de la división de los ingresos en las columnas D2/C2 (féminas / 

varones) a dos lugares decimales para hacerlo más legible.   

 Haga click en la celda E1 y escriba la palabra brecha 

 
 Haga click en la celda E2 y escriba =IFERROR(ROUND(D2/C2,2),-1) y presione Enter 

 
Notará que la celda E2 fue calculada. 

 
Deberá copiar la fórmula a las siguientes celdas hasta la última hacia abajo. 
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 Ubique el cursor en la esquina inferior derecha de la celda E2 hasta que vea una cruz con un 

punto negro en su centro.  Haga doble click en esta esquina y calculará los valores para las 

demás celdas hacia abajo. 

 
Celdas calculadas.   

 

Extraer ID de municipios usando función Right() 

La tarea que falta es extraer el identificador del municipio para dejarlo igual al identificador que está en la 

tabla de atributos del geodato de municipios.  El identificador GEO_ID está compuesto de 14 espacios.  

Los últimos 5 espacios corresponden al identificador de cada uno de los 78 municipios (equivalente al 

county en EEUU).  Usaremos la función Right() para extraer los últimos 5 espacios: 72 equivale a Puerto 

Rico y los últimos tres espacios a cada municipio. 

 
Primero añadamos una columna. 

 Haga right click en la cabecera de la columna B y escoja la opción Insert Columns Left. 

 
 Escriba el nombre de la nueva columna: muni_id 

 
 Haga click en la celda B2.  Escriba la fórmula =Right(A2,5)  
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Resultado… 

 
 Copie la fórmula a las demás celdas vacías en esta columna de la misma forma realizada 

anteriormente.   

 
Celdas calculadas… 

 
Esta hoja ya está lista para usarse en QGIS. 

 Guarde este archivo como un workbook ods de LibreOffice Calc.  File > Save As…  

 

                                                                                        
 

 Cierre LibreOffice Calc. 
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Convertir valores -1 a null en QGIS 

En QGIS será más práctico tomar todas las celdas con valor -1 en la columna brecha y convertirlos a null.  

Esto facilitará la representación cartográfica al momento de dividir los valores de esta columna en clases.   

 

 Abra una sesión de QGIS.  Traiga el archivo s1501_2017.ods a la lista de layers.  Siga la 

secuencia de la figura a continuación: 

 
 Vamos a cambiar el nombre de esta tabla en QGIS.  Haga right click encima del nombre y 

escoja la opción Rename Layer 

 
 Cambie el nombre a s1501.  

 
 Para comenzar a cambiar valores en la tabla (editar), comencemos por abrirla.   

Con la tabla s1501 activada, haga click en el botón Open Attribute Table.  

 
Podrá ver los records con valor -1 en la columna brecha. 

 

En lugar de cambiarlos uno a uno, es mejor hacer el cambio 

en ristra, usando la herramienta de barra de cálculos para 

campos. 

 

Primero debemos seleccionar todos los records con valor -1 

en el campo brecha 

 Para seleccionar estos valores -1 en campo brecha, haga click en el botón Select features using 

an expression  
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 Para seleccionar estos records, siga los pasos como en la siguiente figura: * 

 
 * También puede escribir la siguiente sentencia: “brecha” = -1 en la caja de texto. 

Los records aparecerán seleccionados 

 

 Con estas filas (records) seleccionadas, haga click en el botón Toggle editing mode.  

Aparecerá la barra para hacer cómputos en la tabla QGIS 

 
 Usando el botón drop-down, cambie el campo a brecha.  

 

 
 En la caja de texto para escribir fórmulas, escriba la palabra null 

 
 Haga click en el botón Update Selected para modificar todas las filas que están seleccionadas. 

 
Las filas aparecerán registradas con NULL. 
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 Haga click en el botón Toggle editing mode  para guardar los cambios y cerrar el modo de 

edición.   

 
 Cierre la tabla s1501.  No cierre QGIS aún. 

 

Ya todo está listo para continuar la próxima parte. 
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4-II. Unir datos censales con un geodato y 

producir mapas estadísticos 
Tópicos de esta sección: 
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Parear tablas: tabla de datos estadísticos con tabla del geodato 
En esta parte, traeremos una tabla de datos estadísticos del Censo y la uniremos (join tables) al geodato de 

municipios.  Muchas veces es necesario parear información estadística con áreas administrativas o algún 

otro tipo de delimitación.  Usualmente esta información se recopila usando otros programas como Excel o 

mediante programas más complicados para manejo de datos (bases de datos).   

 

Los datos estadísticos o datos de campo se entrelazan (join) con la tabla de atributos del 

layer/geodato/shapefile/archivo sig.  Los datos en tablas separadas se entrelazan mediante un 

identificador común primary key, presente en ambas tablas.  En el caso de este ejercicio, usamos los 

municipios.  Estos tienen un código identificador que le da el gobierno federal, a través del Negociado del 

Censo.   

 
Como podemos notar en este gráfico, los nombres de los campos son diferentes, pero para que los 

records pareen, deben ser idénticos y del mismo tipo de dato. 

 

Usaremos QGIS para visualizar mapas temáticos usando datos del Censo.  En la parte anterior, habíamos 

descargado una tabla con datos estadísticos de la interfaz data.census.gov, tomando datos de la Encuesta 

para Puerto Rico del American Community Survey, con estimados a 1 o 5 años, en este caso de 2013 

a 2017. 

 

Descargamos de la interfaz FactFinder la tabla s1501, la cual contiene datos sobre niveles de instrucción 

y salarios de partes de la población (25 años o más) en los 78 municipios.  Luego usamos la interfaz 

Power Query de Excel para extraer, cargar y exportar los datos a formato xlsx.   

 

El formato xlsx de Excel resulta más práctico que el csv.  El formato csv en QGIS debe tener un archivo 

complementario csvt, el cual indica cuál es el tipo de dato de cada columna.  Registrar el tipo de dato en 

un archivo cvst para dos o tres columnas está bien, pero para tablas censales extensas se vuelve tedioso.   

 

 Comencemos, abriendo una nueva sesión de QGIS. 

 Traiga el mapa de municipios (g03_legales_municipios_edicion_octubre2015.shp) que usó 

anteriormente.  Este debe estar localizado en su folder 

Tutorial_QGIS\Ejercicio_2\Puerto_Rico.   

 Use el botón Add Vector Layer. 

 
Aparecerá la forma Data Source Manager | Vector.  
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 Vaya a la sección Source y haga click en el botón Browse. 

 
 Seleccione y abra el geodato g03_legales_municipios_edicion_octubre2015.shp 

   
 De vuelta a la forma Add vector layer, haga 

click en el botón Add 

 
 Cierre la forma Data Source Manager | Vector 

haciendo click en el botón Close.  

Una vez abra el archivo y aparezca en el canvas de QGIS, 

inspeccione la tabla de atributos de este geodato. 

 Haga click en el nombre del geodato y click en el botón Open Attribute Table 

 
Note que la tabla tiene solo cuatro campos: fid, cntyidfp, municipio y abrev.  Todos son identificadores.  

No hay información estadística: 

  
 

 
 Cierre la tabla.  

 

Información: 

cntyidfp será el campo que usaremos para parear esta tabla con la tabla de datos censales 

del ejercicio anterior.  Este código contiene: 72 como el identificador de Puerto Rico y los últimos 

tres números representan el código para cada uno de los 78 municipios. 

Recuerde: 
En Files of type: debe usar ESRI 

Shapefiles [OGR] (*.shp *.SHP) 

OGR es una colección de programas 

para conversión de geodatos.  
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Traer tabla Excel con los datos 
En QGIS no hay un botón exclusivamente destinado para traer tablas.   

 Para traer una tabla, deberá usar el botón Add Vector Layer para traerla a la lista de geodatos. 

 
Aparecerá la forma Data Source Manager | Vector.  

 Vaya a la sección Source y haga click en el botón Browse. 

 
 

 En la forma Open an OGR Supported Vector Dataset(s), vaya a la sección Files of type: y 

escoja MS Excel Office spreadsheet (*.xlsx *.XLSX).   

  

 
En el caso de usar Linux, utilice el archivo .ods del procedimiento para Linux. 

 

 Entre en el directorio (folder) Ejercicio_4.  Escoja y abra el archivo s1501_2017.xlsx realizado 

anteriormente. 

 
 Presione el botón Open en la forma Open an OGR Supported Vector Dataset(s) 

 

 Añada entonces la hoja Excel a QGIS presionando el botón Add en la forma Data Source 

Manager 

 

 Cierre la forma Data Source Manager haciendo click en el botón Close. 

 

 Aparecerá la tabla s1501_2017 s1501 en la lista de geodatos en el panel/lista de geodatos Layers: 

 
 

Cambiémosle el nombre para hacerla más legible.   

 Haga right click encima del nombre s1501_2017_s1501 y escoja la opción Rename Layer 

 
 

 Cámbiele el nombre a s1501_2017.  
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 Inspeccione la tabla abriéndola.  Right click > Open Attribute Table 

 
Note que la tabla contiene los caracteres correctos en los nombres (tildes, acentos, etc.), el campo geo_id 

tiene el sangrado (alineado) hacia la izquierda.  Esto por lo general, denota que el campo es alfanumérico.  

Por el contrario, los campos numéricos están alineados a la derecha. 

 
 Cierre esta tabla. 

Crear un nuevo banco de datos SpatiaLite y exportar el shapefile 

a este formato 
Estamos promoviendo el uso de los bancos de datos SpatiaLite en este taller, así que exportaremos la 

tabla y el geodato a este formato.   

 Primero debemos crear el banco de datos SpatiaLite.  Para hacer esto, debemos activar el 

Browser Panel.   

 Vaya al menú principal y escoja View > Panels > Browser Panel. 

   
El panel estará ubicado normalmente en la parte inferior izquierda de la interfaz de QGIS. Este panel 

provee las posibles conexiones a las diferentes fuentes de datos, folders y bases de datos.   

 Navegue hacia abajo en el panel Browser, hasta encontrar el ítem Spatialite.   

Haga right click encima y escoja Create Database… 

 
 

 En la forma New SpatiaLite Database File, navegue hasta llegar dentro del folder 

Tutorial_QGIS\Ejercicio_4.   
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 En la caja de texto File name: escriba ejercicio_4.sqlite. 

 
 Haga click en el botón Save para crear el nuevo banco de datos. 

 

El próximo paso es exportar el geodato de municipios al nuevo banco de datos SpatiaLite.   

 Para hacer esto, vaya al menú principal y escoja Database > DB Manager. 

 
También puede usar el botón  para acceder a esta interfaz 

 

Le aparecerán las conexiones al expandir el nodo SpatiaLite,  

 

notará que está vigente la conexión al banco de datos del ejercicio anterior (#3) y 

el ejercicio_4.sqlite 

 Haga right click encima del banco de datos ejercicio_3.sqlite y escoja la única opción: Remove 

 
 Presione el botón Yes en la forma que le preguntará si su intención es desconectarse de este 

archivo.  

 Expanda el nodo del banco de datos ejercicio_4.sqlite para que pueda conectarse a este nuevo 

banco de datos… 

 

Importar geodato shapefile al banco de datos Spatialite 
Vamos ahora a insertar/importar el geodato de municipios (shapefile) dentro del banco de datos sqlite 

 Para importar el geodato de municipios, haga click en el botón Import layer/file.   

 
 En la forma Import vector layer que aparecerá, vaya a Input y escoja el layer g03_legales… 

 
 Haga click en el botón Update options para traer la estructura del geodato y preparar la plantilla 

para importarlo a SpatiaLite. 



 

Tutorial Quantum GIS 3.4 LTR 

123 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

 En el apartado Output table, en la caja de texto Table, escriba el nuevo nombre del geodato: 

municipios_2015 

 
 En la sección Options, haga check en la opción Create spatial index. 

 
Mantenga las otras opciones como están 

 Haga click en el botón OK para importar el geodato de municipios. 

 

 Haga click en el botón OK en la forma informativa Import to Database 

 
 

 Haga right click en el geodato municipios_2015 y escoja la opción Add to canvas para que lo 

pueda ver y manipular en el canvas de QGIS. 

 
El geodato aparecerá en el canvas… 
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 Removamos el shapefile g03_legales_muni....  Ya no es necesario.   

Haga click en el botón Remove Layer/Group 

 
 Volvamos a la forma DB Manager que debe estar detrás de la interfaz de QGIS. 

Importar tabla de datos censales a SpatiaLite 
 Para importar la tabla de datos censales s1501, haga click en el botón Import layer/file.   

 
 En la forma Import vector layer, escoja la tabla s1501_2017 

 
 

 Haga click en el botón Update options para traer la estructura de la tabla y preparar la plantilla 

para importarla a SpatiaLite 

 En el apartado Output table, mantenga el nombre s1501_2017. 

 
 Presione OK en esta forma 

 

 Haga click en el botón OK en la forma informativa Import to Database 

 

 Cierre la forma DB Manager. 

 Añada la tabla a la tabla de contenido de QGIS haciendo click en el botón  Add Spatialite 

Layer.   
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 En la forma Data Source Manager | Spatialite que aparecerá, haga click en el botón Connect 

para que se pueda conectar al banco de datos Spatialite. 

 
 Más abajo en esta forma, haga check en la opción Also list tables with no geometry para que 

aparezca la tabla importada en proceso anterior.  

 
 Seleccione la tabla s1501_2017 y haga click en el botón Add. 

 
Cierre esta forma haciendo click en el botón Close.  

 

 Remueva la tabla xlsx.  Ya no es necesaria.  Right click > Remove. 

   
 

 En la forma Remove layers and groups, haga click en el botón OK para aceptar la remoción de 

esta tabla. 
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4C: Unir las tablas (join tables) 
Ya tenemos el ambiente preparado con la tabla externa en la lista de layers.   

 Para unir esta tabla con la tabla de atributos del geodato de municipios, deberá hacer doble click 

encima del nombre del geodato de municipios_2015. 

Aparecerá la forma Layer Properties.   

 Haga click en el ítem Joins. 

 
 Para establecer un enlace (join), presione el botón de adición (cruz verde) en la parte inferior 

izquierda de esta forma. 

 

Aparecerá la forma Add vector join.   

 Use las siguientes opciones: 

 

Join 

layer 
s1501_2017 Tabla con datos censales 

Join 

field 
geo_id 

Campo que contiene los identificadores 

para parear en la tabla s1501_2017 

Target 

field 
cntyidfp 

Campo que contiene los mismos 

identificadores en la tabla de atributos del 

geodato de municipios 

 

 Check en Cache join layer in virtual memory 

  
 Usaremos la opción Joined Fields para traer solamente un campo para que la tabla sea más 

simple. 

  
 Haga check en el campo brecha (razón de ganancias mujeres/hombres, con nivel educativo 

graduado o profesional, 25 años o mayores) 
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 En el apartado Custom field name prefix, haga check y borre el nombre de la tabla. . 

 
 Presione OK para registrar este pareo de tablas 

Aparecerá entonces este enlace registrado. 

 
 Presione OK para cerrar la forma Layer Properties y terminar de registrar este enlace. 

 Abra la tabla de atributos del geodato de municipios_2015 haciendo right click encima del 

nombre de este layer de municipios y escogiendo Open Attribute Table 

Podrá ver el campo añadido (brecha) de la tabla s1501_2017 a la tabla de atributos del geodato de 

municipios. 

 

Usar herramienta exploratoria de datos: Graphics 

(Geoprocessing Tools) 
Antes de hacer el mapa es recomendable tener una idea de cómo están distribuidos estos datos.  QGIS 

ofrece una serie de gráficos para exploración y resumen visual de datos numéricos.  Luego estos 

datos pueden ser exportados a la interfaz en línea plot.ly, la cual le puede dar más opciones de 

visualización.   

 Para comenzar, vaya al menú principal y escoja Processing > Toolbox 

 



 

Tutorial Quantum GIS 3.4 LTR 

128 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

 En el Panel Processing Toolbox, expanda el grupo Graphics y haga doble click en la función 

Mean and Standard deviation plot.   

 
 Aparecerá la forma Mean and Standard Deviation Plot.  Escoja las opciones como en la 

siguiente figura.  Input table: g03_legales_municipios_edicion_octubre2015 

Category name field: abc abrev 

Value field: 1.2 brecha 

 
Click en botón Run para preparar la gráfica.  

 

 El panel Results Viewer mostrará un enlace.  Haga click en este enlace para poder ver la gráfica 

en su navegador web (web browser).  
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Así aparecerá la gráfica en su navegador por defecto.  En este caso: Chrome. 

 
Esta gráfica nos muestra la distribución de datos.  El valor mínimo es 0.27 y 

el máximo es 1.5.  Los datos se concentran entre los valores 0.6 y 0.89 (rangos 

intercuantiles 1 y 3, respectivamente), con una mediana de 0.78.  La mediana 

y la media son casi idénticas.   

Sin embargo, no sabemos cuáles son los municipios (campo abrev) porque la 

herramienta parece no incluirlos o tiene algún bug.   

Recordemos que el valor 1 que significa igualdad de ganancia anual en dólares 

entre varones y mujeres.   

Hagamos con otra gráfica para obtener tanto los municipios como los valores.  

 Haga doble click en la función Bar plot localizada bajo el grupo Graphics. 

 
 Siga la secuencia que muestra esta figura: 

 

 

 

 

Input table: 
g03_legales_municipios_edicion_octubre2015 

Category name field: abc Abrev 

Value field: 1.2 brecha 

 Click en botón Run para preparar la gráfica.  
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 El panel Results Viewer mostrará un enlace.  Haga click en este enlace para poder ver la 

gráfica.  

 
La gráfica aparecerá en su navegador browser.  Los datos no están ordenados.  Es mejor ordenar (sort) 

los valores para conocer rápidamente cuáles son los valores mínimos, medios y máximos.  Para 

ordenarlos, usaremos la interfaz web plot.ly.   

 Haga click en el enlace Edit in Chart Studio o puede hacer click en el enlace Export to plot.ly 

  
 Espere que termine de cargar la gráfica.  Al principio muestra un splashscreen de la aplicación.   

  Esto solo es una imagen de inicio de la aplicación.   

 Plot.ly le mostrará la gráfica de la misma manera.  Ahora podemos ordenar los valores por la 

columna y. 

 

 Haga click en el botón de opciones de la columna y.  Escoja Sort by this column > Ascending. 
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Así aparecerá la gráfica de forma ordenada ascendente en valores de la columna y.  Notará 

rápidamente los valores mínimo y máximo y los municipios que tienen estos valores: MAU Maunabo 

y LOI Loíza, respectivamente.   

 
Por el momento, es todo en cuanto a gráficas.  Esta interfaz merecería otro tutorial aparte.   

 

Opcional: 

 Use estos datos para generar un histograma basado en la columna y.  

 
 Cierre su navegador para continuar el trabajo en QGIS.   
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Diccionario de datos: ¿Qué significan los códigos de los nombres 

de los campos? C05_... 
El archivo ACSST5Y2017.S1501_metadata_xxx.csv contiene los significados de los códigos de los 

nombres de los campos.   
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4D: Hacer el mapa coroplético 
En esta parte haremos un mapa coroplético usando los datos estadísticos que ahora están presentes (join) 

en la tabla de atributos del geodato.  Por lo general, al hacer un mapa coroplético, resumimos datos, 

agrupando valores en clases (bins) o categorías.  
 

 
QGIS provee varios métodos (Mode) para resumir los datos usando diferentes esquemas de clasificación.  

Estos son los métodos de clasificación que provee QGIS: 

Equal 

Interval 

En este método se obtiene el valor máximo de la distribución y se le resta el mínimo.  El usuario 

determina el número de clases/grupos y ese número se divide entre la resta del máximo-mínimo.  En cada 

grupo puede haber diferentes cantidades de casos (diferente frecuencia).    

 Se recomienda usar si distribución de valores es de tipo normal. 

Quantile 
Intentará poner la misma cantidad de casos en cada grupo/clase. 

 Se recomienda para mostrar posicionamiento (rank) u orden.  Ideal para datos ordinales. 

Natural 

Breaks 

(Jenks) 

Intentará que la distribución de valores dentro cada clase sea lo más homogénea posible al minimizar la 

varianza dentro de cada clase.  Además, generará los límites de clases donde existan la mayor distancia 

entre grupos que componen las clases al maximizar la varianza fuera de los grupos.   

 Permite identificar valores atípicos en la distribución de datos.  Agrupa valores próximos.  

Standard 

Deviation 

Es el método preferido para mostrar casos que están por encima o por debajo del promedio.  Utiliza 

desviaciones estándar para crear clases/grupos.  La desviación estándar es una medida estadística para 

determinar el grado de separación en la distribución de valores.  

 Permite identificar valores atípicos en la distribución de datos, pero para hacerlo más legible 

es preferible modificar la leyenda para que exprese valores, no desviaciones estándar 

solamente.  

Pretty 

Breaks 

Es parecido al método Equal Interval.  Redondea los límites de las clases.  

 Se recomienda cuando queremos hacer que las clases numéricas sean más legibles. 

 

Para este ejercicio, los datos que vamos a representar expresan una razón (ratio) entre dos cantidades: 

ganancias en dólares.  Este tipo de dato es numérico con fracciones (en términos matemáticos, números 

Reales).  Hay filas sin valores, pero estas serán ignoradas por QGIS al momento de la clasificación.  

Luego haremos las distinciones entre las filas que tienen valores y las que están vacías (null), para 

incluirlas en el mapa.  Esta es una idea del mapa que se va a preparar.   

 

 
  

Información: 
Mapas temáticos.  En principio todos los mapas tienen uno o varios temas.  A los mapas estadísticos se les llama 

también mapas coropléticos (choros, lugar y plethos, mucho(s))   

https://es.wikipedia.org/wiki/Distribución_normal
http://en.wikipedia.org/wiki/Choropleth_map
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Tareas/Destrezas:  
 Antes de clasificar/agrupar/resumir, es recomendable usar el método Categorized para mostrar la 

distribución de datos sin agrupar.  ¿Por qué?  El método Categorized nos relaciona por color y/o 

cantidad de tinta la distribución ordinal de datos tal como es con sus pequeñas o grandes distancias 

entre valores observados.   

 Usar método Graduated para representar las razones (ratios) comparando las ganancias en dólares (US) 

mujeres/varones, 25 años o más en los últimos 12 meses.  

 Asignar una paleta de colores divergentes para diferenciar gradaciones de ganancia > 1 o ganancia < 1 

 Usar método Rule-Based Classification para añadir un renglón que incluya las filas sin datos (null) 

 Colocar etiquetas labels mostrando las siglas municipales y valores de brecha de ganancias.  Hacer 

etiquetas aparte para municipios sin datos. 

Cartografía exploratoria: Método sin clasificar 
Así como usamos gráficas para tener idea de una distribución de datos, debemos probar varios métodos 

de clasificación.  Lo recomendable es primero usar algún método que nos permita relacionar niveles de 

color/intensidad con el orden de los valores observados.  Para estos fines, QGIS ofrece esta posibilidad si 

usamos un esquema ordenado de intensidad de colores, ya sean convergentes o divergentes.  De esta 

manera tendremos una idea de cuál es la distribución geográfica de los valores observados.  

 En el panel Layers, active (click en) el layer municipios_2015 y haga click en el botón Open 

Layer Styling panel 

 
El panel Layer Styling aparecerá a la derecha de la interfaz gráfica de QGIS. 

 En el ítem Symbology , haga click en el menú drop down y escoja la opción Categorized. 

 
El mapa desaparecerá del canvas porque QGIS está esperando que el usuario defina cuál es la columna 

que se usará para representar (styling).   

 En el apartado Column, haga click en el menú drop down y escoja la columna brecha. 

 
 En la próxima sección Symbol, haga click en el botón Change… 

 
Entrará en la subforma Symbol Selector.  Vamos a hacer varios cambios. 

 En el apartado Fill, haga click en el item Simple fill.   

 
 Vaya a la sección Stroke Color y haga click en el cuadro negro. 

 
Entrará en la subforma Select Stroke Color. 
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 Incremente el nivel de luminosidad (V) a 60%.  Los niveles H y S deben permanecer en cero (0). 

 

 Haga click en el botón  para regresar al panel Layer Styling.   

 Vaya a la sección Stroke width.  Use el botón para reducir el grosor de los contornos de áreas 

hasta Hairline. 

 
 En la sección Color ramp escoja el esquema de colores PiYG 

 
Vamos a hacer algunos cambios a este esquema de color. 

 Invertirlo.  Haga right click encima de esta gradación y escoja Invert Color Ramp 

 
 Cambiar color central.  Haga click encima de esta gradación.  Aparecerá la forma Select Color 

Ramp 

 
 En la forma Select Color Ramp, haga click en el botón slider central para activarlo. 

 
 En el apartado HTML notation, escriba el código para amarillo claro #fff938 y presione Enter. 

 
Notará que la caja Current cambiará a amarillo claro.  
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 Haga click en el botón OK para aceptar cambios y cerrar esta forma.  

De vuelta al panel Layer Styling, vaya a la parte inferior de este panel. 

 Haga click en el botón Clasify 

 
Podrá ver la distribución de datos por intensidad de colores divergentes, desde el verde oscuro al amarillo 

claro en el centro de la leyenda hasta el púrpura oscuro al final de la leyenda… 

   
El layer de municipios se presentará de esta manera: 

 
Los municipios que no tienen datos (null en el campo brecha) están pintados igual que el valor máximo  

brecha = 1.5.  Procedamos a cambiarle el color a uno neutral = gris claro.   

 Haga right click encima del último item (vacío) de la lista de la leyenda, bajo el valor 1.5 y 

escoja la opción Change Color… 

 

 En la forma Change Symbolo Color  que aparecerá, cambie los valores H: 
0, S: 0, V: 95% 

 
 Haga click en el botón OK para aceptar los cambios y cerrar la forma.  
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Esta es la distribución de datos sin usar método de agrupación.  En este caso el mapa representa una 

escala lineal limitada desde 0 a 1.5 

 
 

Guardemos este equema de color que hemos modificado. 

 Haga right click encima del esquema de colores 

 
 Escoja la opción Save Color Ramp… 

 
 En la forma Save New Color Ramp que aparecerá: 

o En la caja de texto Name escriba GiYP 

o En la caja de texto Tag(s), escriba ramp 

o Haga check en la caja Add to favorites 

 
 Haga click en el botón Save para aceptar los cambios y cerrar esta forma.   

 

Esto nos servirá de plantilla para hacer un mapa parecido a este, usando el método Graduate y la técnica 

de clasificación Natural Breaks de George F. Jenks.  

 

Hay algunos aspectos que merecen mencionarse.  Primero, con excepción de algunos municipios como 

Guaynabo, San Juan, Gurabo y Trujillo Alto, esta brecha solamente representa entre 1 y menos del 9% de 

la población municipal.  Segundo, según estudio publicado por el Censo Federal (2019), la diferencia de 

ganancias entre varones y mujeres (gender pay gap) se acentúa más en el sector de profesionales y de 

estudios por encima del bachillerato.  En ocasiones, si la fémina gana más, éstas tienden a exagerar las 

gancias del cónyuge/pareja al Censo (2018).  Por lo tanto, este mapa solo representa la diferencia de 

ganancias entre varones y mujeres solo para un sector pequeño de la población que los municipios 

mencionados anteriormente están entre el 10 al 19%. 

  

https://en.wikipedia.org/wiki/Jenks_natural_breaks_optimization
https://www.census.gov/library/stories/2019/05/college-degree-widens-gender-earnings-gap.html
https://www.census.gov/library/stories/2018/07/wives-earning-more-than-husbands.html
https://www.census.gov/library/stories/2018/07/wives-earning-more-than-husbands.html
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Representar datos mediante método Graduated 
Ya que tenemos una idea de cómo es la distribución geográfica de los datos, vamos a realizar un mapa 

coroplético que relacionará un esquema de intensidad de color con el orden de magnitud de las 

proporciones.   

 

 Para comenzar, haga click encima del nombre del geodato municipios_2015.  

 Asegúrese que el panel Layer Styling esté activado (check).  

 

 
 En la forma Layer Styling escoja la opción Graduated   

   
 

 En el apartado Column, escriba la función to_real(brecha) 

   
¿Por qué usamos esta función?  Esto evitará que QGIS incluya los valores null como si fueran 

ceros al momento de clasificar.   

 En la sección Legend format, use el botón para reducir la cantidad de lugares decimales 

Precision a 2. 

 
 En el apartado Color ramp, haga right click y escoja la opción GiYP.  Este es el esquema de 

color que habíamos guardado anteriormente.  

 
Este esquema de colores es divergente.  Se usa para representar distribuciones de valores que se 

comparan contra un centro.  En este caso, los valores se comparan contra el valor de igualdad de 

ganancia = 1 de la distribución de valores.     

 

Ahora, queremos relacionar los colores rosado-púrpuras con los municipios que tengan valores 

mayores a 1 en la brecha de ganancias.  Estos serían lugares donde las mujeres reportan más ganancias 

que los hombres.   

Brecha de ganancia o “Gender divide”  
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Habíamos indicado que el valor de comparación es 1 (donde las mujeres y hombres tienen igual 

ganancia).   

 Antes, cambie el método de clasificación Mode a Natural Breaks (Jenks) con 5 clases o 

divisiones.  

 
Aparecerá la leyenda con los 5 grupos.   

 

Ver el histograma de la distribución de valores 
Un histograma nos muestra gráficamente cómo se distribuyen los datos.  La altura de las barras representa 

el número de casos dentro de un bin o balde donde se van acumulando estos por conteo (count) al lado 

izquierdo de la gráfica.  En el eje horizontal se muestra la amplitud de valores desde el mínimo al 

máximo.  En el centro estará la medida central (media).   

 Para ver el histograma, haga click en la pestaña Histogram, al lado derecho del tab Classes  

 

 Cargue los valores haciendo click en el botón  Load Values.  Dejemos las demás 

opciones como aparecen por defecto.   

 

 

Haga check en las opciones:  

 Show mean value 

 Show standard deviation 

Esto nos da idea de la distribución de las 

frecuencias y dónde el algoritmo Jenks delimitó 

los valores para separar clases.  Este algoritmo 

tiende a crear límites de clases donde hay 

valores separados o muchos casos vs pocos 

casos en la recta numérica.   

 

 

  



 

Tutorial Quantum GIS 3.4 LTR 

140 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

 Haga click en el tab Classes.   Fíjese en: 

o La cantidad de clases 5 

 
o La leyenda 

 
o Podrá notar que hay 18 espacios vacíos: 17 vacíos en varones, 5 vacíos en mujeres, 

menos 4 que no reportaron ni varones ni mujeres = 18. 

 

 

 
Hasta el momento, ¿cómo describiría algún patrón geográfico en zonas en particular? 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

 

¿Cómo se parece al mapa sin agrupar/agregar en clases? 

 
Los valores extremos en púrpura y verde se mantienen parecidos.  La diferencia está en los colores de 

valores cercanos a la media (0.78).  Podemos añadir una o dos clases más para que la distribución se 

parezca lo más posible al mapa anterior.   
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Añadir clases adicionales  
La idea es tratar de reproducir el mapa sin clases en un mapa agregado/clasificado.  Como aproximación 

no quedará exactamente igual pero suficientemente parecido y con 7 clases o menos, sin contar los null.   

 En el panel Layer Styling, vaya al apartado Classes y aumente el número de grupos/clases a 7 

 
Así aparecerá el mapa en el canvas: 

 
 

¿Cómo se parece al mapa sin agrupar/agregar en clases? 

 
 

Añadir conteo de observaciones en cada clase de la leyenda 
Cada clase de la leyenda puede mostrar la cantidad de casos dentro de cada clase.   

 Haga right click encima del nombre del geodato/layer municipios_2015 y escoja la opción 

Show Feature Count. 

 
Los conteos de casos se mostrarán a la derecha de cada clase: 
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Representar casos sin datos (null) 
Al usar la función to_real(campo), QGIS no toma en cuenta los casos sin datos.  La columna brecha 

tiene 18 casos sin datos en los cuales no son reportadas las ganancias de varones, mujeres o por los dos 

en los pasados 12 meses.  Esto es una ventaja porque los podemos incluir en una clase aparte.   

Para esto debemos cambiar el método de clasificación (Mode) a Rule-based. 

 

QGIS mantendrá las clases como están.  Solo tendremos que añadir una nueva clase que incluirá los casos 

sin datos (null). 

 En el panel Layer Styling cambie el método de clasificación a Rule-based 

 
Podrá notar que las categorías se convierten en definiciones de límites 

 
Estas describen los valores mínimos y máximos de cada clase.  Añadamos la regla para incluir los casos 

sin valores.   

 Haga click en el botón de suma para añadir una regla. 

 
 

No se desconcierte si ve que todo el mapa cambia y se dejan de observar las clases. 

Por ejemplo, así: 

 

 

Continuemos trabajando en el panel Layer Styling.  Observe que está ahora en la subforma Edit Rule. 

 
 En el apartado Label, escriba sin datos. 
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 En el apartado Filter, haga click en el botón Expression ε. 

 
Aparecerá la forma Expression String Builder.   

 Expanda el nodo Fields and Values, localizado en la lista de funciones que aparece en el centro 

de esta forma. 

 
 Haga doble click en el campo brecha para incluirlo en la caja de texto de la izquierda de esta 

forma. 

 
 En la caja de texto para escribir expresiones, termine la expresión escribiendo IS NULL 

 
 Abajo en la forma debe indicar Output preview: 0 

 
 Haga click en el botón OK para aceptar los cambios y cerrar esta forma.   

Ya que conoce la sintaxis de expresiones simples, la próxima vez podrá escribirla directamente de esta 

manera “brecha” IS NULL 

Podrá ver que el mapa municipal cambia.  Se incluye en la leyenda la clase para casos sin valor  

no data [18]. 

 
 

Ahora debemos asignar un color neutral a estos casos para distinguirlos de los demás.   

En la subforma Edit Rule…   
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 En la sección Symbol, haga click en el cuadro Simple fill 

 
 En el apartado Fill color, haga click en la caja de color.  

 
 Cambie el porcentaje de luminosidad (V) a 95% 

  
 Cambie los valores H y S a 0%. 

 
 Haga click en el botón de regreso para volver a la subforma Edit Rule 

 
 En la subforma Edit Rule, haga click en el apartado Stroke color.   

 
 Cambie el nivel de luminosidad a 60% 

 
 Haga click en el botón de regreso para cambiar el grosor de la línea de límites municipales. 

 
 De regreso a la subforma Edit Rule, haga click en el apartado Stroke width.   

Haga clicks en el botón hasta reducir el grosor al nivel Hairline. 

 
 Haga click en el botón de regreso para salirnos de la subforma Edit Rule.  

 
Ya tenemos todas las clases preparadas y el mapa.  

 
 

 

 

4E: Añadir etiquetas con valores 
Ya tenemos el mapa que relaciona los colores con niveles de intensidad (ratio) de la columna brecha.  

Podemos informar mejor a la audiencia que verá el mapa si añadimos información sobre el nombre o 

código nemónico municipal, así como el valor de razón de la columna brecha.   

Información: 
Los mapas temáticos de valores numéricos relacionan la intensidad (cantidad de tinta) con el orden 

de la magnitud de un valor.  Esto lo percibimos de forma ordenada, relacionando los valores más 

altos con los colores más intensos o de mayor cantidad de tinta. 
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 Comencemos en la tabla de contenido, activando el layer municipios_2015 haciendo click en el 

nombre   

 
 y luego haga click en el botón Layer Labeling Options (ABC) 

 
En panel Layer styling, se activará el ítem ABC Labeling 

 
 Haga click en el drop down list y escoja la opción Single labels. 

 
 En el apartado Label with que aparecerá, escoja el campo abrev 

 
 En la pestaña (tab) abc,  busque apartado Size, baje el tamaño a 6 puntos.  

 
Al momento podrá ver que aparecerán en el canvas, los códigos nemónicos municipales.  Habrá 

algunas etiquetas que no aparecerán.  Esto se hace para evitar que las etiquetas estén demasiado pegadas 

para aumentar la legibilidad del mapa.  Además, los códigos no necesariamente aparecerán centralizados. 

 
 Haga click en el tab Formatting +abc < c 

  
 En la sección Alignment, escoja de la lista la opción Center. 

 Esto no alinea la etiqueta en el centro del 

municipio.  Se hace aquí en preparación de una tarea posterior para etiquetas compuestas y 

centralizarlas.   

 Haga click en el tab Buffer.  
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 Haga check en la opción Draw text buffer.  Esto servirá para añadir un halo a las etiquetas 

para que los límites y colores no compitan con el fondo y colores del mapa. 

 
 En el apartado Size, baje el tamaño a 0.65 

 
 Haga click en el tab Placement 

  
 En el apartado Placement, haga click en el radio button Offset from centroid. 

 

 
Podrá notar que centralizará las etiquetas ubicándolas encima del centro del área municipal. 

 

Aún puede haber municipios sin etiquetas.  Añadamos las que faltan.  

 Haga click en el tab Rendering 

 
Haga check en la opción Show all labels for this layer (including colliding labels). 

 
 

Aparecerán las etiquetas que faltaban como Guaynabo (GYB), Luquillo (LUQ). 

  

Luego añadiremos los valores de razón (ratio) de la columna brecha. 

4F: Añadir etiquetas compuestas 
El propósito de esta parte es añadir el valor ratio del campo brecha a las etiquetas existentes.  Lo vamos a 

colocar debajo del código nemónico del municipio.   

 Todavía en el item ABC Labeling del panel Layer Styling, haga click en el botón ε. 

 
Aparecerá la forma Expression Dialog.  Note que en esta forma está presente el campo abrev. 



 

Tutorial Quantum GIS 3.4 LTR 

147 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

 
Lo que vamos a hacer es concatenar esta etiqueta de códigos municipales con la etiqueta de los valores 

ratio del campo brecha.  Para esto se usa el operador de concatenación ||.  Como queremos que aparezca 

debajo del código municipal, usaremos otro operador ‘\n’.  Este añade una línea luego de la última letra 

del código nemónico municipal.   

 En la caja de texto de expresión, ubique el cursor haciendo click al final de la palabra abrev y 

dejando un espacio.   

 

 Haga click en el botón del operador de concatenación  

 Note que abajo en esta forma, le presentará un mensaje de error porque la expresión 

está en este caso, incompleta.   

 

 Haga click en el botón del operador de añadir línea  (line feed). 

 En este momento, Output preview no le devuelve error, pero la fórmula sigue 

incompleta porque no le hemos añadido el valor de ratio del campo brecha. 

 
 

 Haga click en el botón del operador de concatenación  

 Vuelve a aparecer como expresión no-válida. 

 En la lista de funciones que aparece en el centro de esta forma Expression Dialog, expanda el 

nodo Fields and Values y haga doble click en el campo brecha. 

 

 

Note que los campos abrev y 

brecha aparecen sin comillas 

dobles y con comillas dobles.   

Las dos maneras son válidas 

para llamar estos campos para 

traer los valores.   

Lo más correcto es encerrar 

los nombres de campos en 

comillas dobles en caso de 

que los campos tengan 

nombres con espacios, etc.  

Ya la etiqueta compuesta está lista, como aparece en el Output preview.  

 

 Haga click en el botón OK para aceptar los cambios y cerrar esta forma.  
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Así aparecerá el mapa: 

 
¿Qué pasó con las etiquetas de los municipios en gris, que tienen la categoría “sin datos”? 

¿Cómo se relaciona esto con las filas sin datos en la columna brecha?  
Si hay casos sin valor, QGIS los ignora y no los presenta.  Las operaciones que incluyan 

un null, ‘nulifican’ el resultado, por ejemplo: null + 1 devuelve null, ‘abc’ || null devuelve 

null, etcétera. 

4G: Crear regla para añadir etiquetas con casos sin 

datos (null) 
Lo que falta para completar este mapa es añadir solo los nombres de los municipios donde no se reportó 

ganancias tanto por varones, hembras o por ambos (18 municipios).  Esto se refleja en la columna brecha, 

la cual contiene filas sin dato (null).  Para esto añadiremos una regla en la cual solo se incluyan los 

municipios sin datos.  Podemos presentarlos de manera menos llamativa usando un color gris más claro y 

un tamaño un poco más pequeño  

 Aún en el panel Layer Styling y dentro del item ABC Labeling, cambie el método de etiquetado 

de Single labels a Rule-based labeling. 

 
 En la única regla que aparecerá, haga right click encima y escoja la opción Copy.   

 

Con esto, copiamos toda la definición de las 

etiquetas existentes y solo modificaremos 

algunas características, primero para que 

puedan aparecer y segundo, para hacerlas 

menos llamativas. 

 

 Haga right click en el espacio en blanco, fuera de la regla existente y escoja la opción Paste.   

 
 Active la nueva regla copiada haciendo click encima.   

 
Ahora haremos los cambios dentro de una nueva regla.  Esto incluirá crear un filtro para traer solamente 

los casos con null, bajar un poco el tamaño de la letra, y cambiar su color a gris oscuro.   
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 Haga click en el botón Edit Rule.  Este botón está localizado en la parte inferior del panel 

Layer Styling.  

Entrará en la subforma Edit Rule.   

 En el apartado Description, escriba sin datos. 

 
 En el apartado Filter, escriba la expresión brecha IS NULL  

 
 Más abajo en la sección Labels, haga check en Labels y en el apartado Label with, sustituya la 

expresión existente escogiendo el campo abrev.  

 
Las etiquetas aparecerán en el mapa, pero debemos cambiarle el formato para que no resalte sobre las 

demás etiquetas.  

 Active la pestaña abc  

 En el apartado Size, baje el tamaño a 5.5.   

 Continuando, más abajo en la sección Color, haga click en la caja negra para cambiar el nivel de 

luminosidad.   

 

 En la subforma Select Text Color  que aparecerá, vaya a la sección V 

(luminosidad) y escriba 30% 

 
 Haga click en el botón para regresar primero a la subforma Edit Rule y otra vez para llegar al 

panel Layer Styling 

 
Así aparecerán las etiquetas de todos los municipios: 

  

Opcional: Añadir efectos visuales al mapa 
Este paso sirve de ejemplo de las capacidades de QGIS para hacer que el mapa sea más atractivo. 

 

QGIS provee herramientas para hacer que el layer aparezca con una sombra o un halo.  Esto hace que el 

mapa pueda aparecer con el efecto de profundidad o podemos crear el efecto de estar rodeados de agua, 

como es el caso nuestro de una isla.   
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 Para crear este efecto, regrese al panel Layer styling.  Si lo cerró antes, haga click en el botón 

Open en el layer styling dock del Layers Panel 

 
 Expanda la sección Layer Rendering, localizada en la parte inferior del panel Layer Styling, 

haciendo click en el triángulo (nodo).   

 
 Navegue hacia abajo hasta encontrar la opción Draw effects y haga check en el cuadro. 

 

El botón Customize effects  se habilitará…   

 Haga click en este botón: 

 
Aparecerá la subforma Effects Properties.   

 Haga check y click para activar el item Outer Glow para mostrar el efecto de halo o brillo 

exterior.  

 

El objetivo es crear un halo 

exterior de color azul para dar 

impresión de que se trata de 

una isla en el océano.   

 Deje las demás opciones que aparecen por defecto y haga click en el botón de color negro al lado 

de la opción Single Color 

 
 En la sub-forma Select glow color escriba: 

 200 en la caja de texto correspondiente al valor H (Hue) del modelo de colores HSV. 

 100% en S (saturación) 

 100% en V (luminosidad) 
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Verá los cambios inmediatamente: 

 
 Cierre el panel Layer Styling. 

 

Cambiemos el nombre del layer de municipios_2015.  El nombre debe reflejar el tema que presenta el 

esquema de colores.  El tema es la brecha o ratio de ganancias mujeres vs hombres. 

 Haga right click en nombre del layer de municipios_2015.   

 
 Cambie el nombre a brecha 2013-2017.  Solo escribimos esto porque esto será ampliado en el 

título del mapa, en el ejercicio para generar un mapa para imprimir en formato PDF.  

 
 Guarde este proyecto QGIS con el nombre Ejercicio_4.qgs.  Lo usaremos posteriormente para 

el ejercicio final de preparación e impresión de mapa en formato PDF.  

 Cierre la sesión de QGIS. 

 

En la próxima práctica, usaremos algunas funciones de geoprocesamiento con aplicación 

medioambiental. 
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Sin Clasificar (Categorized) 

 
Natural Breaks (Jenks)  

 
Standard deviation (7 clases) 

 
Equal Interval 
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Preguntas 
1. Pareo de tablas (join): Indique cuáles son las condiciones necesarias para parear tablas.   

(p 114) 

______________________________________________________________________________ 

______________________________________________________________________________ 

 

2. ¿Qué mecanismo visual podemos usar para representar los valores numéricos en un campo de la tabla 

en un mapa? Dicho de otro modo, ¿cómo relacionamos las gradaciones de intensidad de los valores en el 

mapa? (p 134) 

______________________________________________________________________________ 

______________________________________________________________________________ 
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Para propósitos de este tutorial, cuando hablamos de geoprocesos, hablamos de funciones que utilizan 

datos para hacer un trabajo o producir resultados.  Estos resultados pueden resultar en un geodato o 

pueden resultar en una tabla de atributos o incluso un listado ordenado. 

Consideraciones antes de comenzar 

geoprocesamiento 
Un artículo de la compañía Esri, describe el proceso de análisis o geoprocesamiento.  En este artículo, el 

proceso se divide en cinco pasos fundamentales: 

1. Establecer, dar forma clara a la pregunta o problema 

2. Explorar y preparar los datos 

3. Analizar cuáles serían los métodos de geoprocesamiento o herramientas adecuadas de análisis 

4. Llevar a cabo el proceso con las herramientas o funciones escogidas 

5. Examinar y refinar los resultados 

 

Estos serían ejemplos de preguntas que podrían contestarse usando las funciones analíticas de un 

programa desktop GIS: 

 

Descargar los datos para esta parte 
 Para realizar estos ejercicios, deberá descargar el banco de datos SpatiaLite que contiene los datos 

necesarios (Ejercicio_5.zip) para esta primera parte.   

 Descomprima este archivo zip en el folder C:\Tutorial_QGIS\Ejercicio_5. 

 

  

http://www.esri.com/
https://community.esri.com/groups/esri-training/blog/2018/10/19/use-the-five-step-gis-analysis-process
http://gis.otg.pr.gov/downloads/tutorials/qgis/ejercicio_5.zip
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Modelo Simple Features del Open Geospatial 

Consortium 
Muchos programados open source de manejo de datos geográficos utilizan este estándar para codificar y 

registrar las geometrías que se usarán para representar elementos geográficos y eventos localizables.  

QGIS hace uso de este estándar y es buena idea describir algunos aspectos de importancia.  De esta 

manera, podremos entender mejor el comportamiento de éste y otros programas que adoptan este 

estándar.   

 

El siguiente diagrama, extraido del documento OpenGIS® Implementation Standard for Geographic 

information - Simple feature access - Part 1: Common architecture, versión 1.2.1.145 

 

En este podemos notar las jerarquías de las geometrías.  Las de arriba son las geometrías abstractas, 

Geometry, Point, Curve, Surface, GeometryCollection, de las cuales se derivan LineString, Polygon, 

MultiPolygon, MultiLineString y otras.  QGIS y otros programas tipo Desktop, no leen directamente el 

tipo GeometryCollection, pero sí MultiPolygon, MultiPoint y MultiLineString.   

  

http://portal.opengeospatial.org/files/?artifact_id=25355
http://portal.opengeospatial.org/files/?artifact_id=25355
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Dimensión de las geometrías 
Geometría Dimensión 

Punto, multipoint 0 

Entidad lineal 1 

Entidad superficial 2 

Interior, contorno y exterior de las geometrías 
Estas características de las geometrías nos ayudan a entender las relaciones espaciales y el uso de los 

operadores y predicados espaciales.  Tabla 2: 

Point/MultiPoint 

 

Interior El mismo punto o puntos 

Contorno

/Límite 

Vacío 

Line/MultiLine 

 

Interior Puntos que no estén en los 

puntos del contorno: estos 

son los puntos de inicio y 

final 

Contorno

/Límite 

Puntos de inicio y final.   

MultiLine: puntos de 

contorno que estén en 

líneas componentes que 

sean impares 

Polygon/MultiPolygon 

 

Interior Puntos del interior de los 

anillos:  

MultiPolygon: Puntos del 

interior de los anillos 

Contorno

/Límite 

Conjunto de anillos 

exteriores e interiores 

El exterior de estas geometrías estará compuesto por los puntos no situados ni en el interior ni el 

contorno. 
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Predicados para las relaciones topológicas 
A continuación, una breve explicación de los predicados disponibles en QGIS.  Tabla 3. 

Predicado 

Geometría: 
P punto,  
L polilínea,  
S polígono Condiciones 

Equals Todas A es igual a B si: 

* la relación topológica entre estos es idéntica … aunque …    

* el número de vértices y la dirección de las líneas pueden ser diferentes 

Disjoint Todas A es desjunto de B si: 

* los objetos no tienen ningún punto en común (interior o límite).   

(Este es el inverso de Intersects) 

Touches S/S, L/S, L/L, 

P/S, P/L 

A toca a B si: 

* los límites (contornos) de los objetos tienen al menos un punto en común… y ... 

* si los interiores de ambos no tienen algún punto en común 

Crosses P/S,P/L,L/S,L/L A cruza a B si: 

* los interiores de los objetos tienen al menos un punto en común … pero … 

* no todos en común … y …  

* si la dimensión de la intersección de los interiores es inferior a la dimensión 

máxima de los objetos A y B (no aplica a PP, SS) 

Within Todas A está dentro de B si: 

* todo punto de A es un punto de B … y …  

* si los interiores tienen al menos algún punto en común …  

* (ningún punto de A está en el exterior de B) 

* (inverso de Contains) 

Contains Todas A contiene a B si: 

* todo punto de B es un punto de A … y …  

* si los interiores tienen al menos algún punto en común 

* (ningún punto de B está en el exterior de A) 

* (inverso de Within) 

Overlaps S/S,L/L,P/P A solapa a B si a la vez: 

* A y B tienen la misma dimensión (no aplica a P/L, P/S, L/S) …  

* A y B tienen puntos en común… pero no todos …  

* La intersección de los interiores de A y B tiene la misma dimensión que A y B 

Intersects Todas A interseca a B si: 

* A y B tienen al menos un punto en común (interior o límite) 

* (Inverso de Disjoint) 

Covers Todas A cubre a B si: 

* ningún punto de B está en el exterior de A 

* todo punto de B es un punto de A  

Compárese con Contains 

CoveredBy Todas A está cubierto por B si: 

* ningún punto de A está en el exterior de B 

* todo punto de A es un punto de B 

Compárese con Within 

*Relate (AB, 
DE-9IM 
Pattern 
Matrix) 

Todas * Explica la relación espacial de A y de B mediante la aplicación del modelo 

DE9IM.  

* Permite la generalización de los predicados espaciales para 98 relaciones 

topológicas  

*Relate se puede usar solo desde consultas SQL a través del DB Manager. 
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5A: Proximidad, área de influencia (buffer zone) 
Estos son ejemplos de situaciones en las cuales podemos usar funciones de distancia para contestar 

preguntas:  

1. Cuáles y cuántas gomeras (lugares para instalación de neumáticos) están a 300 metros a ambos 

lados de la carretera PR-111.  Esta es la carretera que va desde el Municipio de Aguadilla, en el 

noroeste hasta el Municipio de Utuado en el centro-oeste. 

2. Cuántas personas viven a 400 metros de la estación de Tren Urbano “Las Lomas” en San Juan. 

3. Cuántas son las instalaciones con tanques soterrados de almacenamiento de combustible que 

estén a 100 metros de una escuela en el Municipio de San Sebastián.  

Etcétera… 

 

Realización del ejemplo 1: 

Cuáles y cuántas gomeras (lugares dedicados a la instalación y manejo de neumáticos) están a 300 

metros a ambos lados de la carretera PR-111. 

Hacer conexión a la base de datos SpatiaLite 
En una nueva sesión/project de QGIS, deberá hacer una conexión a la base de datos para el ejercicio 5.  

Se trata del archivo zip que descargó y descomprimió dentro del folder C:\Tutorial_QGIS\Ejercicio_5.   

**NOTA: En esta sección los ejemplos están haciéndose en Ubuntu 18.04 LTS** 

 Abra una nueva sesión New Project de QGIS 

 

 Vaya a Database > DB Manager, o use el botón . 

 

 Haga right click en el ítem 

SpatiaLite y escoja la opción 

New Connection. 

 Navegue hasta llegar al folder 

C:\Tutorial_QGIS\Ejercicio_5.  

 

 

 Escoja el archivo 

Ejercicio_5.sqlite.   

 Haga click en el botón Open. 

 

 

 Expanda el nodo de la nueva 

conexión a la base de datos 

ejercicio_5.sqlite. 

 Haga right click en la tabla/layer 

municipios_2015 y escoja la 

opción Add to canvas.   

 

 Cierre la forma DB Manager. 

La carretera PR-111 va desde los municipios de Aguadilla hasta Utuado.   
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 Acérquese al área mediante zoom in haciendo un cuadro como este: 

 

Hacer conexión al servidor de geodatos de la Oficina de Gerencia 

y Presupuesto: Transmisión de datos usando protocolo Web 

Feature Service (WFS) 
Para traer el geodato de carreteras de la Autoridad de Carreteras, use una conexión web feature 

service WFS.  Este le traerá el geodato que escoja, con sus coordenadas y atributos, de una lista de 

geodatos publicada en nuestro servidor GIS mediante el programa Geoserver.  

 En QGIS haga click en el botón Add WFS Layer 

 
Aparecerá la forma Add WFS Layer from a Server. 

 Haga una nueva conexión usando el botón New. 

 
Aparecerá la forma Data Source Manager | WFS 

 
 En el apartado Connection details: 

 

En Name escriba Geoserver OGP. 

En URL, escriba 

http://geoserver.gis.pr.gov/geoserver/wfs 

 Haga click en el botón OK.  Es todo lo que necesita.   

 De vuelta a la forma Data Source Manager | WFS, escoja Geoserver OGP del combo box 

 
 Haga click en el botón Connect 

 

 En l a caja de texto Filter, escriba carreteras  y presione Enter  

¿Qué es WFS? 

Web Feature Service: Es una interfaz 

estandarizada de transmisión de datos 

geográficos.  Utiliza el lenguaje GML, 

derivado de XML. 

Ver artículo WFS en Wikipedia (inglés). 

http://geoserver.org/display/GEOS/Welcome
http://en.wikipedia.org/wiki/Geography_Markup_Language
http://en.wikipedia.org/wiki/XML
http://en.wikipedia.org/wiki/Web_Feature_Service
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 Espere que haga la conexión.  Escoja el geodato g35_viales_carreteras_estatales_julio_2015. 

  
 

 Presione el botón Build query.  Usaremos estas instrucciones para traer solamente la carretera 

PR-111. 

 
Aparecerá la forma SQL query composer. Esta forma sirve para filtrar la extracción de datos desde el 

servidor que publica datos mediante WFS.  Verá escrita parte de la consulta SQL para extraer los datos. 

Lo que falta es ubicarse en la caja de texto Where, el cual sirve para insertar el nombre de la columna y la 

condición. 

 Haga click dentro de la caja de texto Where. 

 
 Para insertar el nombre de la columna de este geodato, vaya al combo box Columns que está bajo 

el apartado Data: 

 Escoja la columna g35_viales_carretera…2015.num_carre (int) 

 
 Deberá aparecer el nombre completo del geodato y la columna en la caja de texto Where 

 
 Inmediatamente después del nombre de la columna, escriba =111 

 
Así debe aparecer la consulta completada en la caja de texto SQL statement 

 
 Haga click en el botón OK para aceptar los cambios y cerrar esta forma. 

La consulta SQL deberá aparecer en la forma Add WFS Layer from a Server, en la sección SQL: 

 
 

 Haga check en las opciones: 

 Use title for layer name.  Esto acortará el nombre del layer, usando solo el título 

 Only request features overlapping the view extent.  Esto sirve para traer datos dentro de la 

extensión territorial en uso en el canvas. 
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Note el sistema de referencia espacial EPSG:6566.  (State Plane Lambert Conformal Conic 

NAD83(2011): 

 
 Presione el botón Add en la forma Add WFS layer from a Server 

  
 Cierre la forma Data Source Manager.  

Aparecerá el nuevo layer WFS en el panel Layers.  Podrá ver que QGIS asigna un icono de filtro a este 

layer para hacer saber que es un layer basado en un subconjunto de los datos de carreteras.   

 
Es posible que el nuevo layer de carretera PR-111 no se note.  Depende del color que QGIS le asigne por 

defecto.  Cambie el color a uno más notable… 

 Para acercarse (zoom) al área seleccionada, active el layer 

g35_viales_carreteras_estatales_julio_2015 y use el botón Zoom to Layer: 

 
El geodato de carreteras estatales deberá verse más o menos así: (solo la carretera PR-111).  Esta es la 

carretera que va desde Utuado hasta la costa noroeste en Aguadilla.   

Esta era una ruta que se origina en el siglo XIX para el transporte del café del centro-oeste hacia el puerto 

de Aguadilla 

  
Ahora necesitará buscar el geodato de lugares de venta e instalación de gomas (neumáticos). 

Repita el proceso de añadir un layer WFS tal como lo hizo para el geodato de carreteras. 

 Presione el botón Add WFS Layer: 

  
Aparecerá la forma Data Source Manager | WFS. 
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 Ya hizo la conexión anteriormente, por lo tanto, solo necesita escoger Geoserver OGP del 

combo box: 

 
 En Filter, escriba gomeras y presione Enter.  Esto hará que aparezca solo el geodato llamado 

g11_proteccion_gomeras 

 
 Selecciónelo haciendo click encima del geodato g11_protección_gomeras 

 
 Presione el botón Add para traer el geodato a QGIS. 

 Cierre la forma Data Source Manager.  

Así debe verse más o menos el mapa con la carretera PR-111 y las gomeras (lugares para instalación y 

manejo de neumáticos): La diferencia debe estar en la simbología… 

 
En la próxima sección vamos a establecer el umbral o área de influencia (buffer) con radio/distancia 

de 300 metros alrededor de la carretera PR-111. 

Usar el panel Processing toolbox: buffer 
QGIS provee múltiples algoritmos de geoprocesamiento, tanto para geodatos vectoriales como matriciales 

(ráster).  Estos incluyen los que trae QGIS, los de GDAL/OGR, SAGA y los de GRASS.   

 Para este propósito vaya al menú principal y escoja Processing > Toolbox 

 
 Aparecerá el panel Processing Toolbox.  En la caja de texto escriba buffer. 

 
Aparecerán varios algoritmos relacionados a la tarea Buffer.   

 Escogeremos la herramienta buffer, bajo los geoalgoritmos Vector geometry de QGIS.   
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Algunos de estos algoritmos funcionan con datos 

ráster.  En esta parte, los datos que estamos usando son 

vectoriales (puntos, líneas, áreas) 

 Haga doble click en el ítem Buffer.   

Aparecerá la forma Buffer 

 

 En Input vector layer escoja el layer g35_viales_carreteras_estatales_julio_2015: 

 
 En Distance, escriba 300.  Recuerde que las unidades de medida están en metros. 

 
 En Segments escriba 20.  Esta es una opción para suavizar el contorno del buffer.  Si deja la 

opción en 5, el buffer se verá menos redondeado. 

 
 En el apartado End cap style mantenga la opción Round.  Esto es para que los extremos de este 

buffer aparezcan redondeados, no cuadrados.  

 
 En el apartado Join style, mantenga la opción Round.  

 
 Deje el apartado Miter limit en dos unidades.  

 
 Use la opción Dissolve result 

 
 En el apartado Buffered, mantenga la opción Create temporary layer 

  
 Mantenga check la opción Open output file after running algorithm para que aparezca en el 

canvas cuando termine de realizar el buffer.  

 
 Presione el botón Run para realizar el buffer. 
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 Cierre la forma Buffer.   

Así debe verse la zona buffer de 300 metros alrededor de la carretera PR-111: 

  
 En la tabla de contenido, arrastre el nuevo layer temporal Buffer debajo del layer de carreteras: 

 →  

 

Select by location: Devolver conteo de puntos dentro de la 

distancia 
Ya tenemos todo preparado.  Lo que falta es usar la función Select by location para averiguar cuáles y 

cuántas son las gomeras que están a 300 metros a ambos lados de la PR-111.  

 En el menú principal busque Vector > Research Tools > Select by location: 

 

Aparecerá la forma Select by location.  

 En Layer to select from, escoja el geodato de g11_proteccion_gomeras [EPSG:6566] 
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 En el apartado Where the features (geometric predicate), mantenga check solamente la opción 

intersects 

 
 En el apartado By comparing to the features from, escoja el layer temporal Buffered 

  
 En el apartado Modify current selection by, mantenga la opción creating new selection 

 
 Presione el botón Run para hacer la selección. 

 Cierre la forma Select by Location. 

En la parte inferior izquierda de QGIS aparecerá el número de elementos seleccionados: 

 
Así se ve la selección geográfica en el canvas de QGIS.  Los puntos seleccionados están en amarillo 

brillante. 

 
 Active click enel layer g11_protección_gomeras.  Abra la tabla de atributos del geodato de 

gomeras.  

Notará que la barra de título muestra el número de elementos seleccionados (36 de 1865). 

 
 Para ver los records seleccionados solamente, use la opción Show selected features localizada en 

el combo box de la esquina inferior izquierda de la tabla. 
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Estos son algunos de los 36 records ordenados por municipio: 

 
 Cierre la tabla. 

Según estas dos funciones, (buffer y selección por intersección) hay 36 gomeras localizadas a 300 

metros de distancia de la carretera PR-111.  

 

Remueva los layers: * gomeras, * buffer de 300 metros y * la carretera 111.   

NO se usarán para el siguiente ejemplo. 

 Seleccione estos layers en la tabla de contenido.  

 Haga click en el botón Remove. 

      
 

 Presione OK para confirmar la remoción de estos layers. 
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5B: Intersección geométrica usando plugins GRASS y 

Group Stats 
La intersección devuelve la geometría de la zona de coincidencia entre dos o más geodatos.   

                         
Suele usarse para extraer áreas y a la vez preservar los atributos de ambos geodatos.  Por ejemplo: 

1. Hacer un listado de cuáles son los tipos de suelos por barrio en un municipio, por 

ejemplo, el Municipio de Arroyo. 

2. Cuáles son las carreteras estatales que están en las diferentes zonas de susceptibilidad a 

deslizamientos 

3. Cuál es la población en zonas inundables (esto requerirá además usar interpolación areal) 

4. Conocer las diferentes reglamentaciones de suelo en la zona del carso y áreas de rocas 

calizas. 

5. Cuáles fueron los usos de suelos registrados en 1977 en los barrios del Municipio de 

Arroyo 

Haremos el ejemplo número 5  

Cuáles fueron los usos de suelos registrados en 1977 en los barrios del Municipio de Arroyo.   

  

http://www.geog.ubc.ca/courses/klink/gis.notes/ncgia/u41.html#SEC41.3.1
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Para este ejercicio necesitará instalar el plugin Group Stats.   

Este plugin es útil para organizar y visualizar los datos por categorías.  Es equivalente a una pivot 

table de MS Excel o LibreOffice Calc.  Además, permite seleccionar por celda o categorías y 

provee para ver estas selecciones en el canvas de QGIS.  

 
En esta gráfica estamos viendo una tabla pivot con las sumas de área (en cuerdas) ocupada por usos de 

suelo (1977) para cada barrio del Municipio de Arroyo (ubicado en la costa sur-sureste de Puerto Rico).  

Algo que le podrían añadir a este pivot table sería el cómputo de subtotales por fila y por columna, 

aunque esto puede hacerse fácilmente en LibreOffice Calc o en Excel.  

 Comience por instalar el plugin.  Vaya al menú principal y escoja Plugins > Manage and 

Install Plugins 

 
Aparecerá la forma Plugins. 

 A la izquierda de esta forma, haga click en el item All. 

 
 En la caja de texto Search, escriba group s. 

 
Aparecerá el plugin Group Stats. 

 

Los plugins o complementos proveen herramientas útiles y son desarrollados de manera 

independiente por colaboradores que desan resolver algún problema y lo comparten con otros.   

http://anitagraser.com/2013/02/02/group-stats-tutorial/
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Aparecerá una descripción corta de este plugin: (visto en agosto 8, 2019) 

 
 Presione el botón Install Plugin. 

 
 Espere que termine la instalación. 

 
 Cuando está instalado, aparecerá una marca check al lado del nombre del plugin:  

 
 Presione el botón Close para cerrar la forma Plugins. 

Traer geodato de barrios del municipio de Arroyo 
Traiga el geodato de barrios del Municipio de Arroyo usando la conexión a la base de datos 

Ejercicio_5.sqlite.   

 Vaya a la interfaz DB Manager  

 
y expanda el nodo del archivo ejercicio_5.sqlite.  

 

 

 

 

 

 Haga right click encima del layer/tabla 

arroyo_barrios_2015 y escoja la opción Add to canvas. 

  

  

 

 En la tabla de contenido de QGIS, haga right click en el layer 

arroyo_barrios_2015 y escoja Zoom to layer 
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Así debe verse el geodato de barrios del Municipio de Arroyo.  Los colores pueden variar 

 

Traer geodato de uso de suelos, 1977 
Traiga este geodato usando el DB Manager yendo al menú principal > Database > DB Manager 

 

 Haga right click encima del layer/tabla 

arroyo_usos_suelos_regional_1977 

 Escoja la opción Add to canvas. 

  

 

 En la tabla de contenido de QGIS, haga right 

click en el layer 

arroyo_usos_suelos_regional_1977  

 Escoja la opción Zoom to layer 
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Le asigné 30% de transparencia a este layer de usos para que pueda ver el layer de barrios y el de 

municipios. 

 
 Así debe verse la tabla de atributos del entorno del Municipio de Arroyo, usos del suelo, 1977: 

 

v.overlay (GRASS-GIS): ejecutar intersección geométrica 
Continuando, ahora podemos hacer el proceso de intersección geométrica usando la función de 

Intersección geométrica.  De esta manera, podremos integrar los datos de usos de suelos, 1977 en la 

tabla de atributos del geodatos de barrios de Arroyo.   

 En el panel Processing Toolbox que debe tener aún visible desde la tarea anterior 

 
en la caja de texto Search escriba la palabra overlay: 
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Podrá notar que QGIS le hará disponible el 

geoalgoritmo v.overlay del programa GRASS.  

El plugin GRASS nos permite utilizar módulos 

(geoalgoritmos) de GRASS sin necesidad de 

abrir el programa.  

 
Aparecerá la forma v.overlay – Overlay two vector maps 

 Siga los siguientes pasos: 

 

 
 Haga click en el botón Run para correr el algoritmo v.overlay. 

 Espere los resultados.  

 
 Cierre la forma v.overlay. 

 

  

Recuerde que vamos a intersecar geometrías; esto nos devolverá solamente las áreas en común 

que solapan.  Además, uniremos las tablas de ambos geodatos para las áreas comunes.  Lo que 

esté fuera del Municipio no se guardará en el resultado. 

❶: Mantenga activo el tab Parameters 

❷: En la sección Input Layer (A), escoja el 

layer arroyo_barrios_2015 

❸: Input Layer (A) Type: area 

❹: Input Layer (B), escoja el layer 

arroyo_usos_suelos_regional_1977 

❺: Input Layer (B) Type: area  

❻: Operator to use: escoja and  

❼: Snapping threshold for boundaries 

[optional] escriba 1.0  

❽: Click en botón triángulo Advanced 

parameters y en v.in.ogr snap tolerance: 

escriba 1.0  

❾: v.out.ogr min area: escriba 10.000  

❿: v.out.ogr output type: mantenga opción 

auto  

⓫: Mantener check en opción Open output 

file after running algorithm.  El 

resultado será un layer temporal. 
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Al final de este proceso deberá aparecer el nuevo geodato temporal “Overlay” en el canvas y en la tabla 

de contenido. 

 

 

 Remueva el geodato regional de usos de suelo, 1977 haciendo click en el botón Remove Layer: 

 
 Inspeccione la tabla de atributos del nuevo geodato.  Active el archivo temporal Overlay y haga 

click en el botón Open Attribute Table  

  

Añadir una columna para registrar el área en cuerdas que ocupan 

los usos de suelo 
Ya que tiene la tabla de atributos activada… 

 En la tabla, haga click en el botón de modo de edición Toggle edit mode  

Aparecerá la interfaz de calculadora de campos, en la cual podrá modificar los valores de los campos.  

  
 

Vamos a crear una columna de tipo de datos numérico con decimales para guardar el área en 

cuerdas de cada elemento geométrico de área del geodato.   

 Use el botón New column para añadir una columna. 
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 Aparecerá la forma Add field 

 

Name: escriba cuerdas 

Comment: puede escribir área en cuerdas 

Type: escoja de la lista a Decimal number (double) 

 

 Presione OK para añadir esta columna. 

Aparecerá la nueva columna cuerdas con NULL en cada record. 

  

Hacer cómputo de área en cuerdas en la nueva columna 
Nuestra unidad de área para el geodato es el metro cuadrado. Vamos a calcular los valores de cuerdas 

para cada record.   

1 cuerda = 3930.395625 metros cuadrados 

Para calcular valores, usaremos la herramienta Field calculator bar. 

 Seleccione el campo cuerdas dentro del drop-down list (lista de campos). 

 En la caja de texto a la derecha, escriba la función $area seguido del signo de división y el factor 

de conversión. 

 

$area / 3930.395625 

 Para calcular todos los records de la tabla, presione el botón  Update All  

 Haga dos clicks en la cabecera header del campo cuerdas y verá los valores calculados en orden 

descendente. 

  
Más adelante pasaremos a sumarlos usando el complemento plugin GroupStats, agregando valores para 

resumir uso de suelo por bario en el Municipio.   

 Guarde su trabajo, presione el botón  Save edits para guardar los cambios.   

 Presione el botón  Toggle editing mode para cerrar la sesión de edición de la tabla. 

 Cierre la tabla. 

Resumir área de uso de suelos por barrio (Pivot Table) 
Usaremos el plugin Group Stats para esta parte.  Este funciona como las tablas pivot en MS Excel, 

Access y LibreOffice Calc.   

 Ya que lo ha instalado anteriormente, vaya al menú principal y escoja Vector > Group Stats > 

Group Stats. 

Aparecerá la forma Group Stats: 
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 En la sección Control Panel, vaya al apartado Layers, y asegúrese que está usando el geodato 

temporal Overlay: 

  
 En Fields, tome un momento para distinguir los campos.   

 

 

 

Campos/Fields: 

Numéricos: a_cat, b_cat, b_id, b_lucode, cuerdas se 

identifican como tales con un ícono de diagrama pie 

chart .  

 

Texto, tales como a_barrio, a_cntyidfp, a_geoid, 

a_id, a_statefp, b_tipo, b_usos aparecen con un icono 

de documento . 

 

Geometría (Area, Perimeter) aparecen con icono de 

globo terráqueo . 

Funciones matemáticas y de agregación de datos 

(average, sum, …) aparecen con iconos en forma de 

gráfica de barras .  
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Preparemos la forma para el proceso.  Vamos a hacer que cada barrio tenga una columna.   

 En el apartado (caja) Columns, deberá poner el campo Barrio.  Siga los siguientes pasos: 
❶: Arrastre el campo a_barrio de la lista en 

Fields, dentro de la caja Columns 

❷: Arrastre ahora el campo b_usos en la 

lista Fields, dentro del apartado (caja) Rows 

 
 

❸: Arrastre el campo cuerdas dentro del 

apartado (caja) Value 

❹: Arrastre la función Sum, en la lista 

Fields, dentro de la caja Value, debajo del 

campo cuerdas.  Con esto, vamos a resumir la 

superficie (área) de los usos de suelo en 

cuerdas, mediante sumatoria.   

 
 

 No haga check en la opción Use only selected features 

 
Notará que luego de añadir la función sum, se activará el botón Calculate.   
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Así deben quedar las opciones en el panel de 

control de esta función: 

 
 

 Presione el botón Calculate  

 

 
 

 

A la izquierda de esta forma Group Stats, 

aparecerá la tabla con los resúmenes de 

uso de suelo (sumatoria) del área o 

superficie en cuerdas por cada barrio del 

Municipio de Arroyo 

Esta tabla puede exportarse a formato csv para manipulaciones posteriores o para generar gráficas en 

Excel o Calc de Open Office. 

 
 

Puede seleccionar celdas (ctrl+click) de esta tabla y verlas en el canvas: 

Luego haga click en Features > Show selected on map  
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Áreas seleccionadas vistas en el canvas de QGIS:

  

 Descarte esta selección haciendo click en el 

botón Deselect features  .  

 Cierre la forma Group Stats.  

 

Guarde este archivo temporal en el banco de datos sqlite: 

 Haga click en el botón DBManager   . 

 Siga el procedimiento, según la figura: 

 

❶: Haga click en el nodo del banco de datos 

ejercicio_5.sqlite para establecer conexión.  

❷: Haga click en el botón Import layer/file. 
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❸: Escoja layer Overlay 

❹: Click en Update options 

❺: Escriba 

arroyo_barrios_usos_suelos_1977 

❻: Check en Create spatial index 

❼: Click OK 

❽: Click OK en la forma Import Database 

 
 

 Añada este nuevo geodato al canvas.  Haga right click encima del geodato/tabla 

arroyo_barrios_usos_suelos_1977 

 
 Cierre la forma DB Manager. 

 Remueva el geodato temporal Overlay.  

 
 Guarde este proyecto QGIS con el nombre ejercicio_5.qgs.  Project > Save As … 

 

 Guárdelo en la carpeta Tutorial_QGIS\Ejercicio_5 

5C: Dissolve: Agregar áreas contiguas con datos 

iguales 
Esta función tiene como propósito agregar elementos (líneas o polígonos) contiguos con la misma 

característica en la tabla de atributos.   

 

Ejemplos: 

1. Unir varios municipios contiguos para generar una región. 

2. Generalizar datos en la tabla de atributos: En un geodato de usos de suelo, podemos 

generalizar la clasificación asignando el mismo tipo a usos de suelo parecidos.  Por ejemplo, 
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sembradíos de café, plátanos, frutos menores, pastizales para ganado pueden ser catalogados con 

una categoría más general: “Agrícola”. 

 

Haremos una demostración con el ejemplo # 2.   

Utilizaremos el layer arroyo_barrios_usos_suelos_1977, el cual fue generado en la pasada sección.   

 Abra la tabla de atributos de este geodato arroyo_barrios_usos_suelos_1977, haciendo right-

click encima del layer y escogiendo Open Attribute Table  

 

Note que el campo b_usos tiene ‘Areas Agricolas’ repetido varias veces.  En este caso, esto significa que 

‘Areas Agricolas’ incluye usos más específicos como Pastos, Caña, y otros.  

  
 

Vamos a generalizar el geodato, para una clasificación menos detallada de uso de suelos. 

Función Dissolve 
 Para aplicar la función Dissolve, deberá ir al panel Processing Toolbox y en la caja de texto, 

escriba dissol. 

 

Entre todos los algoritmos Dissolve 

disponibles, el más práctico para este ejemplo 

es el que provee GDAL/OGR Dissolve 

polygons.   

 

Este algoritmo nos da opciones tales como 

poder eliminar campos innecesarios y resumir 

datos en una sola función. 

 Haga doble click en este algoritmo Dissolve polygons, bajo [OGR] Geoprocessing 
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Aparecerá la forma Dissolve polygons 

 Siga los pasos como en la siguiente gráfica: 

 
 Cierre la forma Dissolve 

Luego de terminar, así debe verse el geodato con la consolidación (dissolve) de usos de terrenos.  

 

 

 

❶ Escoja el layer 
arroyo_barrios_usos_suelos_1977 

❷: Dissolve field: escoja el campo  

       b_usos  

❸: Geometry column name, escriba 

geom 

❹: Check Count disolved features  

❺: Check Compute area and 

perimeter of dissolved features 

❻: Check Compute 

min/max/sum/mean for the 

following numeric attribute 

❼: Numeric attribute… escoja 

cuerdas 

❽: Check Open output file after 

running algorithm 

❾: Click Run 
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Puede abrir la tabla de atributos de este geodato para inspeccionarla.   

 Active el layer temporal Dissolved y haga click en el botón Open Attribute Table 

 
Así aparecerá la tabla, con los atributos previamente definidos: conteo de entidades integradas, sumatoria, 

mínimo, máximo, promedio, de cuerdas y los campos recalculados de área y perímetro en metros 

cuadrados y metros, respectivamente.   

 
 Cierre esta tabla. 

Exportar el geodato temporal a la base de datos SpatiaLite 
 Vamos a integrar este geodato temporal en la base de datos que estamos usando.   

Vaya al menú principal y escoja Database > DB Manager > DB Manager.   

 Expanda el nodo de SpatiaLite y el nodo del archivo ejercicio_5.sqlite 

 
 Haga click en el botón Import Layer File 

  
 En la forma Import vector layer, vaya al apartado Input y escoja el geodato temporal 

Dissolved. 

 Haga click en el botón, Update options.  

 En el apartado Output table, escriba arroyo_barrios_usos_suelos_gen_1977  

 
 

  



 

Tutorial Quantum GIS 3.4 LTR 

186 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

 En la sección Options, primero debemos establecer el sistema de referencia geoespacial. 

Haga check en Source SRID y haga click en el botón Select SRS 

 
 En la forma Coordinate Reference System Selector, vaya a la sección Filter y escriba 6566.   

 
 En el apartado Coordinate reference systems of the world, escoja el Sistema NAD83(2011) / 

Puero Rico and Virgin Is. EPSG:6566. 

 
 Haga click en el botón OK para cerrar esta forma. 

 

 Haga check en Target SRID y haga click en el botón Select SRS 

 
 Repita el proceso de selección del SRS EPSG:6566 aplicable a nuestros geodatos en Puerto Rico. 

 
 Haga click en el botón OK para aceptar cambios y cerrar esta forma 

 De vuelta a la forma Import vector layer, haga check en la opción Create spatial index. 

 
 Haga click en el botón OK para aceptar los parámetros y cerrar la forma Import vector layer.  

 

Deberá aparecer el mensaje de importación exitosa. 
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 Añada este nuevo layer al canvas, haciendo right-click encima del nombre 

arroyo_barrios_usos_suelos_gen_1977 y escogiendo la opción Add to canvas. 

 
 Cierre la forma DB Manager. 

 Remueva el geodato temporal Dissolved. 

 
El geodato/layer/tabla SpatiaLite aparecerá en el canvas y la tabla de contenido de QGIS. 

Asignar una definición de colores (simbología) a partir una tabla 

de simbología SpatiaLite 
Podemos cambiar el aspecto del mapa usando un archivo con simbología predefinida.  Este un archivo 

está guardado dentro del banco de datos SpatiaLite o puede guardarse en un archivo XML externo.   

 

 
 

Para asignar esta simbología, acceda a las propiedades del layer arroyo_usos_general_1977.   

 Haga doble click encima del nombre de este layer para que aparezca la forma Properties. 
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 Haga click en el botón Style > Load Style 

  
Aparecerá la forma Database Styles manager.   

 En la sección Load Style, mantenga la opción from database (spatialite) 

 En la sección Other Styles on the database, localice y escoja el style arroyo_usos_suelos_1977 

dentro del banco de datos SpatiaLite Ejercicio_5.sqlite 

 
 Presione el botón Load style para traerlo. 

De vuelta a la forma Layer Properties, haga click en el ítem Symbology.  Notará la definición de 

simbología, colores y bordes de las áreas. 

  
 Presione el botón OK para aceptar los cambios y cerrar esta forma. 

Así deberá aparecer el layer: 

 

 

 

Esto termina este ejemplo usando la función Dissolve en QGIS.  

 Guarde el proyecto con el nombre: ejercicio_5.qgs dentro de la carpeta 

Tutorial_QGIS\Ejercicio_5 

 Cierre QGIS.  
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5D: Geoprocesamiento vectorial con GRASS 
La función Union se utiliza cuando necesitamos incluir geometrías y atributos de dos o más geodatos.  Se 

incluye todo el contenido de dos o más geodatos en uno solo, el cual contendrá todas las geometrías y 

atributos.  Es análogo al concepto de sumar y puede aplicarse a records en tablas.   

Ejemplos: 

1. Combinar geodatos de distintas susceptibilidades en un solo geodato.  Por ejemplo, una región o 

gobierno municipal desea combinar distintos mapas de riesgos en uno solo para evaluarlos 

simultáneamente. 

 

2. Por el contrario, buscar idoneidad, uniendo distintos geodatos de interés en uno solo.  Por ejemplo, 

buscar áreas idóneas para desarrollar tomando geodatos de áreas naturales protegidas, áreas previamente 

urbanizadas, áreas inundables, terrenos llanos, reservas agrícolas, suelos potencialmente agrícolas, 

parcelación, distancia a infraestructura vial, etcétera. 

 

Aplicaremos el ejemplo #1. Combinar geodatos de distintas susceptibilidades a deslizamiento de 

terrenos. 

 

Para hacer el ejemplo necesitará descargar los geodatos: 

• Pendientes de 50% o mayores 

• Unidades geológicas registradas como depósitos de deslizamientos: (Ql, Qm, Qc) y las unidades 

geológicas que hayan pasado por una meteorización profunda (suelos lateríticos y saprolitas). 

• Cubierta de suelo 2006 generalizada. Solo para propósitos de este ejemplo.   

 

En esta parte usaremos shapefiles.  Hay algunos problemas con el uso del formato SpatiaLite, pero 

están relacionados a la programación de los wizards, no al formato como tal.  

 

En la próxima sección está el enlace para descargar los shapefiles y descomprimirlos. 

En esta parte E del ejercicio, vamos a: 

• Definir un directorio y espacio de trabajo “GRASS_DATA” y “mapset”.  El mapset se define con 

un sistema de referencia espacial único.   

• Importar los geodatos shapefile a GRASS. 

• Realizar las tareas de geoprocesamiento Union e Intersect de los datos referentes a susceptibilidad 

de deslizamientos de terreno.  

El siguiente modelo gráfico simplificado, muestra las funciones y resultados de los geoprocesos: 

 
Por qué usar GRASS:  

1: Porque provee herramientas topológicas y cluster tolerance para la validación de 

geometrías planas 2D.  Cluster tolerance permite colapsar geometrías insignificantes. 

2: Porque tiene disponibles cientos de herramientas para manipular y analizar datos geográficos, 

tanto vectoriales como matriciales, además de incluir módulos para el procesamiento  

 

Por lo tanto, vamos a hacer la prueba con la interfaz de GRASS disponible ya dentro de QGIS.  

GRASS es un SIG completo y es el software SIG libre de más antigüedad.   

http://grass.osgeo.org/documentation/general-overview/
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Preparar un MAPSET desde QGIS 
Preparemos el ambiente o espacio de trabajo para trabajar con GRASS 

 Abra una nueva sesión de QGIS. 

 Si no le aparece el toolbar de GRASS en QGIS,  

 
deberá activar este plugin.   

 Vaya al menú principal y escoja Plugins > Manage and Install Plugins…  

 
 Aparecerá la forma Plugins.  Haga click en el ítem Installed.  

 
 En la caja de texto Search, escriba grass 

 
 Aparecerá el plugin de GRASS.  Haga click en la caja check para activarlo. 

 
 Haga click en el botón Close para cerrar esta forma. 

Para trabajar en GRASS, es necesario establecer el ambiente de trabajo (MAPSET) que se utilizará.   

 

Un MAPSET está circunscrito solamente a un sistema de referencia espacial. 

Este “mapset” es muy parecido a la nomenclatura de Workstation ArcInfo de Esri, en el cual se trabajaba 

por directorio-folder (workspace) y cada “cobertura” era un folder dentro de otro folder superior. 
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Recuperado de https://grass.osgeo.org/grass70/manuals/helptext.html (5 enero 2017) 

 

Antes de comenzar a definir la base de datos GRASS y el Mapset, podemos aprovechar que la interfaz 

de QGIS facilita la definición de la extensión territorial para una nueva base de datos y mapset de 

GRASS. 

 Para esto, si no lo tiene en el canvas, traiga el geodato de municipios_2015. El geodato está en el 

banco de datos spatialite ejercicio_5.sqlite.  Expanda los nodos y haga doble click encima del 

layer municipios_2015 

 
 Cierre la forma DB Manager 

Deberá mantener la extensión territorial completa de este geodato de municipios: 

 Si no le aparece así, asegúrese de haber utilizado el botón Zoom full 

 
Recuerde que al traer el geodato desde SpatiaLite, QGIS utilizará la simbología asignada por defecto al 

geodato.  Por tal razón, aparece con los colores y etiquetas de ejercicios anteriores. 

Con esta extensión territorial definida, producirá un nuevo MAPSET.  

https://grass.osgeo.org/grass70/manuals/helptext.html
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 Vaya al menú principal > Plugins > GRASS, haciendo click en el botón New mapset: 

 
El nuevo MAPSET será creado en el directorio C:\Tutorial_QGIS\Ejercicio_5.   

 Use el botón Browse y seleccione el folder C:\Tutorial_QGIS\Ejercicio_5\ 

 Añada el folder grass_data.  Se creará el directorio al finalizar este proceso.  

WINDOWS

LINUX 

 Presione el botón Next > 

Location: Este será un directorio donde guardará finalmente los geodatos del proyecto. 

 Seleccione la opción Create new location 

 
 y en la caja de texto escriba Puerto_Rico_6566 

  
 Presione el botón Next > 

Proyección cartográfica: 

 Seleccione la opción Projection: 

 
 En la caja de texto Filter, escriba el código correspondiente al (CRS) sistema de coordenadas 

SPCS NAD83(2011) de Puerto Rico & USVI: 6566 

 

En esta parte se definirá el sistema de 

referencia espacial.   

Se usa 6566 para indicar el 

código de referencia espacial. 

NAD83(2011) 
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Más abajo, en la sección Coordinate reference systems of the world, deberá aparecer el CRS descrito 

con sus parámetros.   

 Seleccione el ítem NAD83(2011) / Puerto Rico & Virgin Is. EPSG: 6566: 

 
 Presione el botón Next > 

GRASS Region: 

Defina la extensión territorial del conjunto de datos.  Usaremos la extensión territorial vigente en esta 

sesión de QGIS.   

 Haga click en el botón Set current QGIS extent.  Esto nos facilitará el trabajo de averiguar las 

coordenadas mínimas y máximas.   

 
Sus coordenadas W N S E deben ser parecidas a estas.  Dependerá del tamaño del monitor o de la 

resolución de este.  Lo importante es que mantenga la extensión completa del geodato de municipios.  

Recuerde que estamos usando un sistema de coordenadas planas, usando metros como unidades.   

El botón Set current QGIS extent es para fijar esta extensión territorial.   

 



 

Tutorial Quantum GIS 3.4 LTR 

194 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

NO use el botón Set porque le proyectará la extensión territorial a Afganistán o cualquier otro país que 

esté en la lista.   Solo tendrá que usar el botón Set current QGIS extent para devolverlo al lugar original. 

 Presione el botón Next > 

Mapset: 

Este será finalmente el nombre del subdirectorio que contendrá los geodatos que trabajaremos para este 

ejemplo.  

 En la caja de texto New mapset escriba villalba  

 
 Presione el botón Next > 

 

Este es el último panel de este wizard.  En esta etapa deberá aparecer lo siguiente: 

 
En Windows deberá ser Database: C:\Tutorial_QGIS\Ejercicio_5\grass_data 

 Presione el botón Finish para generar el mapset 

 
Si hace zoom out en QGIS, notará la extensión territorial (región) de este mapset en rojo: 

 
El mapset está listo para comenzar a añadir datos.   

Vamos ahora a usar las herramientas de GRASS para importar los shapefiles antes mencionados al 

formato nativo de GRASS. 
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Importar shapefiles a GRASS usando el plugin QGIS-GRASS 
Ya que tenemos definido el espacio de trabajo (mapset), usaremos las herramientas de importación de 

datos GDAL/OGR disponibles en el plugin GRASS.   

Los shapefiles necesarios para realizar esta parte están en este enlace. 

http://gis.otg.pr.gov/downloads/tutorials/Qgis/villalba_geodata.zip 

 Descomprima el contenido de este zip file dentro del directorio 

C:\Tutorial_QGIS\Ejercicio_5\villalba_geodata.  Estos son los shapefiles incluidos.   

 
Para esta versión de GRASS (7.6.1 en Windows, 7.4.0 o 7.6.1 en Ubuntu-Linux), puede invocar el 

módulo v.in.ogr con la opción –-ui.  De esta manera, puede usar los layers en formato de SpatiaLite 

que están en el banco de datos ejercicio_5.sqlite.  Por el momento, por simplicidad, vamos a usar el 

grupo de shapefiles con los mismos datos. 

Importar el layer de geología 
El layer shapefile villalba_geol_landslide_prone proviene de varios mapas geológicos que solapan el 

entorno del Municipio de Villalba.  Está compuesto de unidades geológicas de depósitos no consolidados, 

y suelos lateríticos entre otros.  Estas unidades geológicas son las de mayor riesgo a deslizamientos 

inducidos por lluvias.   

 Para comenzar, haga click en el botón Open GRASS Tools. 

 
Aparecerá la forma GRASS Tools.  En este caso, se muestra el Location/Mapset activo.  Este se llama 

Puerto_Rico_6566/villalba.  Por defecto, aparece el tab Modules, donde aparecen los módulos de 

GRASS 

 
v.in.ogr es la función/módulo que vamos a usar.  Es muy conveniente porque provee herramientas de 

“limpieza geométrica”, durante la importación.   

 Expanda los nodos File Management > Import intoGRASS > Import vector into GRASS 

 Haga doble click en el módulo v.in.ogr Import OGR vector. 

 

 En el tab Options de este módulo, vaya al apartado Name of the OGR datasource to be 

imported y haga click en el botón de elipsis  para poder buscar el primer shapefile.  

http://www.gdal.org/
http://gis.otg.pr.gov/downloads/tutorials/Qgis/villalba_geodata.zip
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 Localice y escoja (click) en el shapefile villalba_geol_landslide_prone.shp. 

 
 En el apartado Name for output vector map, escriba villalba_geol_landslide_prone 

 
 

 Haga click en el botón Show advanced options >> 

 
 

 Solo haga check en las opciones Override projection check y Change column names to 

lowercase characters. 

 
 

 En la sección Snapping threshold for boundaries (map units), escriba 1 

 
 

 En la sección Minimum size of área to be imported (square meters), escriba 1 

 
 

 Al final de esta forma, haga check en la opción Override projection check (use current 

location’s projection) 
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 Así deben quedar las opciones en esta forma v.in.ogr: 

 

 
 Haga click en el botón Run para correr este módulo v.in.ogr. 

 

 Espere el resultado. 

 
 Haga click en el botón View output. 

 Active el layer villalba_geol_landslide_prone y haga click en el botón  Zoom to layer 

extent. 

Topología:  

GRASS trabaja de forma análoga a Workstation ArcInfo.  El modelo topológico tiene un parámetro 

“cluster tolerance” el cual se usa como umbral de tolerancia para igualar (snap=enganchar) la 

localización de cualquier punto que esté dentro del umbral de distancia establecido.   

 

 Note que establecimos un umbral de 1 metro para que los bordes contiguos sean consolidados.   
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 Además, se fijó otro umbral para no importar áreas partiendo de menores o iguales a 1 metro 

cuadrado.  

 
Así aparecerá el geodato importado en el canvas de QGIS: 

 
 

Importar el shapefile de pendientes mayores o iguales a 50% 
Pasemos a importar el segundo geodato: áreas con pendientes >= 50%. 

 
 Repita el procedimiento de abrir el módulo v.in.ogr, usando la misma forma de la sección 

anterior.   

 

Esta es la versión de uso de la consola en el caso de usar SpatiaLite: 

C:\>v.in.ogr -o input=C:\Tutorial_QGIS\Ejercicio_5\ejercicio_5.sqlite layer= 

villalba_geol_landslide_prone output= villalba_geol_landslide_prone min_area=1 snap=1 

villalba_slopes50pct_gt_2cuerdas.shp 

Este shapefile contiene áreas con pendientes >= 50% y con áreas de más de 2 cuerdas. 
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 En el apartado Name of the OGR datasource to be imported, busque y escoja el shapefile: 

 

 
 

 En el apartado Name for output vector map, escriba villalba_slopes50pct_gt_2cuerdas 

 
 Haga click en el botón Show advanced options >> 

 
 Solo haga check en las opciones Override projection check y Change column names to 

lowercase characters. 

 
 En la sección Snapping threshold for boundaries (map units), escriba 1 

 
 En la sección Minimum size of área to be imported (square meters), escriba 33 

 
 Al final de esta forma, haga check en la opción Override projection check (use current 

location’s projection) 

 
 

 Note que no importaremos áreas menores de 33 metros cuadrados.  Esto ayudará a hacer que 

el archivo sea más simple.  Estas áreas son bastante pequeñas para este ejemplo exploratorio. 

 
 Haga click en el botón Run para producir los resultados de la importación. 

 Luego de terminado el proceso, haga click en el botón View output para que aparezca este layer 

en el canvas. 
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Así debe verse el layer acabado de importar (los colores pueden variar): 

 
Tome un tiempo para explorar estos geodatos.  El geodato de pendientes >=50% se deriva de un ráster de 

pendientes en porciento, el cual a su vez se deriva de un modelo digital de elevaciones.  

Unión geométrica en GRASS 
Queremos usar la función UNION porque: 

• debemos preservar la totalidad de las áreas con pendientes mayores o iguales a 50% y, 

además,  

• debemos preservar todas las unidades geológicas identificadas previamente como de muy 

alta susceptibilidad.   

Habiendo ya preparado los layers en GRASS, pasemos a usar este módulo. 

 Haga click en el botón Open GRASS tools 

 

Esta es la versión de uso de la consola en el caso de usar SpatiaLite: 

C:\>v.in.ogr -o input=C:\Tutorial_QGIS\Ejercicio_5\ejercicio_5.sqlite 

layer=villalba_slopes50pct_gt_2cuerdas output=villalba_slopes50pct_gt_2cuerdas min_area=33 

snap=1 
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 En la forma GRASS Tools, presione el tab Modules Tree y expanda los nodos: 

 Vector > Spatial Analysis > Overlay 

 
 Escoja la función v.overlay.or – Vector union 

 En el módulo v.overlay.or, escoja los siguientes parámetros en el tab Options: 

 

 En Name of input vector map (A), escoja el layer 

villalba_geol_landslide_prone 

 En Name of input vector map (B), escoja el layer 

villalba_slopes50pct_gt_2cuerdas 

 En Name of output vector map, escriba  

villalba_union_derrubios 

 Haga click en el botón Run para correr el módulo/función.   

  
 Una vez terminado…  

 

Presione el botón View output  para traer el resultado a la tabla de contenido y al 

canvas. 

 

  

Recuerde: OR es el equivalente al 

proceso UNION.  Estamos “añadiendo” 

geometrías y atributos de ambas tablas. 
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Así se ve el resultado de la función UNION: 

 

Tenemos en este geodato la unión de todas 

las áreas con susceptibilidad alta a 

deslizamientos (pendientes >=50%) 

además de las áreas que habían sido 

identificadas como las de más alto riesgo 

a deslizamientos usando el mapa de 

unidades geológicas a escala 1:20,000.   

 

Este mapa podría usarse como guía para 

mantener estas áreas cubiertas con bosques 

para evitar la erosión, sedimentación de las 

represas aledañas, así como también 

minimizar el riesgo a deslizamientos. 

 

 

Nota: Opcional 

La interfaz de GRASS-QGIS no le brinda la opción de colapsar áreas muy pequeñas.  Si le 

interesa obtener un geodato más simple con menos records insignificantes, puede usar el 

comando v.overlay --ui.   

1 

 

2 

 

sintaxis 
v.overlay ainput=villalba_geol_landslide_prone@villalba 

binput=villalba_slopes50pct_gt_2cuerdas@villalba operator=or 
output=villalba_union_derrubios snap=10 
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La desventaja de esa opción es que no dispondrá del botón View output.  Deberá ir al panel 

Browser y navegar en el disco para localizar dónde está el grass database y el mapset “villalba” 

para añadir el layer #1 del geodato villalba_union_derrubios. 

Importar el shapefile de cubierta de terrenos usando WHERE 

condition SQL 
Un paso más adelante sería determinar cuáles áreas deberían tener prioridad para incentivar la 

densificación de bosques.  Esto lo podemos hacer usando un mapa de cubierta de terrenos que muestre 

áreas que no son bosques.  El tercer shapefile villalba_landcov2006_generaliz.shp fue preparado en 

2006 y tiene estas distinciones de cubierta de terrenos: 

 
 Repita el procedimiento de abrir el módulo v.in.ogr, descrito anteriormente.   

 
 Localice y seleccione el shapefile llamado villalba_landcov2006_generaliz.shp en el folder 

Tutorial_QGIS\Ejercicio_5\villalba_geodata 

 

 En Name of OGR datasource… el 

shapefile es 

villalba_landcov2006_generaliz.shp 

 En Name for output vector map, 

escriba 

villalba_landcov2006_no_bosques 

 Haga click en el botón Show 

advanced options 

 

 

 Haga check en las opciones: 

 Override projection 

 Change column names to lowercase 
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 En Snapping threshold for 

boundaries escriba 1 

 En Minimum size of área to be 

imported escriba 350 

 En WHERE conditions… escriba 

exactamente: 

"lc_code" > 3 

Podemos notar que en la sección Minimum size of área to be imported, se establece un límite de 350 

metros cuadrados para no generar áreas menores de ese tamaño.  Esto tiene que ver con datos 

considerados como insignificantes, resultado del origen de estos datos. 

 Asegúrese escribir en la caja de texto WHERE conditions of SQL statement without ‘where’ 

keyword "lc_code" > 3 
(Use copy/paste) De lo contrario, GRASS importará el shapefile completo sin filtrar 

 
Esta opción nos permite discriminar lo que vamos a importar.  Solo necesitamos traer las cubiertas que no 

estén asociadas a bosques ni humedales.  Además, los cafetales de alturas suelen estar bajo sombra de 

bosques.   

 Haga click en el botón Run para correr la importación. 

Presione el botón View output para que aparezca el resultado en el canvas y tabla de contenido 

de QGIS.   

 
 

Este es el resultado.  Cubierta de terrenos, 2006: 

 

 

 

  

Es importante que se escriba el enunciado tal y como está escrito: comillas dobles para el 

nombre del campo: “lc_code”.  Si no se escribe idéntico, GRASS importará todo el contenido 

del shapefile. 
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  Note las dobles comillas al inicio de la cláusula where=.  Esta cláusula debe estar rodeada de comillas 

dobles where="condición" 

 

Tenemos entonces las áreas susceptibles a deslizamientos (muy alto y alto riesgo) en un solo layer.  

Además, acabamos de importar el shapefile de cubiertas, excluyendo los bosques.   

Queremos tener las áreas de riesgos que no son bosques ni cuerpos de agua para: 

1. Densificar bosques (áreas de pastos o agrícolas) 

2. Trabajar un plan de prevención o vigilancia en zonas habitadas para evitar deslizamientos. 

Intersección geométrica 
La función/módulo Vector Intersection nos generará un layer que contendrá aquellas áreas coincidentes 

entre el layer de susceptibilidad y el de usos.  

Ahora pasemos a usar la función/módulo Intersection… 

Esta vez vamos a usar la opción para invocar el módulo v.overlay desde la consola de 

comandos.  ¿Por qué?  Esta opción nos da la oportunidad de no generar áeras demasiado 

pequeñas.  Estableceremos un umbral para colapsar bordes cercanos a 10 metros, 

considerando la escala de compilación de uno de los mapas fuente.  

 Si no está·abierta, abra la forma Open GRASS Tools 

 Haga click en la opción shell: 

 
 En la consola de comandos, escriba v.overlay --ui y presione Enter 

 
 Siga las indicaciones de la siguiente figura: 

 

 En Name of input vector 

map (A), escoja el layer 

villalba_union_derrubios. 

 En Name of input vector 

map (B), escoja el layer 
villalba_landcov_no_bosque

s 

 En Operator defines 

features written to output 

vector map, escoja and. 

 En Name for output 

vector map, escriba 
villalba_landcov_derrubios 

 Haga click en el tab Optional.  

 

Esta es la versión de uso de la consola en el caso de usar SpatiaLite: 

C:\>v.in.ogr input=C:\Tutorial_QGIS\Ejercicio_5\ejercicio_5.sqlite 

layer=villalba_landcov2006_generaliz output=villalba_landcov2006_no_bosques 

where=""lc_code" > 3" min_area=350 snap=1 
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 Navegue hacia abajo hasta que encuentre la sección Snapping threshold for boundaries.   

En la caja de texto escriba 10 

 
 Haga click en el botón Run para poner a trabajar este módulo. 

 
 Espere los resultados… 

 
 Cierre esta forma v.overlay. 

Esta vez no disponemos del botón View output.   

Para traer un layer de GRASS, será necesario activar el panel Browser.   

 Esto se hace yendo al Menú principal > View > Panels > y escoja (check) Browser. 

 Navegue en el disco hasta encontrar el directorio GRASS  

Tutorial_QGIS\Ejercicio_5\grass_data\Puerto_Rico_6566\villalba.   

 Expanda el geodato GRASS villalba_landcov_derrubios.   

 Haga right click en el layer 1 y escoja la opción Add Layer. 

 
Este es el resultado de la intersección de ambos layers (zonas de riesgo y cubierta terrenos). 
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Note que la tabla incluye los campos de ambos layers.   

 
Así podremos hacer las distinciones necesarias y poder identificar riesgos por tipo de cubierta.  Se 

debe prestar atención especial además en las áreas desarrolladas que estén en zonas de riesgo. 

Podemos visualizar estas zonas usando colores para distinguirlos.  Utilice las propiedades del layer para 

cambiar los colores según el tipo de cubierta: 

 

Para hacer esta distinción de colores puede usar el archivo landcover2006.qml que se provee con el zip 

file que se descomprimió previamente en esta parte del ejercicio. 

 Acceda a las propiedades de este layer villalba_landcov_derrubios (doble click encima del 

nombre de este layer) 

 
 Traiga la definición de colores (simbología) presente en el archivo landcover2006.qml usando el 

botón Load Style…  
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 Aparecerá la forma Database styles manager.  Al final de esta forma, haga click en el botón 

elipsis . 

 
 Navegue hasta el directorio Ejercicio_5/villalba_geodata y escoja el archivo 

landcover_2006.qml.  Presione el botón Open.  

 
 De vuelta a la forma Database Styles manager, haga click en el botón Load style 

 
La leyenda deberá verse así.  En este caso, queremos resaltar las áreas en rojo porque son áreas 

construidas en zonas de alto riesgo de deslizamientos de terrenos.  

 
 Haga click en el botón OK para ver el mapa. 
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Note las áreas en rojo.  Estas deben inspeccionarse con mayor detalle para descartar si son áreas 

construidas en zonas de riesgo.  Las áreas en color amarillo son las áreas de riesgo que no tienen 

cubierta boscosa.   

Recalcular áreas 
Si vamos a la tabla de atributos del geodato villalba_landcov_derrubios e inspecciona el campo de área 

a_b_area_sqm, notaremos que algunos records no tienen valores.  Además, los valores ya no son 

correctos.  Este campo debe ser actualizado luego de los procesos de cambios en las geometrías.  Para 

recalcular el área, utilizaremos el módulo v.to.db. 

 
 Abra la forma Open GRASS Tools si es que no está abierta. 

Esta vez usaremos la consola de comandos de GRASS.   

 En el tab Modules Tree, haga click en shell-GRASS shell. 
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Aparecerá la consola de comandos: 

 
 

 En el prompt escriba 

v.to.db --ui y presione enter 

 
En caso de usar Windows: 

 
 

 

 En la forma v.to.db de GRASS que aparecerá:   

 

 En el tab Required, bajo Name of 

input vector map: escoja el layer 

villalba_landcov_derrubios@villa

lba 

 En Value to upload escoja area. 

 En Name of attribute column to 

populate, escoja el campo 

a_b_area_sqm 

 Haga click en el tab Optional.    

 

 Haga check en Verbose module 

output 

 En Layer number…, mantenga 1 

 En Units, escoja meters 

 Haga click en el botón Run y espere que termine. 

 
 Cierre la forma v.to.db y cierre la consola de Windows. 

Para ver los cambios en la tabla, deberá remover el GRASS layer villalba_landcov_derrubios y 

volverlo a traer.   

 Remueva este layer: 

 
 

Note que hay records con área = 0 y otras insignificantes que podrían ser eliminadas con la herramienta 

topológica v.clean de GRASS, usando la opción rmarea = 300 metros cuadrados.   

Por ejemplo: 
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 Vaya al shell, escriba v.clean --ui y presione Enter. 

 
 En la forma v.clean, siga las indicaciones de esta figura: 

 

Input: villalba_landcov_derribios 

 

 

Output: 

villalba_landcov_derrubios_final 

 Aún en la sección Required, navegue hacia abajo y haga check en la opción remove small 

areas, the longest boundary with adjacent área is removed. 

 
 Haga click en el tab Optional.   

 
 Vaya a la sección [multiple] Threshold in map units, one value for each tool y escriba 300. 

 
 Haga click en el botón Run para eliminar estas áreas marginales. 

 Espere que finalice el módulo y cierre la forma v.clean 

 Recalcule el área en el campo a_b_area_sqm 

 
y en el tab Optional, escoja meters. 

 
 Cierre la forma v.to.db 

 Añada el layer desde el panel Browser 
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 Abra la tabla de atributos y ordene la columna a_b_area_sqm.  Notará que no habrá áreas 

menores de 300 metros cuadrados.   

 
 

 Guarde el proyecto QGIS con el nombre Ejercicio_5.qgs. 

 Cierre QGIS. 

 

Con esto concluimos esta sección de geoprocesamiento vectorial con GRASS.  Más adelante se incluye 

una sección de procesamiento de datos ráster usando GRASS.   
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Opcional: Técnicas para muestreos aleatorios: 

función para ubicar puntos al azar: Random points 
Estas técnicas pueden ser de interés para personas que hacen muestreos y trabajos de campo.  En estas, se 

pueden ubicar lugares al azar y de la misma manera, seleccionar elementos geográficos. 

 

Situación:  

Hacer un muestreo de lugares para diseñar un plan para trabajo de campo.  

Se escogerán 100 lugares. 

Estos deben estar concentrados en: 

1. El barrio-pueblo o zona urbana del Municipio de Comerío y establecer una zona de 

influencia (buffer) de 700 metros para incluir otros asentamientos contiguos al casco urbano. 

2. Se debe usar el sistema viario, derivado de los mapas censales Tiger Files, 2006, solamente 

dentro de esta área de influencia.  Aplicar un buffer zone de 15 metros alrededor de cada 

segmento de calle dentro de esta área. 

3. Finalmente, aplicar la función Random Points (100 puntos) al buffer de vías para seleccionar 

los lugares a visitar. 

 

Comience una nueva sesión de QGIS. 

 Solamente necesitamos el barrio Pueblo (casco urbano tradicional) del Municipio de Comerío.  

Para esto usaremos el botón Add WFS Layer 

 
 En la forma Add WFS Layer from a Server, use la conexión Geoserver OGP y presione 

Connect.  

  
 En la caja de texto Filter: escriba barrios 

 Bajo la columna Title, escoja el geodato g03_legales_barrios_edicion_octubre2015 

 Para escoger solamente el barrio Pueblo de Comerío, presione el botón Build query 
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Aparecerá la forma SQL query composer. 

  
 Haga click en la caja de texto WHERE 

 
 En la sección Data a la derecha de esta forma, haga click en la lista drop down Columns; escoja 

el campo llamado countyfp (string) 

  
 En la caja de texto Expression: 

o añada = ‘045’ 

o escriba la palabra AND 

o Presione Enter 

 
 En la sección Columns, escoja el campo de la lista llamado countyfp  

 
o Escriba = ‘Barrio Pueblo’ 

Su expresión debe quedar así 

g03_legales_barrios_edicion_octubre2015.countyfp='045' AND 

g03_legales_barrios_edicion_octubre2015.barrio='Barrio Pueblo' 

   
 

 Presione el botón OK. 

 De regreso a la forma Data Source Manager | WFS, presione el botón Add.  

 Cierre la forma Data Source Manager 

 Para ver dónde está la selección que realizó, haga right click en el nombre de este layer y escoja 

Zoom to Layer  
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El barrio Pueblo del Municipio de Comerío debe aparecer así: 

Siguiendo con el plan, debemos generar un área de influencia (buffer zone) de 700 metros alrededor para 

incluir otros asentamientos cercanos al antiguo casco urbano (Barrio Pueblo). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Aplicar buffer de 700 metros al Barrio Pueblo 
 Para determinar la zona de influencia (buffer), vaya al menú principal y escoja,  

Proccessing > Toolbox. 

 
 En la caja de texto Processing Toolbox, escriba buffer 

  
 Bajo el grupo Vector geometry, haga doble click en el algoritmo Buffer. 

  
  

Nota histórica:  

El nombre Comerío proviene de un antiguo cacique taíno local.  El Municipio de 

Comerío se llamó Sabana del Palmar hasta 1894.  Es posible que el cambio de 

nombre haya sido influido por el auge de resaltar rasgos indígenas en el Caribe durante 

el siglo XIX. 
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Aparecerá la forma Buffer. 

 

 En Input layer, mantenga el 

layer de barrios 

g03_legales_barrios… 

 En Distance, escriba 700 

 En Segments, escriba 20.  Esto 

sirve para suavizar los 

contornos del buffer 

 End cap style: Round 

 Join Style: Round 

 Miter limit: 2 

 Check en la opción Dissolve 

result 

 En Buffered, mantenga 

Create temporary layer y 

check en Open output file 

after running algorithm. 

 Presione Run para generar el buffer. 

 Cierre la forma Buffer. 

 Presione el botón Zoom to layer  para poder ver toda la extensión territorial del geodato. 

 

 Mueva (drag and drop) el layer de barrio-pueblo (g03_legales_barrios…) encima del layer 

temporal Buffered: 

 
Así deben verse más o menos ambos layers: buffer y barrio Pueblo: 

  
 Ahora añada el geodato de calles y carreteras producido por el Censo Federal. 

 Haga click en el botón Add WFS Layer 
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 En la forma Data Source Manager | WFS, use la conexión Geoserver OGP y presione 

Connect.  

 
 En la caja de texto Filter, escriba tiger 

 
Encontrará el geodato llamado g35_viales_mapa_base_tiger_rds_2006se  

 Haga check o mantenga check las opciones  

Use title for layer name 

Only request features overlapping the view extent 

  
Esto debe usarse para traer solamente datos en el área de interés.  

 

 Presione el botón Add para traer los datos. 

 Cierre la forma Data Source Manager | WFS 

 Deslice el layer de viales (tiger2006) encima del layer de barrio si fuere necesario. 

 

Una vez que traiga el geodato de las vías, es preferible seleccionar solamente las vías que estén sobre 

el área de influencia de 700 metros alrededor del Barrio Pueblo del Municipio de Comerío.  

 
 Para seleccionarlos, vaya al menú principal y escoja Vector > Research Tools > Select by 

Location. 
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Aparecerá la forma Select by location.  Siga los siguientes pasos: 

 

 En Select features from, escoja 

g35_viales_mapa_base_tiger_rds2006se  

 Where the features (geometric 

predicate), haga check en la opción  

are within.  Nos interesan solamente las 

vías que están completamente dentro 

de la zona de influencia 

 By comparing to the feature from, 

escoja el layer Buffered 

 En Modify current selection by, escoja 

la opción creating new selection 

 

 Presione Run para hacer la selección. 

 

 Cierre la forma Select by location. 

 

 Los elementos seleccionados aparecerán en color amarillo brillante. 

 

 En la parte inferior de la interfaz gráfica de QGIS aparecerá un aviso del número de elementos 

que han sido seleccionados: 422  

 Use las destrezas adquiridas para corroborarlo (abrir tabla, etc.) 
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Hacer buffer de 15 metros alrededor de las vías seleccionadas 
Utilice los elementos (vías) seleccionados para hacer este buffer.   

 Para determinar la zona de influencia o buffer, vaya al grupo Vector geometry, haga doble click 

en el algoritmo Buffer. 

  
Aparecerá la forma Buffer. 

Siga los siguientes pasos: 

 

 En Input layer, escoja el layer 

g35_viales… 

 Check SELECTED 

FEATURES ONLY 

 En Distance, escriba 15 

 En Segments, escriba 20.  Esto 

sirve para suavizar los contornos 

del buffer 

 End cap style: Round 

 

 Join style: Round 

 

 Mitter limit: 2.0 

 

 Check en la opción Dissolve 

result 

 En Buffered, mantenga [Create 

temporary layer] 

 Check en Open output file after 

running algorithm. 

 Presione Run para generar el buffer de 15 metros alrededor de las vías seleccionadas. 

Así debe verse: 
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 Cambie el nombre de este layer temporal a Buffer_viales_15m 

 >>  

 

Note que hizo buffer solo a los elementos seleccionados.  Ninguno de ellos se sale del área de influencia 

de 700 metros. 

Para propósitos demostrativos podemos usar esta selección.  Continuemos. 

Aplicar función Random Points 
Finalmente podremos aplicar la función Random Points al buffer de vías (15 metros). 

 Para hacerlo, vaya al menú principal y escoja Vector > Research Tools > Random Points in 

Layer Bounds 

Aparecerá la forma Random Points in Layer Bounds. 

 Siga los siguientes pasos: 

 

 En Input Layer, escoja el layer 

Buffer_viales_15m 

 En Number of Points, escriba 100.  (Cien 

lugares a muestrear) 

 En Minimum distance between points, 

escriba 100 

 En Random points, mantenga la opción 

Create temporary layer y también 

mantenga la opción Open output file after 

running algorithm 

 

 Presione Run para generar los puntos aleatorios.  Espere que el proceso termine.  Puede tardar 

unas decenas de segundos porque el buffer tiene una geometría algo complicada. 
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Así debe (más o menos) lucir el geodato de puntos aleatorios sobre los demás layers: 

 

Al ser una función de puntos aleatorios, si repite el proceso, la función deberá presentarle puntos en 

diferentes localizaciones. 
 

Se pueden descartar aquellos puntos 

que estén fuera de asentamientos o 

viviendas a lo largo de estas vías.  

Guarde este proyecto QGIS con el 

nombre Random_points.qgs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Cierre este proyecto QGIS. 

 

Nota importante.  Los layers temporales solo son válidos dentro de una sesión abierta de QGIS.  Si 

cierra el Project file y lo abre nuevamente, no podrá ver el contenido y tendrá que correr 

nuevamente el algoritmo.  Si desea que estos layers temporales sean permanentes, deberá exportarlos a 

un banco de datos SpatiaLite o al formato de su preferencia.  
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Opcional: Aplicación en biología: genética 

poblacional 
Uso de tablas con coordenadas puntuales XY en sistema de referencia espacial WGS84 

 

El insecto “Diaphorina citri” es una plaga en cítricos, siendo el vector que transmite la enfermedad del 

citrus greening (causado por la bacteria Candidatus liberibacter sp.).  El árbol muere de dos a cinco años 

al ser infectado por esta bacteria.  El estudiante Luis Y Santiago-Rosario del programa graduado de 

biología de la Universidad Interamericana en Bayamón realizó un muestreo que permite observar 

poblaciones alrededor de la isla en cuanto a su genética y la comparación de poblaciones del insecto.  

 

  
Diaphorina citri 

 

 
Ejemplo de un árbol cítrico sano al fondo y otro enfermo (a la izquierda). 
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Esta es la tabla con las ubicaciones registrando el muestreo de árboles contaminados en distintos lugares. 

  
La tabla contiene coordenadas en puntos.  El sistema de referencia espacial presunto es EPSG:4326 

WGS84 (World Geodetic Survey 1984), latitud y longitud en grados decimales.  La mayoría de los 

instrumentos GPS de bajo costo y teléfonos celulares usan este sistema de referencia espacial. 

 
 Descargue esta tabla en el enlace a continuación: 

TABLA EXCEL MUESTREO 

 En el navegador, utilice la opción de guardar el archivo comprimido zip. 

 

Acuérdese dónde guardó el archivo zip.  Es posible que lo 

guarde por defecto en el folder “Downloads” de su perfil de 

usuario si está usando Windows. 

 
 Extraiga el contenido del archivo comprimido en el folder  

Tutorial_QGIS\ Ejercicio_5\Genetica_Poblacional  

 

Esta tabla servirá como input para generar un mapa de puntos que podremos sobreponer a otros mapas 

disponibles en el servidor de geodatos del gobierno.   

Todos los records con identificadores deberán tener una coordenada x y. De lo contrario, habrá 

mensajes de error o problemas en la parte que continuará.  

http://gis.otg.pr.gov/downloads/tutorials/qgis/Base_de%20_datos_d.citri-3.zip
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 Pasemos a abrir una sesión de QGIS. 

 
Primero, asegurémonos que este nuevo proyecto utilice el sistema de referencia espacial (CRS) 

antes mencionada (WGS84).   

 

 Para que funcione la sobreimposición y vea correctamente en sitio los puntos de la tabla, haga 

click en el botón del código del CRS  

 
Aparecerá la forma Project Properties > CRS 

Esto hará que se reproyecten y se posicionen correctamente los geodatos que estén usando diferentes 

sistemas de referencia espacial.  Esto incluye diferentes proyecciones cartográficas y datums. 

 
 En la caja de texto Filter, escriba 4326:  

 
Deberá aparecer WGS84 en la lista: 

 Haga click en este ítem para escoger este sistema de referencia espacial.  El código 

identificador es EPSG:4326. 

 
 Presione OK en esta forma para aceptar estos cambios y adoptar el WGS84 como sistema de 

referencia de este proyecto.  Fíjese que haya cambiado el sistema de referencia espacial al 

EPSG:4326 (OTF) 

 

Uso de geoalgoritmo Points layer from a table 
Este algoritmo es útil para aquellas personas que tienen tablas con coordenadas puntuales guardadas 

en hojas de cálculo Excel o LibreOffice.   

 Antes de generar las coordenadas de la tabla, traigamos el geodato de los municipios.  Vaya al 

menú principal y escoja Database > DBManager 

 

Para este ejemplo, como sabemos que las coordenadas de la tabla están registradas en el 

sistema WGS84, lo usaremos como el sistema de referencia de este proyecto QGIS. 
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 Haga right click en el layer municipios_2015 y escoja Add to canvas 

 
 Ahora, traiga la tabla Excel con los datos de coordenadas.  Use el botón Add vector layer 

 
 En la forma Data Source Manager | Vector, pulse el botón Browse.   

 Localice el archivo Base_de_datos_d.citri-3.xls dentro del directorio 

C:\Tutorial_QGIS\Ejercicio_5\Genetica_Poblacional 

 
 Presione el botón Open en esta forma  

 De vuelta a la forma Data Source Manager | Vector, haga click en el botón Add.  

 
La tabla aparecerá en la tabla de contenido Layers Panel. 

 
 Cierre la forma Data Source Manager | Vector 

Pasemos entonces a convertir las coordenadas de la tabla en puntos en el mapa.  

 Vaya al menú principal y escoja Processing > Toolbox.   

 En la caja de texto Search, escriba points layer 
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 Haga doble click en el algoritmo Points layer from table 

Aparecerá la forma Points layer from table.  Siga los pasos: 

 

 En Input layer, escoja la tabla 

Base_de_datos_d_citri-3 

 En X field, escoja el campo 

LONG 

 En Y field, escoja el campo 

LAT 

 En Z field, escoja el campo 

ELEV 

 En Target CRS, mantenga 

EPSG:4326 

 En Points from table, 

mantenga [Create temporary 

layer] 

 Mantenga check la opción 

Open output file after 

running algorithm 

 Haga click en el botón Run para convertir las coordenadas de la tabla en puntos en el mapa. 

 

El nuevo geodato (layer) aparecerá como uno temporal.  Note el icono de temporalidad (chip de memoria 

RAM) 

 
Luego podremos guardarlo y exportarlo a otro formato.  Este nuevo geodato utilizará otro sistema de 

referencia espacial  

Por ahora podrá ver dónde localizaron las coordenadas en forma de puntos: 
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Exportar las coordenadas como un shapefile con otro sistema de 

coordenadas (reproyección) 
Supongamos que estas coordenadas deben someterse a una agencia del gobierno para alguna 

evaluación ambiental.  Las agencias del gobierno en Puerto Rico utilizan el sistema de referencia 

espacial establecido en la Ley 264 de 2002.  Esta ley fue sustituída por la Ley 184 de 2014.  Dicha ley 

dispone el uso del sistema de referencia espacial: Sistema estatal de coordenadas planas con proyección 

cartográfica Cónica conforme de Lambert, datum norteamericano de 1983 o su revisión más reciente y 

metros como unidad de medida.  Como ya hemos visto anteriormente, para estos ejercicios el sistema 

tiene como identificador el código EPSG:6566.   

 

Para exportar a shapefile y a la vez reproyectar los puntos originales en WGS84 a EPSG:6566… 

 Haga rigth-click encima del layer temporal con los puntos y escoja Export > Save Features 

As… 

 
Aparecerá la forma Save vector layer as… 

 

 En el apartado Format, mantenga la opción ESRI Shapefile. 

 En el apartado File name, haga click en el botón Browse 

Guarde el nuevo archivo dentro del folder 

C:\Tutorial_QGIS\Ejercicio_5\Genetica_Poblacional 

 Póngale nombre.  En este ejemplo usaremos citri3_6566.shp 

 En CRS, escoja el sistema EPSG:6566 
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 Presione el botón Save. 

 En el apartado CRS, escoja de la lista el sistema EPSG:6566. 

 Haga click en la opción Add saved file to map: 

 
 Presione OK para comenzar a generar el nuevo shapefile reproyectado. 

 

Compruebe que el nuevo geodato está referenciado en el sistema 6566.   

 Haga right click encima del nuevo geodato (layer) y escoja Properties.   

 En la forma Layer Properties, escoja el ítem Source. 

 
En el apartado Coordinate reference system podrá ver la etiqueta con el código del sistema de referencia 

espacial EPSG:6566, NAD83(2011) / Puerto Rico & Virgin Is. 

El mapa muestra los puntos del nuevo shapefile con las coordenadas. 

   
 

Esto concluye este ejercicio. 

 Guarde el proyecto con el nombre: ejercicio_genetica_poblacional.qgs en su folder de 

C:\Tutorial_QGIS\Ejercicio_5\Genetica_Poblacional. 

 Cierre QGIS. 

Conteo de árboles por municipio.  Esto se hace mediante Vector > Analysis tools > Count points in 

polygon 
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5-II. Procesamiento ráster usando GRASS: 

Análisis del terreno y aritmética de 

rásters 
 

Tópicos de esta sección: 

5-II. Procesamiento ráster usando GRASS: Análisis del terreno y aritmética de rásters .......................... 229 

Análisis de terreno (geomorfometría) ................................................................................................... 230 

5-II-A: Importar el MDT en GRASS .................................................................................................... 231 

5-II-B: Determinar los parámetros de la región ráster .......................................................................... 235 

5-II-C: Derivar ráster de inclinación (pendientes) en por ciento a partir del MDT .............................. 236 

5-II-D: Derivar ráster de orientación de las pendientes (aspect) ........................................................... 239 

5-II-E: Reclasificar rásters para el modelo ........................................................................................... 241 

Parámetro de pendientes ................................................................................................................... 243 

Asignar paleta de color al raster reclasificado .................................................................................. 244 

Mostrar leyenda del raster ................................................................................................................. 245 

Parámetro morfométrico ................................................................................................................... 246 

Parámetro de exposición ................................................................................................................... 248 

5-II-F: Aplicar el cómputo de rásters (map algebra) ............................................................................. 250 

Herramienta r.mapcalc.simple .......................................................................................................... 250 

5-II-G: Cuantificar cobertura de zonas de riesgo dentro de un área de interés ..................................... 252 

Rescalar el ráster de riesgos para reducirlo a 5 niveles ..................................................................... 256 

Añadir etiquetas a las categorías generadas por r.recode .................................................................. 258 

Aplicar la máscara al raster resultante .............................................................................................. 260 

Aplicar módulo r.report para calcular áreas ocupadas ...................................................................... 261 

Combinar dos rásters para agregar datos usando r.report ................................................................. 262 

Convertir layer vectorial a raster ................................................................................................... 263 

Asignar los nombres de barrios a cada categoría .......................................................................... 263 

Usar r.report para calcular áreas de riesgo por barrio ................................................................... 264 

Visualizar ráster en 3D ...................................................................................................................... 266 

Preguntas ............................................................................................................................................... 270 

 



 

Tutorial Quantum GIS 3.4 LTR 

230 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

Introducción 

El procesamiento de geodatos matriciales (ráster) necesitaría otro libro aparte.  La motivación de este 

ejercicio es experimentar el manejo de rásters porque son parte importante de cualquier conjunto de 

geodatos, especialmente para las entidades que administran recursos naturales.  GRASS ofrece una gran 

variedad de módulos para el manejo de geodatos matriciales.   

Análisis de terreno (geomorfometría) 
En esta parte se experimentará la derivación geodatos ráster a partir de un modelo digital de elevaciones 

(MDT o DEM en inglés).  Se proveerá un MDT, el cual se derivó de geodatos vectoriales de elevación, 

presentes en un mapa base detallado de la Isla.  Este contenía puntos con coordenadas x, y, z, cuerpos de 

agua superficial con elevaciones integradas, además de crestas y hondonadas topográficas, donde cada 

vértice contenía elevación.  Se trata de una región compuesta por un espacio ocupado por seis 

cuadrángulos topográficos: 1,098 km cuadrados o 423.9 millas cuadradas.  El MDT tiene resolución 

espacial (detalle) de 5 x 5m por celda (píxel). 

 

 
Detalle del MDT y su localización. 

 

Dentro de esta zona se encuentran las partes 

más elevadas de la isla, en la Cordillera 

Central.   

 

 

Primero usaremos GRASS para obtener derivados de la elevación: pendientes en por ciento y 

orientación de las pendientes (aspect).  Estos se usarán como inputs para una parte de lo que sería un 

modelo más completo de susceptibilidad a incendios forestales.  Solamente consideraremos el aspecto 

topográfico, que es el más fácil de obtener, teniendo como partida un MDT.   

Segundo, reclasificaremos los rásters de pendientes y aspect para que se adapten a los parámetros del 

modelo topográfico 

Tercero, aplicaremos solamente la fórmula para el modelo de índice topográfico-geomorfológico (IM) 

obtenida de Mostefa et al. (2003)  Application du SIG et de la télédétection dans la gestion des feux de 

forets en Algérie http://www.ltir.usthb.dz/sites/default/files/aplication5.pdf pp. 7-9.  Accedido en agosto 

19, 2019 

 

IM = 3p + (m * e) 
donde, 

p = pendiente en por ciento 

m = parámetro de topomorfología (elevación 

basada en categorías de pendientes) 

e = exposición (basado en categorías de 

orientación de las pendientes) 

  

http://www.ltir.usthb.dz/sites/default/files/aplication5.pdf
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Los términos IM, p, m, y e serán capas ráster derivadas del MDT.  Note la importancia (peso) que se le da 

al componente topográfico de pendientes p, otorgándole tres veces su peso.  Además, el componente m 

se deriva en función de la pendiente. 

 

Este modelo se aplicó en Argelia. Otros estudios y guías en España y Francia repiten más o menos las 

mismas recomendaciones en cuanto al componente topográfico.  Aclaramos nuevamente que este no es 

un modelo de riesgo completo; solamente cubre el aspecto topográfico dentro de un modelo más 

completo. 

 

Para empezar,  

 Descargue el siguiente archivo (reg_dem.zip) desde esta dirección: 

Este archivo zip contene un archivo MDT en formato Erdas Imagine (img) y otros archivos 

de texto requeridos para continuar los ejercicios.  

 

 Descomprima el archivo reg_dem.zip en el folder existente 

C:\Tutorial_QGIS\Ejercicio_5\GRASS_DATA 

 
 Contenido parcial del archivo reg_dem.zip: 

 
 

5-II-A: Importar el MDT en GRASS 
A través de las librerías GDAL, GRASS puede importar múltiples formatos ráster, por ejemplo, el img de 

Erdas.   

 

Para comenzar, usaremos el mapset anterior del entorno de Villalba.   

 Abra una nueva sesión de GRASS.  Haga doble click en el icono de GRASS que aparece en 

el desktop  

 

En caso de usar Linux, deberá abrir la consola de comandos tecleando crtl+alt+t. 

En la consola escriba grass y presione Enter 

 
 

http://gis.otg.pr.gov/downloads/tutorials/qgis/reg_dem.zip
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Aparecerá esta forma para inicializar la sesión de GRASS 

 

1. Select the GRASS GIS database 

directory: 

C:\Tutorial_QGIS\Ejercicio_5\grass_d

ata 

2. Select GRASS Location: 

Puerto_Rico_6566 

3. Select GRASS Mapset: villalba 

 

 Haga click en el botón Start GRASS session  . 

Espere que inicialice la sesión de GRASS 

 
 

 La interfaz de GRASS le presentará dos pantallas  

  
La pantalla (o panel) de la izquierda (Layer Manager) sirve para traer los layers e invocar los 

diferentes módulos o funciones.  La pantalla de la derecha se usa para visualizar y para 

digitalizar/editar layers.   Note la caja roja, la cual muestra la región de trabajo.  Fíjese que la 
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barra de título de la pantalla Map Display lea Puerto_Rico_6566/villalba.  De lo contrario, 

estará en el directorio equivocado. 

 
Vamos a impotar el primer geodato raster: el modelo digital de elevaciones.   

 Vaya al panel Layer Manager y escoja File > Import Raster Data > Import common raster 

formats [r.in.gdal] 

De manera alternativa puede hacer click en la pestaña Console y escribir r.in.gdal --ui 

 
Aparecerá la forma r.in.gdal, donde va a especificar las opciones:  

 
 En el tab Required, vaya a la sección Name of raster file to be imported, y use el botón para 

traer el archivo reg_dem.img, localizado en el folder Tutorial_QGIS\Ejercicio_5\grass_data 

 
 En este mismo tab, vaya a la sección Name for output raster map, y escriba reg_dem. 

 
 Haga click en el tab Projection y haga check en la opción Override projection check (use 

current location’s projection). 

 
 Haga click en el tab Metadata y en la sección Title for resultant raster map, escriba MDT 

Regional 

 
 Haga click en el tab Region y haga check en la opción Extend region extents based on new 

dataset. 

 
 Abajo en esta forma, mantenga check en la opción Add created map(s) into layer tree.  Esto, 

para añadir el mapa al panel derecho: Map Display: 1 

 
 Haga click en el botón Run para correr este módulo.   
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 Espere que termine de procesar y haga click en el botón Close para cerrar esta forma.  

 
Así debe aparecer el MDT en el panel Map Display:1 

 
Para ver la información descriptiva de este ráster, usemos el comando r.info de GRASS.   

 En la consola del panel Layer Manager, escriba r.info --ui y presione enter  

  
 

Aparecerá la forma r.info [raster, metadata] 

   
 En el tab Required escoja el único ráster que debe aparecer ahora “reg_dem”. 

  
 Presione el botón Run. 

  

Note que en la barra inferior aparece el comando y la sintaxis para ejecutarlo desde el prompt, de modo 

que bien puede escribir r.info map=reg_dem@villalba y debe dar el mismo resultado. 
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Fíjese en los parámetros mínimo y máximo (Range of data).  Estos son los números reales del archivo 

img original.  Por lo tanto, no ha habido cambios en los datos.   

   
 Presione el botón Close para salir. 

5-II-B: Determinar los parámetros de la región ráster 
Antes de continuar, deberíamos asegurarnos de que los demás rásters derivados tengan la misma 

resolución espacial (nivel de detalle, tamaño de la celda).  Por ejemplo, el MDT regional tiene una 

resolución de 5 x 5 metros.  Los demás deben tener la misma resolución.   

 

Esto se hace para evitar generar rásters con menor resolución.  Por ejemplo, si combinamos dos rásters 

con resoluciones espaciales diferentes, el resultado tendrá la resolución del ráster con menor detalle. 

 

Además, debemos hacer que la región de trabajo sea compatible con la extensión territorial del MDT para 

no generar píxeles vacíos (NODATA) fuera de esta extensión. 

 En la consola GRASS shell escriba el nombre de la función g.region --ui y presione enter 

 
 

 En la forma g.region que aparecerá, haga click en el tab Existing. 

 En el apartado [multiple] Set region to match to match this raster map: seleccione el ráster 

reg_dem@villalba 
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 Haga click en el tab Resolution y en el apartado Grid resolution 2D (both north-south and 

east-west), escriba 5.   

  
Fíjese en cómo se ejecuta realmente el módulo por la línea de comandos: 

  
 Presione el botón Run para correr este módulo.  

 
 Cierre esta forma g.region. 

Asegúrese que la región cubre todo el raster de elevación.   

5-II-C: Derivar ráster de inclinación (pendientes) en 

por ciento a partir del MDT 
En esta parte procederemos a generar el ráster de pendientes (slope).  Este debe usar porcentajes como 

unidad de inclinación, según lo requiere el modelo mencionado al principio de esta sección de análisis 

ráster.  Aunque podemos generar múltiples rásters: pendiente, orientación, etcétera, en esta parte solo 

generaremos el raster de pendientes en porcentajes.  

 Para generar el ráster de pendientes, vaya al panel Layer Manager y escoja del menú: Raster > 

Terrain analysis > Slope and aspect [r.slope.aspect] 

  
Aparecerá la forma r.slope.aspect  
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 En el tab Required, escoja cualquiera de los MDT reg_dem porque son lo mismo.   

 
 Haga click en el tab Outputs y en la caja de texto de la sección Name for output sople raster 

map, escriba reg_slope. 

 
 Haga click en el tab Settings y en la sección Format for reporting the slope escoja Percent. 

 
 Haga click en el botón Run para correr este módulo.  

 Espere que finalice el proceso y cierre la forma 
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Así aparece este ráster de pendientes en el panel Map Display:1 

 
Note la extensión de la región de trabajo (con borde rojo), el ráster de pendientes en colores púrpura, 

verde, amarillo.  Los cuerpos de agua aparecen en blanco y las áreas planas con colores amarillos; las 

áreas con pendientes más fuertes tienen colores oscuros hasta el negro. 
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5-II-D: Derivar ráster de orientación de las 

pendientes (aspect) 
El próximo dato para esta parte del modelo es un ráster que contenga los valores de orientación de las 

pendientes (aspect).  A diferencia de otras herramientas SIG de manejo de rásters, el módulo de 

GRASS computa la orientación de manera diferente, en contra de las manecillas del reloj.  La 

orientación de las pendientes se registra en grados, partiendo de: 

este = 360°, noreste = 45°, norte = 90, oeste =180°, sur = 270° y regresa al este con 360° 

El cero se reserva para áreas completamente llanas con pendiente = 0. 

  
 

 Para generar el ráster de pendientes, vaya al panel Layer Manager y escoja del menú: Raster > 

Terrain analysis > Slope and aspect [r.slope.aspect] 

  
Aparecerá la forma r.slope.aspect  
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 En el tab Required, escoja cualquiera de los MDT reg_dem porque son lo mismo.   

 
 En el tab Outputs, vaya a la sección Name for output aspect raster map, escriba reg_aspect. 

 
 Haga click en el botón Run para correr el módulo 

 

 Cierre la forma r.slope.aspect. 

Así aparece el ráster de orientación de las pendientes (aspect): 

 
Nota:  

Settings >  

Es posible generar un raster de orientaciones el cual tenga como partida 

Norte = 0 pero no lo usaremos en este tutorial.  La razón es conveniencia 

porque los materiales (archivos de texto para reclasificar más adelante) se 

prepararon para un raster aspect con orientación Este = 360 y 0 = flat 

(pendiente=0). 
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5-II-E: Reclasificar rásters para el modelo 
Ahora debemos agregar (reclasificar) los valores que están en los rásters de pendientes y aspect para 

adecuarlos a la fórmula que vamos a aplicar para el modelo geomorfométrico.   

 

Recuerde el modelo: 

IM = 3p + (m * e) 

   donde, 

      p = pendiente en por ciento 

      m = parámetro de topomorfología (elevación basada en categorías de pendientes) 

      e = exposición (categorías de orientación de las pendientes) 

 

Tanto IM, p, m, y e serán capas ráster derivadas del MDT 

 

Según el estudio publicado por Mostefa et al. (2003)  Application du SIG et de la télédétection dans la 

gestion des feux de forêts en Algérie http://www.ltir.usthb.dz/sites/default/files/aplication5.pdf pp. 7-9.  

Accedido en agosto 19, 2019, el ráster de pendientes debe ser reclasificado dos veces para generar dos 

rásters: 

Primero, para reclasificar las pendientes en clases: parámetro de inclinación (p).  

Ponderación 

(peso) 

Clase de pendientes Criterios 

1 Menos de 15% Áreas donde la maquinaria agrícola puede intervenir 

2 Entre 15 y 30% Áreas que necesitan otros métodos (Tractores topadores) 

3 Entre 30 y 60% Áreas que necesitan maquinarias más especializadas 

4 Más de 60% Áreas que solo permiten intervención manual 

 

Segundo, para representar niveles de elevación según la pendiente (parámetro topo-morfológico (m). 

Peso Clase de pendientes Clase morfológica 

1 Menos de 3% Llano 

2 Entre 3 y 12.5% Bajo piemonte 

3 Entre 12.5 y 25% Alto piemonte 

4 Más de 25% Montañoso 

 

Tercero, el ráster de orientación de pendientes (aspect), el cual es llamado “de exposición” (e) será 

reclasificado de la siguiente manera:  

 

Peso Orientación 

3 NE-E-SE 

2 SE-S-SO 

1 SO-O-NO 

0 NO-N-NE 

 
 

Una vez tenemos estas clases definidas, pasemos a explicar un poco cómo manejar reclasificaciones de 

rásters en GRASS.   

Para reclasificar un ráster, podemos hacer un archivo de texto que tenga: 

• la amplitud de los datos,  

• el código de la clase (número) y  

• una descripción (opcional).   

 

http://www.ltir.usthb.dz/sites/default/files/aplication5.pdf
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Por ejemplo, así debe verse el archivo de texto para generar el ráster que contendrá las clases de 

pendientes (p): 

 
 

Otro para generar el ráster que contendrá el parámetro (m) 

 
 

Y el de exposición (e) 

 

 
 

 

  

NOTA importante sobre GRASS es que los rásters reclasificados se manejan como tablas con 

referencia al ráster original.  Por lo tanto, debe tener cuidado de no borrar el ráster que origina el 

ráster reclasificado porque el ráster derivado perderá su referencia. 
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Parámetro de pendientes 
Pasemos a reclasificar el ráster de pendientes para generar el ráster representando el parámetro de 

pendientes reclasificadas (p).  

 Vaya al panel Layer Manager y escoja Raster > Change Category vales and labels > 

Reclassify [r.reclass]. 

 

 
Aparecerá la forma r.reclass.   

 Siga estos pasos: 

 

 

 En el tab Required, dentro del apartado 

Raster map to be reclassified, escoja 

reg_slope (reg_slope@villalba) 

 En el apartado Name for output raster map, 

en la caja de texto escriba reg_slope_p 

indicando que es el ráster que contendrá los 

valores p. 

 En el apartado File containing reclass rules, 

haga click en el botón Browse y localice el 

archivo de texto llamado 

reclas_slope_classes.txt.  Este se encuentra 

en el directorio 
C:\Tutorial_QGIS\Ejercicio_5\GRASS_DATA 

 Haga click en el botón Run para correr el módulo. 

 Cierre la forma r.reclass.  

Así debe quedar el ráster resultante.   
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Asignar paleta de color al raster reclasificado 
Podemos cambiar la paleta de color a este layer reclasificado.  Le asignaremos una paleta de colores pre-

definida.  Esta se guarda en un archivo de texto, de la siguiente manera: 

 

1 al 4 corresponden a las categorías del raster reclasificado. 

232:185:146 corresponde a las combinaciones de niveles de color 

RGB para cada categoría. Estas no deben contener espacios al final. 

 

 Para cambiar la paleta de colores, vaya al menú principal del panel Layer Manager y escoja 

Raster > Manage colors, Manage color rules interactively. 

 
 En la forma Create new color table for raster map que aparecerá, vaya a la sección Import or 

export color table.  Vamos a importar un archivo con las definiciones de colores.  

En el apartado Load color table from file, haga click en el botón Browse y escoja el archivo de 

texto reg_slope_p.colortable, localizado en Tutorial_QGIS/Ejercicio_5/grass_data 

 
 Así debe aparecer la forma, luego de haber traído el archivo de texto con la definición de colores. 
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 Haga click en el botón OK para asignar los colores al raster. 

Así debe aparecer el raster en el panel Map Display: 1 

 

Mostrar leyenda del raster 
Podemos mostrar la leyenda para tener una idea de la relación de colores y las categorías.  

 En el panel Map Display: 1 haga click en el botón Add map elements  

 Escoja la opción Add raster legend 

 
 En la forma d.legend que aparecerá, en el tab Input, mantenga el raster map reg_slope_p. 

 
 Haga click en el botón OK para integrar la leyenda al panel Map Display: 1. 

La leyenda aparecerá así… Algo grotesca…. Afortunadamente la podemos ajustar 

 
 Haga right click encima de la leyenda y escoja la opción Resize legend 

 
 Use el mouse left-click-arrastrar para hacer una caja del tamaño de los primeros dos cuadros 

de la leyenda: 

 … y suelte el botón del mouse 
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 La leyenda aparecerá mucho más pequeña, pero legible. 

 
 Puede remover la leyenda haciendo right click encima de la leyenda y  

escoja la opción Remove legend 

 

Parámetro morfométrico 
Pasemos a reclasificar el ráster de pendientes para generar el ráster representando el parámetro 

topográfico-morfométrico (m).   Recuerde que este se basa en pendientes y no en elevaciones: 

 
 Vaya al panel Layer Manager y escoja Raster > Change Category vales and labels > 

Reclassify [r.reclass]. 

 

 
Aparecerá la forma r.reclass.   

 Siga estos pasos: 

 

 

 En el tab Required, dentro del apartado Raster 

map to be reclassified, escoja reg_slope 

(reg_slope@villalba) 

 En el apartado Name for output raster map, en 

la caja de texto escriba reg_slope_m indicando 

que es el ráster que contendrá los valores m. 

 En el apartado File containing reclass rules, 

haga click en el botón Browse y localice el 

archivo de texto llamado 

reclas_slope_morphometric.txt.  Este se 

encuentra en el directorio 
C:\Tutorial_QGIS\Ejercicio_5\GRASS_DATA 

 Haga click en el botón Run para correr el módulo. 

 Cierre la forma r.reclass.  
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 Así debe quedar el ráster resultante.   

 
 

 Así aparece el raster cuando le asignamos la paleta de colores reg_slope_m.colortable.  Use el 

método descrito anteriormente para asignar paletas de color al raster.  Además, hemos añadido la 

leyenda. 

 
 Haga click en el botón de herramientas GRASS Tools.  Si es que no está abierta. 

 

La cuarta categoría (montañoso) domina la mayor parte de este territorio. 
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Parámetro de exposición 
Pasemos ahora a generar el ráster para el parámetro de exposición (e).  Este se deriva del ráster de 

orientación de la pendiente (aspect).  El resultado puede ser contraintuitivo.  Como señala el estudio 

citado, en la pág. 8 explica: 

La exposición al sol nos puede revelar la posible repartición de la vegetación.  La 

inflamabilidad y combustibilidad de la vegetación está relacionada con mayores 

niveles de humedad.   

Por lo tanto, el objetivo es resaltar las caras de las montañas que reciben radiación 

solar por la mañana (noreste – este – sureste).  Por consiguiente, las caras de las 

montañas que miran del suroeste – oeste – noroeste, deberían tener menor humedad.  

 

 
 

 Vaya al panel Layer Manager y escoja Raster > Change Category vales and labels > 

Reclassify [r.reclass]. 

 

 
 

Aparecerá la forma r.reclass.   

 Siga estos pasos: 

 

 

 En el tab Required, dentro del apartado Raster 

map to be reclassified, escoja reg_aspect 

(reg_aspect@villalba) 

 En el apartado Name for output raster map, en 

la caja de texto escriba reg_aspect_e indicando 

que es el ráster que contendrá los valores e. 

 En el apartado File containing reclass rules, 

haga click en el botón Browse y localice el 

archivo de texto llamado 

reclas_aspect_exposition.txt.  Este se encuentra 

en el directorio 
C:\Tutorial_QGIS\Ejercicio_5\GRASS_DATA 

 Haga click en el botón Run para correr el módulo. 

 

 Cierre la forma r.reclass.  
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Así debe quedar el ráster resultante.   

 
Así aparece el raster, luego de aplicarle la paleta de color reg_aspect_e.colortable 

 

 
 

 

Según el estudio publicado, las de mayor riesgo son las caras de las montañas que miran desde el sureste 

hasta el noreste. 
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5-II-F: Aplicar el cómputo de rásters (map algebra) 
Recuerde el modelo: 

IM = 3p + (m * e) 

   donde, 

      p = pendiente en por ciento 

      m = parámetro de topomorfología (elevación basada en categorías de pendientes) 

      e = exposición (categorías de orientación de las pendientes) 

 

Aplicaremos esta fórmula para terminar de producir el ráster que contendrá los valores del índice IM.   

Herramienta r.mapcalc.simple 
La herramienta disponible para aplicar el álgebra de mapas es r.mapcalc.simple. 

 

El orden es:  

1: multiplicar  

• 3*reg_slope_p, 

• reg_slope_m * reg_aspect_e 
2: Sumar los resultados de ambas multiplicaciones. 

 

 Vaya al menú principal del panel Layer Manager y escoja Raster > Raster map calculator > 

Simplified raster map calculator [r.mapcalc.simple] 

 
 Siga los pasos de las figuras a continuación: 

 

 

 En el tab Required, dentro del apartado 

Formula (eg A-B or A*C+B), escriba  

3*A+B*C 

 En el apartado Name for output raster map, en 

la caja de texto escriba reg_topo_im indicando 

que es el ráster que contendrá los valores IM. 

 Haga click en el tab Input maps 
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 En la sección Name of the input A raster map, 

escoja el raster clasificado 

reg_slope_p@villalba 

 En la sección Name of the input B raster map, 

escoja el raster clasificado 

reg_slope_m@villalba 

 En la sección Name of the input C raster map, 

escoja el raster clasificado 

reg_slope_e@villalba 

 Haga click en el botón Run para correr el módulo. 

Así aparece el raster reg_topo_im, el cual contiene los índices geomórficos de susceptibilidad a incendios 

forestales. 

 
 

Así luce el ráster después de haberle aplicado un esquema de color divergente, (reg_topo_im.colortable) 

que ayude a ver mejor las diferencias.  La amplitud de valores va desde 3 hasta 24.  Estos números no 

tienen dimensión ni unidades: solamente representan un proceso aritmético donde se combinaron valores 

ordinales.  Por lo tanto, los resultados también reflejan un orden de susceptibilidad.   
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Las manchas verdes oscuro (menor susceptibilidad) representan represas, áreas llanas, incluyendo el 

pequeño valle del río Jacaguas, donde ubica la zona urbanizada del pueblo de Villalba.  Las áreas en 

color rojo intenso corresponden a zonas con pendientes empinadas, que a su vez miran desde el noreste al 

sureste.  En especial, en los barrios Villalba Abajo, Villalba Arriba, Vacas y Hato Puerto Arriba en el 

Municipio de Villalba.   

5-II-G: Cuantificar cobertura de zonas de riesgo 

dentro de un área de interés 
Esta parte es opcional y tiene el propósito de cuantificar los porcentajes de área ocupada de las zonas 

de riesgo en el Municipio de Villalba.  Aclaramos que este no es un modelo completo y solo sirve de 

ensayo al uso de un modelo de riesgo a incendios forestales que sea más completo. 

Como nos interesa cuantificar dentro del territorio municipal, usaremos los límites del municipio.   

Traigamos el geodato que corresponde al área del Municipio de Villalba.  Este está en el banco de datos 

SpatiaLite “ejercicio_5.sqlite”.   

 

 En GRASS, vaya al menú principal del panel Layer Manager y escoja File > Import vector 

data > Import of common vector formats [v.in.ogr]. 
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 En la forma v.in.ogr que aparecerá, en el tab Required, use el botón Browse para escoger el 

archivo ejercicio_5.sqlite, el cual está guardado en el directorio \Tutorial_QGIS\Ejercicio_5\ 

 
 Haga click en el tab Input y escoja el layer villalba.  El layer id en este caso es el número 8 pero 

esto podría variar  

 
 Haga click en el tab Output y en el apartado Name for output vector map, solo escriba 

villalba.  

 
 Haga click en el tab Optional, haga check en la opción Override projection check (use 

location’s projection).   

En el apartado Snapping threshold for boundaries (map units), escriba 1.  

 
 

 Asegúrese que abajo en esta forma le aparezca check en la opción Add created map(s) into layer 

tree 
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 Haga click en el botón Run para importar el geodato de área municipal de Villalba 

 
 

Cuando termine de importar, le aparecerá el layer en el panel Map Display:1  

 
 

 No cierre el módulo v.in.ogr.  Vamos a importar el geodato de barrios municipales también. 

Repita el proceso para traer el geodato de barrios.  

 

 Esta vez en el tab Input, remplace el layer villalba por el layer villalba_barrios_2015 
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 En el tab Output, cambie el nombre a villalba_barrios. 

 
 

 Las opciones en el tab Optional se quedan como estaban: 

 
 En el tab selection, escriba 100 en la caja de texto del apartado Minimum size of área to be 

imported.  Queremos evitar generar áreas insignificantes al momento de importar.  

 
 Haga click en el botón Run para importar el geodato de barrios de Villalba 

 
 Cierre la forma v.in.ogr. 
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 En el panel Layer Manager, apague (uncheck) el layer villalba_barrios@villalba y arrástrelo 

debajo del layer villalba@villalba 

Estos dos layers son vectoriales 

 

Recapitulando, estas son las tareas por realizar para cuantificar las zonas de riesgo: 

• Reclasificar el raster reg_topo_im para reducir la amplitud a cinco categorías.  Este proceso 

está descrito a continuación.   

• Usar el módulo r.mask utilizando el map layer villalba 

o Una vez exista el map layer llamado MASK, se puede correr el módulo r.stats sobre el 

ráster reclasificado regional de 5 categorías. 

o Usar el módulo r.stats para hacer el cómputo de áreas. 

o Estos procesos nos deben dar este resultado además de la tabla con el resumen: 

 

Vamos ahora a detallar el proceso a seguir. 

Rescalar el ráster de riesgos para reducirlo a 5 niveles 
El ráster de riesgos “reg_topo_im” incluye áreas fuera del territorio municipal.  Además, tiene una 

amplitud (range) de 3 a 24 niveles.  Deberíamos entonces, re-escalar o reclasificar en este caso, dicho 

ráster.  Este se acomodará a 5 niveles: muy bajo, bajo, moderado, alto y muy alto.  Esto nos ayudará 

luego a obtener el cómputo de área ocupada por cada nivel de riesgo dentro del territorio municipal en la 

parte final de este ejercicio. 

 

 Para comenzar, en el panel Layer Manager, vaya al menú principal y escoja Raster > Change 

category values and labels > Recode [r.recode]  También puede escribir r.reclass en la pestaña 

comand console. 

 

  
 

 En la forma r.recode, siga los siguientes pasos:  
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Pasos: 

 

 En el tab Required, escoja de la lista el 

raster reg_topo_im@villalba 

 En Name for output raster map escriba 

reg_topo_im_rescaled 

 En la sección or enter values directly, 

escriba 3:24:1:5 

     *No dejar espacios* 

¿Qué hará esto? Esta pequeña línea sirve 

para escalar la amplitud original de 3 a 24 

del raster fuente reduciéndola a una nueva 

amplitud de 1 a 5 para el nuevo raster 

rescalado reg_topo_im_reclass.  

 

 

 

 En el tab Optional, haga check en las opciones Force 

output to ‘double’ raster map Type (DCELL) 

 Haga check en la opción Verbose module output 

 En la sección Title for output raster map, escriba 

Indice de riesgo a incendios por factor 
topográfico 

 

¿Por qué forzar a generar un raster con decimales? Vamos 

a reducir la escala amplia de 3 a 24 a otra escala tipo Likert 1 

a 5.  No obstante, podemos matizar los valores entre 1 a 5 

usando fracciones o decimales.   

 

 Haga click en el botón Run para hacer la reclasificación. 

 Cierre la forma r.recode cuando haya terminado el proceso.   

Así debe aparecer el ráster reclasificado: 

 
Falta asignarle una secuencia de colores. 
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 Vaya al menú principal del panel Layer manager y escoja Raster > Manage colors > 

Manage color rules interactively 

 
Aparecerá la forma Create new color table for raster map.   

 Siga los siguientes pasos: 

 

 En el tab Map, escoja el raster 

reg_topo_im.rescaled 

 En la sección Load color table 

from file, haga click en el botón 

Load.  Localice el archivo 

reg_topo_im_reclass.colortable 

en el directorio 

Ejercicio_5\GRASS_DATA. 

 Presione el botón OK para asignar estos colores. 

 

El resultado debe parecerse a este: 

 

Añadir etiquetas a las categorías generadas por r.recode 
Hasta ahora hemos reducido los niveles de 21 (3 al 24) a 5 (1 al 5).  Es deseable que estos niveles sean 

expresados además mediante descripciones cortas (category labels).   

 Si activa el botón Query Raster/Vector map, podrá ver los valores de cada pixel que consulte: 
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 Vaya al panel Layer Manager y escoja Raster > Change Category values and labels 

> Manage category information [r.category] 

 En la forma r.category, vaya al tab Required y escoja el raster 

reg_topo_im_rescaled@villalba 

 
 Haga click en el tab Define y en la sección or enter values directly, escriba: 

 

1, Riesgo muy bajo 
2, Riesgo bajo 
3, Riesgo moderado 
4, Riesgo alto 
5, Riesgo muy alto 
Note que GRASS genera un 

archivo temporal para hacer 

este trabajo. 

 Haga click en el tab Optional. Haga check en la opción Verbose module output.  En 

el apartado Field Separator, escoja la opción comma, porque estamos usando la coma 

para asignarle las etiquetas a los números/categorías/niveles del raster.  

 
 Haga click en el botón Run para correr este módulo.  

 Si activa el botón Query Raster/Vector map, podrá ver los valores de cada pixel que consulte: 
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**Cualquier otro valor que no sea entero, no tendrá etiqueta. 

Aplicar la máscara al raster resultante 
En esta parte haremos algo análogo a la función vectorial clip.  Usaremos el map layer vectorial de límite 

municipal villalba como MASK.  De esta manera, aislamos el territorio y calcularemos los valores de 

ocupación de áreas de riesgo.   

 

 Vaya al menú principal del panel Layer Manager y escoja Raster > Mask [r.mask] 

Aparecerá la forma r.mask 

Siga los siguientes pasos: 

 

 En el tab Vector, vaya a la sección 

Name of vector map to use as 

MASK y escoja el map layer 

villalba@villalba 

 En Layer number or name, escoja 

1 

 En Category values (vector), 

escriba 1 

 Haga click en el botón Run para generar la máscara. 

 Cierre la forma r.mask 

Usted puede comprobar si la máscara fue creada cuando: 

 

 

1: Podrá ver que el ráster que estaba 

en el Map Display aparece recortado 

con la forma del Municipio de 

Villalba 

2: Verá un aviso MASK en la parte 

inferior status bar en el panel Map 

Display. 

3: Verá que en la lista de rásters hay 

uno que se llama MASK.  
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 Para esta comprobación, vaya al panel Layer Manager, active la pestaña Command console y 

escriba el comando g.list rast seguido de enter 

  
Le devolverá los resultados de la lista de rásters en este MAPSET.  Note que hay un ráster llamado 

MASK: 

   
Notará que el ráster regional reg_topo_im.rescaled ha sido “recortado”, aunque de manera virtual.  El 

raster sigue teniendo las mismas dimensiones, pero las operaciones que se hagan en adelante 

solamente toman en cuenta el espacio dentro de la máscara. 

 Para ver este layer “enmascarado” más de cerca, vaya al panel, Layer Manager, haga right click 

en el layer vectorial villalba@villalba y escoja Zoom to selected map. 

 >  

Aplicar módulo r.report para calcular áreas ocupadas 
En esta parte podremos saber el área ocupada y el porciento de ocupación de estas zonas de riesgo.   

 

 Usaremos como se mencionó, el módulo r.report, el cual está localizado en el panel Layer 

Manager, en Raster > Reports and statistics > Sum area by raster map and category 

[r.report] 

 

Aparecerá la forma r.report 

 

 Siga los siguientes pasos: 

 
 

 En el tab Required, bajo el apartado Name of 

input raster map(s), escoja el ráster 

reclasificado: reg_topo_im.rescaled 
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 En el tab Statistics, haga check en las 

opciones square miles, square kilometers, 

acres, hectares, percent cover.  

 

 En el tab Floating point, haga check en la 

opción Read floating-point map as integer 

(use map’s quant rules).   

Esto producirá cómputos para cinco 

categorías. 

 

 

 Presione el tab No data y escoja Do not 

report no data value.   

  

 Haga click en el botón Run para generar el informe. 

 

Compare el mapa con los resultados. 

 

 
 

Vemos entonces en este ejemplo que más del 40% del territorio municipal está ocupado por áreas de 

riesgo moderado a alto, dado por los componentes topográficos muy alto, alto y moderado.   

Combinar dos rásters para agregar datos usando r.report 
Supongamos que en la oficina de la alcaldía les gustó tanto el informe, que comenzaron a preguntarse si 

además del nivel municipal, ¿cuáles serían el porcentaje de ocupación de zonas de riesgo por cada barrio?  

Afortunadamente, habíamos convertido el geodato de barrios anteriormente y ya contamos con el mapa 

vectorial de barrios en GRASS.  Lo que falta es convertir el mapa vectorial a raster y usar el mismo 

módulo r.report, el cual le va a producir un listado de ocupaciones de zonas de riesgos por cada barrio.   
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Convertir layer vectorial a raster 

El módulo r.report precisa que los layers a evaluar estén en formato raster.  Por lo tanto, vamos a 

convertir el layer vectorial de barrios a formato raster.  

 Vaya al menú principal del panel Layer Manager y escoja Vector > Map Type conversions > 

Vector to raster [v.to.rast]  

 En la forma v.to.rast, siga estos pasos 

 

 Name of input vector map: 

villalba_barrios@villalba 

 Name of output raster map: 

villalba_barrios_raster@villalba 

 Source of raster values: cat 

‘cat’ tiene una lista del 1 al 8 por los 

ocho barrios de este municipio. Estos 

los usaremos para asignarle el nombre 

en el próximo paso.  

 Deje las demás opciones como están y haga click en el botón Run para generar la versión raster 

del layer de barrios.   

 Cierre la forma v.to.rast. 

Así aparecerá el layer de barrios en formato raster. 

 

Asignar los nombres de barrios a cada categoría 

Cada área en este raster tiene una categoría numérica del 1 al 8.  Estos números son nominales y los 

usaremos para relacionar el número con el nombre del barrio.  Luego de esto, podremos producir un 

informe de datos que nos de el nombre del barrio en lugar de un código numérico.   

Usaremos un archivo de texto que contiene la relación de cada categoría con su nombre de barrio: 

 

Cada relación está delimitada por un ‘tab’.  Esto se verá luego.   

 

 Vamos a asignar los nombres de barrios a este layer raster.  Vaya al menú principal y escoja 

Raster > Change category values and labels > Manage category information [r.category]. 
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 Siga los siguientes pasos: 

 

 En el tab Required escoja el raster 

villalba_barrios_raster@villalba 

 

 Haga click en el tab Define.   

 En el apartado File containing category 

label rules (or “-” to read from stdin) 

haga click en el botón Browse y escoja el 

archivo barrios_names_reclass.txt el cual 

está localizado en el folder 

Tutorial_QGIS\Ejercicio_5\grass_data 

 

 Haga click en el tab Optional.   

 Haga check en la opción Verbose 

 En el apartado Field separator, asegúrese 

esté escogida la opción tab.  

 Deje las demás opciones como están 

 Haga click en el botón Run para asignar estos nombres a las categorías. 

 Cierre la forma r.category. 

Luego de añadir la leyenda, comprobamos que los nombres se asignaron a las categorías: 

 
Ya este raster está listo para el próximo paso: hacer el cómputo de área de riesgo ocupada por cada barrio. 

Usar r.report para calcular áreas de riesgo por barrio 

Ya que disponemos de los dos layers raster, podemos usar el módulo r.report para generar el listado de 

nivel de riesgo por cada categoría, por barrio.   

 

 Busque el módulo r.report, el cual está localizado en el panel Layer Manager, en Raster > 

Reports and statistics > Sum area by raster map and category [r.report] 

 

Aparecerá la forma r.report 
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 Siga los siguientes pasos: 

 
 

 En el tab Required, bajo el apartado Name 

of input raster map(s), escoja los rásters: 

villalba_barrios_raster@villaba, 

reg_topo_im.rescaled@villalba 

 

 En el tab Statistics, haga check en las 

opciones  

square miles, square kilometers, percent 

cover.  

 

 

 En el tab Floating point, haga check en la 

opción Read floating-point map as integer 

(use map’s quant rules).   

Esto producirá cómputos para cinco 

categorías. 

 

 

 Presione el tab No data y escoja Do not 

report no data value.   

  

 Haga click en el botón Run para generar el informe. 

Esto es parte del informe producido por el módulo r.report bajo las instrucciones que entramos 

previamente. 

 

-----------------------

-----------------------

-----------------------

-----------------------

----------------------- 

Le recordamos que 

este no es un 

modelo completo 

y que solamente 

muestra el 

componente 

topográfico de un 

modelo más 

completo de riesgo 

a incendios 

forestales.   

-----------------------

-----------------------

-----------------------

-----------------------

----------------------- 

 

 

 Cierre la forma r.stats. 
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Visualizar ráster en 3D 
Para ver este mapa de riesgos en pseudo 3d, podemos usar las opciones de visualización del Map Display 

de GRASS.  Para esto, necesitaremos traer un modelo digital de elevaciones.   

 Primero, vaya al Layer Manager y remueva todos los layers. 

 

 Añada ahora el map layer de elevaciones reg_dem.  Haga click en el botón  Add raster 

map layer 

Aparecerá la forma d.rast.  

 En el tab Required, bajo Name of raster map to be displayed, escoja el map layer 

reg_dem@villalba 

 
 Haga click en el botón OK 

Podrá ver que, si la máscara MASK está aún activada, solo se mostrará el área del municipio. 

 
 Vaya al panel Map Display y haga click en el botón dropdown 2D view. 

 Escoja la opción 3D view 

 
 Espere que GRASS prepare la interfaz 3D.   
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La interfaz del Layer Manager cambiará, incluyendo las siguientes pestañas/tabs.  

Siga los siguientes pasos (pestaña View): 

 
 

 Arrastre el puntero para que apunte desde el 

suroeste (SW) 

 

 En Height, mantenga 20,000 

 

 En Z-exag, déjelo en 1.0 

 

 Mantenga Perspective en 20  

 

 Mantenga Tilt en 0 

 

← La interfaz 3D interpretará estos parámetros 

así 

 

 Active el tab Data.  

 En Raster map, mantenga reg_dem@villalba. 

 

 En Draw, escriba 2 en Fine mode y 5 en Coarse 

mode escriba 5 

 

 En Surface attributes, vaya a Color y escoja el 

map layer reg_topo_im.rescaled@villalba 

 

La interfaz 3D cargará el raster con los colores para 

los niveles de riesgo a incendios según la topografía 

local. 
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 La leyenda puede añadirse con el botón Add map elements  y escoger la opción Add 

raster legend  

 
 Siga los siguientes pasos: 

 

 En el tab Input, escoja el raster 

reg_topo_im_rescaled@villalba 

 

 En el tab Title, escriba 

Susceptibilidad incendios forestales 

 

 En el tab Gradient, escriba 5 en la 

caja de texto Number of text labels 

for smooth gradient legend 

 

 En el tab Subset, en el apartado 

[multiple] List of discrete category 

numbers/values for legend escriba  
1: muy bajo,2: bajo,3: moderado,4: 
alto,5: muy alto 

 

 En el tab Font settings, escriba 10 en 

la caja de texto Font size. 

 

 Haga click en el botón OK para 

aceptar cambios y cerrar la forma. 

 

 

 Haga click en la leyenda que 

aparecerá abajo y arrástrela a un 

lugar donde se pueda apreciar. 

Puede hacer los cambios que 

desee para visualizar desde otras 

direcciones, cambiar altura, 

perspectiva, etcétera. 
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Hay muchas más opciones que puede explorar. 

 Cierre GRASS. Vaya al menú principal y escoja File > Quit GRASS GIS 

 En la forma Quit GRASS GUI haga click en el botón Quit GRASS GIS.  

 
 El programa preguntará si desea guardar las preferencias en un archivo workspace de GRASS. 

Haga click en el botón Yes. 

 
 Guarde este archivo con el nombre indice_topografico_incendios_villalba.gxw dentro del 

folder Tutorial_QGIS/Ejercicio_5/grass_data 

 

Así concluye este ejercicio de aplicación ráster en QGIS usando GRASS.   
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Preguntas 
Mencione las consideraciones antes de comenzar geoprocesamiento (p 132) 

1: _______________________________________________________________________ 

2: _______________________________________________________________________ 

3: _______________________________________________________________________ 

4: _______________________________________________________________________ 

5: _______________________________________________________________________ 

 

Mencione algunas funciones de geoprocesamiento vectorial que fueron utilizadas durante estos 

ejercicios. (por ejemplo, buffers…) 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

 

 

En la parte de geoprocesamiento ráster, explique brevemente de qué se trata el modelado cartográfico que 

se utilizó en el ejercicio.  (p 203, 222) 
 

 

 

_______________________________________________ 

_______________________________________________ 

_______________________________________________ 

_______________________________________________ 

_______________________________________________ 

_______________________________________________ 

_______________________________________________ 

_______________________________________________ 

_______________________________________________ 

 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 
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6. Producción de mapas para imprimir 
 

Tópicos de esta sección: 

6. Producción de mapas para imprimir ..................................................................................................... 271 

Principios gráficos: C R A P ................................................................................................................. 272 

Print layout ............................................................................................................................................ 272 

6A: Print Layout ................................................................................................................................... 273 

6B: Herramientas de la interfaz Layout ................................................................................................ 274 

6C: Cambiar el tamaño de página ......................................................................................................... 274 

6D: Insertar el mapa en la página.......................................................................................................... 275 

6D-1. Centralizar el mapa ................................................................................................................. 276 

6E: Añadir título al mapa ...................................................................................................................... 276 

6F: Añadir la leyenda ............................................................................................................................ 279 

6G: Añadir escala .................................................................................................................................. 281 

6H: Añadir orientación al mapa ............................................................................................................ 283 

6i: Añadir fuente de datos ..................................................................................................................... 284 

6j: Guardar el mapa ............................................................................................................................... 287 

6K: Exportar la composición (mapa) a formato PDF ........................................................................... 287 

Preguntas ............................................................................................................................................... 289 
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Principios gráficos: C R A P 
Estos principios gráficos fueron tomados del libro The Non-Designer's Design Book de la autora Robin 

Williams, edición de 2003.  Enseña de manera amena y fácil sobre los fundamentos de una buena página 

para presentación (layout).  Para los cartógrafos es esencial conocer estas técnicas para poder preparar un 

mapa que sea efectivo.   

• Contraste 

• Repetición 

• Alineación 

• Proximidad 

 

Contraste – Diferenciar elementos que son y deben verse distintos. 

Mínimo  vs  Máximo 
 

Repetición – Sirve para reforzar la coherencia en el gráfico o la página para impresión.   

Podemos: 

repetir un tipo de letra,  

repetir un dibujo, gráfico o  

repetir algún elemento  

que añada continuidad si se trata de varias páginas. 

 

Alineación – Para dar coherencia y organización a la página. 

 
 

Proximidad – Cercanía física implica relación.  Los elementos que representan grupos 

similares, deben estar cerca unos de otros.  A su vez, se deben separar elementos que no sean del 

mismo grupo. 

   

Print layout 
En este ejercicio haremos una composición simple que contenga los elementos gráficos esenciales para 

hacer un mapa.  QGIS tiene un módulo aparte, el cual llaman Print Layout.  Este módulo se diseñó para 

poder hacer la composición en espacio en papel para impresión.  

 

Para hacer este ejercicio, deberá usar el proyecto QGIS llamado ejercicio_4.qgs.  Éste está localizado en 

el folder Tutorial_QGIS\Ejercicio_4.  El proyecto ejercicio_4.qgs contiene el layer de municipios con 
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los datos censales que practicó descargar de la interfaz data.census.gov con el ejercicio para hacer un 

mapa temático. 

 
 

 

El layer muestra con diferentes intensidades divergentes de colores rosado a verde, la brecha de ganancias 

entre varones y mujeres publicado por el Community Survey desde los años 2013 a 2017.   

6A: Print Layout 
 Para hacer un nuevo mapa para impresión, vaya al menú principal y escoja Project > New Print 

Composer  

 
Aparecerá la forma Composer title.   

 En la caja de texto escriba Brecha en ganancias por género. 

  
 Presione OK para iniciar la sesión del Layout. 
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Aparecerá la interfaz Layout con el nombre que acabó de escribir 

 
 

6B: Herramientas de la interfaz Layout 

 
El Layout tiene múltiples funciones, entre ellas las de exportación para formatos gráficos e 

impresión,…  

  
navegación, acercamiento, redibujar (refresh),…  

 
 

adición de elementos gráficos (textos, leyenda, escala gráfica, flecha para orientación, formas 

geométricas, añadir una tabla, añadir marco para exportar en formato html),…  

 
manejo de los elementos gráficos, orden de elementos y alineación. 

 
 

Veremos algunos de ellos más adelante. 

6C: Cambiar el tamaño de página 
 Haga right-click en la página vacía y escoja Page Properties…, Composition. 

  
 En el apartado Page size, en Size, seleccione el tamaño de página Letter 

 En el apartado Orientation, escoja Landscape. 
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Todavía en esta versión (3.4.11), la 

unidad de medida en página es el 

milímetro.  Esto puede se puede 

cambiar si usamos la opción Custom en 

el apartado Size.  

No obstante, la interfaz no cambiará las 

unidades a otra unidad. 

La forma de Puerto Rico es más 

alargada oeste-este, así que en el 

apartado orientation, la página debe 

quedarse “Landscape”. 

6D: Insertar el mapa en la página 
 Para traer el map frame que contiene los layers, utilice el botón Add new map  

 
 Haga una caja en el espacio de papel, más o menos como esta: 

 
 Haga click fuera de la caja que acaba de hacer y espere que aparezca el mapa. 
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6D-1. Centralizar el mapa 
 Active (click) la pestaña Item properties. 

 
 

El mapa en el canvas de QGIS debe estar centralizado.  Centralícelo si es necesario en el canvas. 

 Para centralizarlo, vaya al tab Item properties, en el apartado Extents, haga click en el botón Set 

to map canvas extent 

 

Además, puede usar el botón  Move item content 

para centralizar/mover el contenido del mapa en la 

página. 

 

 Más arriba, en el apartado Main properties, en la caja de texto Scale, escriba 900000 y presione 

Enter. 

 
 Haga click en el botón Update preview para redibujar el mapa. 

6E: Añadir título al mapa 
 El título se añade como cualquier caja de texto, usando el botón Add new label: 

 
 Haga click en un espacio en blanco, en la parte superior de la hoja: La etiqueta, que en este 

caso será el título, leerá “QGIS”. 
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 Haga click en el botón OK de la forma New Item Properties que aparecerá 

 
 Vaya al lado derecho de la interfaz Layout, en el tab Item Properties, y vaya a Label para 

cambiar el texto. 

 
 En la sección Label, en la caja de texto Main properties, escriba:  

Brecha de ganancias entre varones y mujeres  

(gender gap), 2013-2017.  

 
 En el apartado Appearance, presione el botón Font: 
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 En la forma Select Font, cambie las propiedades: 

 

Font:  

 

 

Size 

Arial Rounded MT Bold o 

usar Arial. 

Bold 

28 

 Presione OK. 

 Estire la caja del label con el título, de manera que pueda verse todo el contenido: 

 
 Debemos añadir una línea adicional para explicar mejor el mapa.  Vamos a copiar el texto 

anterior y cambiar el contenido para que lea Nivel educativo: profesionales y estudios 

graduados.  

 Haga click en el título y escoja Edit > Copy luego Edit > Paste (ctrl-c, ctrl-v) 

 
 Cambie el contenido a Nivel educativo: profesionales y estudios graduados 

 
 En el apartado Appearance, presione el botón Font: 
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 Solo cambie el tamaño (Size) de la letra a 16 

 
 Haga click en el botón OK para aceptar el cambio y cerrar esta forma. 

Así debe verse el título y subtítulo si usa el tipo de letra Arial Rounded… 

 

6F: Añadir la leyenda 
 Presione el botón Add new legend.  

 
 Ubique la leyenda haciendo click más o menos debajo de las islas municipio de Culebra y 

Vieques: 

 
 En el tab Item Properties a la derecha de la interfaz Layout, bajo el apartado Legend Items, 

seleccione (click) la tabla s1501_2017.  

 

 Haga click en el botón Filter Legend By Map Content  .  
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 Haga click fuera de la leyenda para que el ítem de la tabla s1501_2017 desaparezca. 

   
 Con la leyenda activada, vaya a la sección Fonts, y cambie el nivel de color negro (V) a 50% 

 

Debemos añadir una caja de texto que explique estos números.  Lo que se expresa aquí es: en el grupo de 

personas con 25 años o más, en el nivel educativo profesional y estudios graduados, cuando la brecha es 

<1, las mujeres ganan menos que los varones.  Cuando la brecha es > 1, las mujeres ganan más que los 

varones.   

 Haga click en el botón  para añadir el texto. 

 Haga click al lado izquierdo de la leyenda para ubicar este texto: 

 
 En la forma New Item properties, haga click en el botón OK.  

 Escriba el siguiente texto en la caja de texto Main Properties de la sección Label: 
Universo: personas con 25 años o más con nivel educativo profesional o estudios 
graduados 
brecha < 1: las mujeres tienen ganancias menores que los varones. 

brecha > 1: las mujeres tienen ganancias mayores que los varones. 

 
 Cambie el tipo de letra a Arial, tamaño 8, Style: Regular y cambie el color a gris con 40% en 

el campo V (value/luminosidad) 

Así debe verse la línea de texto al lado de la leyenda.  

 Acomode la caja de texto según sea conveniente.  Debe 

estar cerca de la leyenda, pero no pegada a ella.  Acuérdese de la regla proximidad = relación. 
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6G: Añadir escala 
 Use el botón Add new scalebar  

  
 Ponga la escala debajo la isla, haciendo click en el espacio de página: 

  
 Haga click en el botón OK de la forma New Item Properties que aparecerá. 

 Mantenga la escala activada.  Con el tab Item properties activado, bajo la sección Main 

properties, en Style escoja la opción Line Ticks Up 

 
 En la sección Units, use kilometers como unidad.   

En Label for units, mantenga la abreviación, km. 

 En la sección Segments, aumente los segmentos a la derecha a 4 segmentos. 

 
 

La apariencia de la escala cambiará.  Recuerde que lo principal es hacer notar la distribución de los 

valores estadísticos por municipio de manera gráfica.  Después de la leyenda y el título, lo demás no es 

tan relevante y no debe llamar demasiado la atención.  

 
 



 

Tutorial Quantum GIS 3.4 LTR 

282 
Oficina de Gerencia y Presupuesto de Puerto Rico – Calle Cruz 254, San Juan, PR 00902-3228 

 

 Expanda la sección Fonts and colors.  Haga click en el botón Font… 

  
 En sección Scalebar Font, vaya a la sección Font, cambie el tipo de letra a Arial, en Size, 

cambie el tamaño de la letra a 8 puntos.  Cambie el color a gris con 50% (V). 

 

 Use el botón para regresar,  para aceptar los cambios y regresar a la sección Scalebar. 

 Aún dentro del tab Item Properties de Scalebar, vaya la sección Fonts and Colors, haga click 

en el botón Line color.  

 
 Vaya a la sección value (V) y cambie el nivel a 50%. 

 

 Use el botón para regresar,  para aceptar los cambios y regresar a la sección Scalebar. 
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 Ajuste la posición de la escala para que esté cerca del centro de la parte inferior del mapa.  Déjese 

orientar por las líneas guía.  Estas le indicarán la ubicación de este centro-inferior en relación con 

la caja de texto: 

 
  

6H: Añadir orientación al mapa 
Para esta parte tenemos dos opciones.  Una es añadir una flecha y añadir una letra N encima de la punta 

de esta flecha.  La otra opción más simple es usar una imagen o dibujo vectorial en formato svg.  Estos 

dibujos están guardados en el directorio de instalación de QGIS, pero la interfaz Layout nos proveerá el 

listado sin tener que buscar los dibujos svg fuera de QGIS.   

 Utilice el botón Add picture. 

  
 Haga click entre la esquina inferior izquierda de la caja de texto explicativo y el número 20 de la 

escala gráfica: 

 
 Haga click en el botón OK de la forma New Item Properties.  

 En el tab Item Properties, bajo Picture, en la sección Resize mode, escoja la opción Resize 

frame to image size.  

 

https://es.wikipedia.org/wiki/Gr%C3%A1ficos_vectoriales_escalables
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 Expanda (click) la sección Search Directories para que pueda escoger el dibujo con la flecha del 

norte: 

 
 Haga click en el primer dibujo de la quinta fila. 

 
El dibujo aparecerá encima de la escala gráfica: 

 
 Pase a la sección SVG Parameters y cambie el Fill color a gris 50% y Stroke color a gris 50% 

 

 

 Use el botón para regresar,  para aceptar los cambios y regresar a la sección Item 

Properties 

 

 Arrastre el dibujo para que esté alineado con la escala gráfica.  Note que le aparezca la cruz, la 

cual le indica que está listo para reubicarlo.  Puede usar además los botones de flecha en el 

teclado. 

  

6i: Añadir fuente de datos 
Es importante dar a conocer al lector del mapa de dónde se extrajeron los datos que componen el mapa.  

Para esto podemos usar el botón que usamos para añadir el título.   
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 Haga click en el botón Add new label. 

 
 Ubique (click) la caja de texto, alineado con el título del mapa, y alineado con el texto explicativo 

de la leyenda: 

  
 Haga click en el botón OK de la forma New Item Properties.  

 En la caja de texto bajo Label > Main Properties escriba: 

Fuentes: 

Datos censales: American Community Survey, 2013-17 

Municipios: Junta de Planificación, octubre, 2015 

 
 Para poder todo el contenido del texto, aumente el tamaño de la caja, estirando las esquinas: 
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Su mapa debe verse más o menos así: 

  
 Para cumplir con el principio de Proximidad, puede mover un poco a la izquierda los elementos 

Escala gráfica y Norte Geográfico.. 
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Active (click) estos dos elementos y use el mouse o las flechas del teclado para moverlos. 

 

6j: Guardar el mapa 

 Para guardar este Layout, use el botón  Save Project. 

 

6K: Exportar la composición (mapa) a formato PDF 
QGIS provee para exportar su mapa en algunos formatos.  En este ejemplo usaremos el formato PDF.   

 Utilice el botón Export as a PDF. 

 
 Póngale nombre: gender_gap2013-17.pdf.  Guárdelo en el folder 

C:\Tutorial_QGIS\Ejercicio_6. 

 
 En la forma PDF Export Options que aparecerá, haga check en la opción Always export as 

vectors y haga click en el botón Save. 
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 Espere que termine el proceso de generar el archivo PDF. 

 
 Una vez acabe, abra el archivo en Adobe Acrobat Reader. 

Haga click en el enlace que aparece en la barra verde Export Layout: Successfuly… para abrir el 

folder donde ubicó el archivo pdf. 

 
Así se verá el archivo PDF en Adobe Acrobat Reader: 

 
 Cierre el Layout:  

 

 Guarde el proyecto QGIS con el nombre ejercicio_6.qgs en el folder 

C:\Tutorial_QGIS\Ejercicio_6. 

Esto termina este ejercicio. 

 

Hay varias maneras de representar este mapa.  Otras personas pueden usar el valor 1 como regla y usar 

distintas gradaciones para mostrar las desigualdades.  En el caso que usamos durante este ejercicio 

asignamos un color rosado claro para aquellos municipios con valores cercanos a 1.   
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Preguntas 
 

Mencione los principios gráficos explicados en la página 245 sobre C R A P:  

¿Qué significan cada uno de ellos? 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

 

Referencias para preparar páginas para impresión (Page Layout): 

 

Regla de los tercios: Dividir el espacio de página en nueve partes iguales para mejorar la composición:  

 

Gendelman, Vladimir, How to Use the Rule of Thirds 

Effortlessly, https://www.companyfolders.com/blog/rule-

of-thirds-graphic-design, recuperado en agosto 28, 2018  

 

 

La ilustración muestra la relación entre la regla de tercios 

y la regla de oro (líneas azules). Fuente: Wikipedia 

 

 

 

 

Golden rule: Reglas de proporción para producir ilustraciones 

 

Gendelman, Vladimir, How to Use the Golden Ratio to 

Create Gorgeous Graphic Designs, 

https://www.companyfolders.com/blog/golden-ratio-

design-examples, recuperado en agosto 28, 2018. 

 

 

 

 

 

 

Nociones de diseño para los no-diseñadores: 

Williams, Robin, Non Designer's Design Book, (4th Ed) Peachpit Press, 240 pp. 

https://www.companyfolders.com/blog/rule-of-thirds-graphic-design
https://www.companyfolders.com/blog/rule-of-thirds-graphic-design
https://fr.wikipedia.org/wiki/R%C3%A8gle_des_tiers#/media/File:Rule_of_thirds_versus_golden_ratio.gif
https://www.companyfolders.com/blog/golden-ratio-design-examples
https://www.companyfolders.com/blog/golden-ratio-design-examples
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